
4-562-025-27 (1)

© 2014 Sony Corporation

Solid-State Memory
Camcorder

Mode d’emploi
Avant d’utiliser l’appareil, veuillez lire attentivement ce manuel 
et le conserver pour future référence.

PXW-FS7
Version 4.0 du logiciel



2

Présentation
Configuration du système ........................................................ 6

Localisation et fonctions des pièces ......................................... 7

Viseur ........................................................................... 11
Oculaire ........................................................................ 11
Objectif (PXW-FS7K uniquement) .............................. 11
Télécommande de poignée ........................................... 11
Télécommande infrarouge ........................................... 12
Unité d’extension (optionnelle) .................................... 12

Affichage de l’écran ................................................................ 13
Ecran du viseur ............................................................. 13
Ecran d’état .................................................................. 15

Préparatifs
Alimentation ............................................................................ 18

Utilisation d’un pack batterie ....................................... 18
Utilisation de l’alimentation CA .................................. 19

Fixation de dispositifs ............................................................. 20
Fixation du support de microphone .............................. 20
Fixation du viseur ......................................................... 21
Fixation de l’oculaire ................................................... 22
Fixation d’un objectif ................................................... 23
Fixation de la télécommande à poignée ....................... 24

Réglage de l’horloge ................................................................ 25

Configuration des opérations de base du caméscope .......... 26
Shooting Mode ............................................................. 26
Color Space .................................................................. 26
Mode de numérisation de capteur d’image .................. 26

Utilisation de cartes mémoire XQD ...................................... 27
A propos des cartes mémoire XQD ............................. 27
Support recommandé ................................................... 28
Insertion d’une carte mémoire XQD ............................ 30
Ejection de cartes mémoire XQD ................................ 30
Passage d’une carte mémoire XQD à l’autre ............... 30
Formatage (initialisation) de cartes mémoire XQD ..... 30
Vérification de la durée d’enregistrement restante ...... 31

Table des matières



3

Utilisation d’une carte UTILITY SD .................................... 31
Cartes SD prises en charge ........................................... 31
Insertion d’une carte SD ............................................... 31
Ejection de la carte SD ................................................. 31
Formatage (initialisation) de cartes SD ........................ 32
Vérification de la capacité restante .............................. 32

Utilisation de l’unité XDCA-FS7 ........................................... 32

Fixation de l’unité XDCA-FS7 .................................... 32
Retrait de l’unité XDCA-FS7 ....................................... 33
Fixation du pack batterie .............................................. 33
Retrait du pack batterie ................................................ 34
Commutation de l’entrée/sortie de code temporel ....... 34

Utilisation de l’unité HXR-IFR5 et AXS-R5 ........................ 34

Connexion de l’unité HXR-IFR5 au caméscope .......... 34
Retrait de l’unité HXR-IFR5 ........................................ 34

Utilisation de la télécommande à infrarouge ........................ 35

Utilisation de la commande à distance Wi-Fi ....................... 36

Prise de vue
Procédure d’opération de base .............................................. 38

Réglage automatique de la mise au point ..................... 40
Réglage manuel de la mise au point ............................. 40
Surveillance de l’audio ................................................. 41
Passage d’une carte mémoire XQD à l’autre ............... 41

Modification des réglages de base ......................................... 42

Sélection du format d’enregistrement .......................... 42
Réglage de la luminosité .............................................. 42
Réglage pour des couleurs naturelles 

(équilibre des blancs) ............................................. 43
Réglage de l’audio sur Record ..................................... 44
Spécification des données temporelles ......................... 46

Fonctions utiles ........................................................................ 46
Touches/molettes personnalisables .............................. 46
Slow & Quick Motion .................................................. 47
Enregistrement de la vidéo par intermittence 

(Interval Rec) ......................................................... 48
Enregistrement en mode de cache d’image 

(Picture Cache Rec) ............................................... 49
Passage en revue d’un enregistrement 

(Rec Review) ......................................................... 50
Mode Self Portrait ........................................................ 50
Affichage du contour de couleur .................................. 52
Affichage des zébrures ................................................. 52



4

Moniteur de signal vidéo .............................................. 52
Obtention d’informations de lieu (GPS) ...................... 52
Prise de vue en mode Cine EI ...................................... 53
Enregistrement d’une vidéo au format RAW ............... 53
Ajout de connecteurs d’entrée audio ............................ 54

Connexion de dispositifs à l’aide du LAN sans fil ................ 55
Fixation de l’IFU-WLM3 ............................................. 55
Fixation du CBK-WA100 ............................................ 55
Connexion une touche des dispositifs équipés de la 

technologie NFC (à l’aide de l’IFU-WLM3 
uniquement) ........................................................... 56

Affichage de Wi-Fi remote control ........................................ 57

Ecran de miniatures
Ecran de miniatures ................................................................ 58

Disposition de l’écran .................................................. 58

Lecture de plans ...................................................................... 59

Lecture de plans enregistrés ......................................... 59

Opérations sur les plans ......................................................... 60

Opérations sur le menu de miniatures .......................... 60
Eléments du menu de miniatures ................................. 60

Affichage et réglages de menu
Configuration et hiérarchie du menu de configuration ...... 61

Organisation du menu de configuration ....................... 61

Opérations du menu de configuration .................................. 63

Liste du menu de configuration ............................................. 64
Menu User .................................................................... 64
Menu Edit User ............................................................ 65
Menu Camera ............................................................... 65
Menu Paint ................................................................... 72
Menu Audio ................................................................. 79
Menu Video .................................................................. 82
Menu VF ...................................................................... 85
Menu TC/UB ................................................................ 89
Menu Recording ........................................................... 90
Menu Thumbnail .......................................................... 92
Menu Media ................................................................. 93
Menu File ..................................................................... 94
Menu System ................................................................ 96



5

Connexion de dispositif externe
Connexion des moniteurs externes et des dispositifs 

d’enregistrement ............................................................. 105

Synchronisation externe ....................................................... 106

Gestion/Edition de plans grâce à un ordinateur ................ 107
Connexion à l’aide d’un câble USB ........................... 107

Annexe
Précautions d’utilisation ....................................................... 109

Formats de sortie et limites .................................................. 110

 Formats vidéo et signaux de sortie ............................ 110

Avertissements de fonctionnement ...................................... 123

Messages d’erreur ...................................................... 123
Messages d’avertissement .......................................... 123
Messages de précaution concernant l’opération ........ 124

Eléments enregistrés dans les fichiers ................................. 125

Diagrammes bloc ................................................................... 135
Audio Input (CH1&CH2) .......................................... 135
Audio Input (CH3&CH4) .......................................... 136
Audio Output .............................................................. 137

Licences .................................................................................. 138

Licence MPEG-4 AVC Patent Portfolio .................... 138
Obtention d’un logiciel sous licence GPL/LGPL ...... 138
AUTORISATION DE LICENCE DE 

L’UTILISATEUR FINAL ................................... 138
Licences de logiciels libres ........................................ 143

Caractéristiques techniques ................................................. 143
Généralités .................................................................. 143
Section de caméra ...................................................... 145
Section audio .............................................................. 146
Section entrée/sortie ................................................... 146
Section d’affichage ..................................................... 147
Section de logement de support ................................. 147
Accessoires fournis .................................................... 147
Téléchargements de logiciels ..................................... 148
Marques commerciales ............................................... 148



6

Cette section contient un exemple configuration du système de la caméra.

Présentation

Configuration du système

ECM-MS2
Microphone

SELP28135G
SEL1635Z
SELP18200
Objectif

UWP-D11
UWP-D12
Système de 
microphone 
sans fil

HVL-LBPC
Lampe vidéo

PXW-FS7

RMT-845
Télécommande infrarouge 
(fournie)

LA-EA3
LA-EA4
Adaptateur 
de monture A

IFU-WLM3
Module USB LAN sans fil 
(fourni)

VCT-FS7
Adaptateur d’épaule

Série S/N/M/H/G
Carte mémoire XQD

MRW-E80
Lecteur de carte 
XQD

HXR-IFR5
Unité 
d’interface

BC-U1A, BC-U2A
Adaptateur CA/Chargeur 
(BC-U1A fourni)

BP-U30, BP-U60, 
BP-U60T, BP-U90
Pack batterie 
(BP-U30 fourni)

XDCA-FS7
Unité 
d’extension

Adaptateur sans fil
CBK-WA100

AXS-R5
Enregistreur 
à mémoire 
portable

Télécommande de poignée 
(fournie)

SMAD-P3
Adaptateur 
de griffe à 
interfaces 
multiples

XLR-K2M
Kit adaptateur 
XLR 
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Pour plus de détails concernant l’utilisation et la fonction de chaque pièce, consultez la page indiquée.

1. Poignée (page 8)

2. Fiche du viseur (page 21)

3. Connecteur REMOTE (page 24)

4. Commutateur INPUT1 
(LINE/MIC/MIC+48V) (page 44)

5. Commutateur INPUT2 
(LINE/MIC/MIC+48V) (page 44)

6. Fixation de la poignée (page 24)

7. Connecteur du module USB LAN sans fil

8. Indicateur d’enregistrement (page 100)
Clignote lorsque la capacité restante de la 
batterie ou du support est faible.

9. Crochet pour mètre à ruban
Le crochet pour mètre à ruban se trouve au 
même niveau que le capteur d’image. Pour 
mesurer la distance entre le caméscope et le 
sujet de manière précise, utilisez ce crochet 
comme point de référence. Vous pouvez fixer 
l’extrémité d’un mètre à ruban au crochet pour 
mesurer la distance à partir du sujet.

10. Touche WB SET (réglage de l’équilibre 
des blancs) (page 44)

11. Goupille de verrouillage de l’objectif 
(page 23)

12. Touche de déverrouillage de l’objectif 
(page 23)

13. Griffe pour accessoire

14. Touche d’enregistrement START/STOP 
de la poignée
La touche d’enregistrement ne peut pas être 
actionnée lorsque le levier de verrouillage est en 
position verrouillée.

15. Levier de zoom sur la poignée (page 70)

16. Griffe à interfaces multiples

Pour plus de détails sur les accessoires pris en 
charge par la griffe à interfaces multiples, 
prenez contact avec votre représentant 
commercial.

Localisation et fonctions des pièces

WB SET
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Fixation de la griffe pour accessoire
1 Soulevez l’avant de la plaque à ressort de la griffe et 

poussez la plaque à ressort dans la direction opposée à 
la flèche gravée sur la plaque.

2 Positionnez la griffe pour accessoire sur le dispositif 
de montage de griffe pour accessoire, en alignant les 
saillies de la griffe sur les points correspondants du 
dispositif de montage, puis serrez les quatre vis.

3 Insérez la plaque à ressort de la griffe dans la direction 
de la flèche, de manière à ce que la partie en forme de 
U s’enclenche au fond de la griffe pour accessoire.

Retrait de la griffe pour accessoire
Retirez la plaque à ressort de la griffe comme 
indiqué à l’étape 1 de « Fixation de la griffe pour 
accessoire », desserrez les quatre vis et retirez la 
griffe pour accessoire.

Fixation de la plaque de protection du module 
USB LAN sans fil
1 Retirez la vis de fixation de la poignée.
2 Fixez la plaque de protection, puis serrez la vis.

Retrait de la poignée
Dévissez les quatre vis de fixation de la poignée, 
puis retirez la poignée du caméscope.

Fixation du capuchon protecteur du connecteur 
de la poignée (fourni)
Lorsque vous utilisez le caméscope sans la 
poignée, protégez le connecteur en utilisant le 
capuchon protecteur fourni.

Protection des bornes du connecteur
Fixez le cache sur les connecteurs non utilisés 
pour protéger les bornes du connecteur.

Plaque à ressort de la griffe

Griffe pour accessoire

Plaque à ressort 
de la griffe

Griffe pour accessoire

1 2
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1. Touche START/STOP

2. Molette ND FILTER (page 43)

3. Touches ASSIGN (personnalisables) 1 à 3 
(page 46)

4. Touche PUSH AUTO IRIS (page 42)

5. Touche PUSH AUTO FOCUS (page 40)

6. Commutateur FOCUS (page 40)

7. Touche DISPLAY (page 13)

8. Touche FULL AUTO (page 38)

9. Commutateur POWER (page 18)

10. Molette IRIS (page 46)

11. Touche STATUS CHECK (page 15)

12. Commutateur HOLD (page 100)

13. Commutateur CH1 LEVEL CONTROL 
(page 44)

14. Molette CH1 INPUT LEVEL (page 44)

15. Commutateur CH2 LEVEL CONTROL 
(page 44)

16. Molette CH2 INPUT LEVEL (page 44)

17. Touche SLOT SELECT (sélection de carte 
mémoire XQD) (page 30)

18. Touche CANCEL/BACK (page 59)

19. Touche MENU (page 61)

20. Touche THUMBNAIL (page 58)

21. Touche droite
Utilisée pour régler des valeurs numériques et 
pour déplacer le curseur vers la droite sur les 
menus et écrans de miniatures. 

22. Molette SEL/SET (sélection/réglage)
Tournez la molette pour déplacer le curseur vers 
le haut/bas pour sélectionner des éléments ou 
des réglages de menu. Appuyez pour appliquer 
l’élément sélectionné.

23. Touche gauche
Utilisée pour régler des valeurs numériques et 
pour déplacer le curseur vers la gauche sur les 
menus et écrans de miniatures.

24. Touche SHUTTER (page 43)

25. Commutateur WHT BAL (sélection de 
mémoire d’équilibre des blancs) (page 43)

26. Touche WHT BAL (équilibre des blancs) 
(page 43)

27. Commutateur GAIN (sélection du gain) 
(page 42)

28. Touche ISO/Gain (page 42)
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1. Connecteur pour casque (page 41)

2. Logement pour carte mémoire XQD A 
(page 30)

3. Logement pour carte UTILITY SD 
(page 31)

4. Indicateur d’accès XQD (A) (page 30)

5. Indicateur d’accès à la carte SD (page 31)

6. Indicateur d’accès XQD (B) (page 30)

7. Connecteur USB
Raccordez à un ordinateur grâce à un câble USB 
pour accéder au support d’enregistrement dans 
un logement pour carte mémoire XQD sur le 
caméscope.

8. Logement pour carte mémoire XQD B 
(page 30)

9. Haut parleur intégré (page 41)

10. Touche de déverrouillage du cache du 
support (page 30)

11. Connecteur d’unité d’extension (page 32)

12. Indicateur d’enregistrement arrière 
(page 38)

13. Connecteur DC IN (page 19)

14. Touche BATT RELEASE (éjection 
batterie) (page 18)

15. Batterie (page 18)

16. Fixation du pack batterie (page 18)

17. Capteur de réception de la télécommande 
à infrarouge (page 35)

18. Microphone interne (page 44)
Microphone de narration pour l’enregistrement 
du son d’ambiance.

19. Connecteur INPUT1 (entrée audio 1) 
(page 44)

20. Connecteur INPUT2 (entrée audio 2) 
(page 44)

21. Connecteur SDI OUT 1 (page 105)

22. Connecteur SDI OUT 2 (page 105)

23. Connecteur HDMI OUT (page 105)

Dessous
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1. Orifice de vis pour trépied (1/4 de pouce, 
3/8 de pouce)
Compatible avec les vis 1/4-20UNC et les vis 
3/8-16UNC.
Attachez à un trépied (en option, vis de 5,5 mm 
ou moins).

Pour plus de détails sur la fixation du viseur 
(fourni) et de l’oculaire, voir page 21.

1. Bouton CONTRAST

2. Touche PEAKING

3. Touche ZEBRA

4. Commutateur MIRROR

5. Crochets de fixation de l’oculaire

Pour plus de détails sur la fixation de l’oculaire 
(fourni), voir page 22.

1. Bouton d’ajustement de dioptrie

2. Œilleton

Pour plus de détails, reportez-vous au mode 
d’emploi de l’objectif.

Pour plus de détails sur la fixation de la 
télécommande à poignée (fournie), voir page 24.

1. Levier de zoom

2. Touche ASSIGN (personnalisable) 4

3. Molette personnalisable

4. Touche ASSIGN (personnalisable) 6

5. Touche d’enregistrement START/STOP

6. Sélecteur multiple

7. Touche de rotation de la poignée

8. Touche ASSIGN (personnalisable) 5

Viseur

Oculaire

Objectif (PXW-FS7K uniquement)

Télécommande de poignée
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1. Touche DATA CODE
Pas utilisée sur cette version.

2. Touche TC RESET

3. Touche SCAN/SLOW

4. Touche ./> (PREV/NEXT)

5. Touche PLAY

6. Touche STOP

7. Touche DISPLAY

8. Emetteur de télécommande

9. Touche START/STOP

10. Levier de zoom

11. Touche PAUSE

12. Touche MODE
Pas utilisée sur cette version.

13. Touche b/B/v/V/ENTER

Pour plus de détails sur la fixation d’une unité 
d’extension (optionnelle), voir page 32.

1. Touche BATT RELEASE

2. Connecteur de batterie

3. Connecteur GENLOCK IN

4. Connecteur DC IN

5. Connecteur DC OUT

6. Indicateur d’enregistrement

7. Connecteur REF OUT

8. Connecteur TC IN/OUT

9. Commutateur TC IN/OUT

10. Connecteur RAW OUT

Télécommande infrarouge Unité d’extension (optionnelle)
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Pendant la prise de vue (enregistrement/veille) et la lecture, l’état du caméscope et ses réglages sont 
superposés sur l’image affichée dans le viseur.
Vous pouvez afficher/masquer ces informations en utilisant la touche DISPLAY.
Vous pouvez également choisir d’afficher/masquer chaque élément de manière indépendante (page 85).
L’image au rapport d’aspect de 17:9 capturée par le capteur d’image est affichée sur le viseur. En formats 
d’enregistrement 16:9, les parties sombres sur les bords gauche et droit ne sont pas enregistrées.

Informations affichées sur l’écran pendant la prise de vue

1. Indicateur du mode/de la vitesse 
d’obturation (page 43)

2. Indicateur de filtre ND (page 43)

3. Indicateur de gain (page 42)
Affiché comme une valeur IE lorsque Base 
Setting (page 96) >Shooting Mode dans le menu 
System est réglé sur « Cine EI ».

4. Indicateur de position de mise au point
Affiche la position de mise au point (si un 
objectif prenant en charge l’affichage du réglage 
de mise au point est fixé). 

5. Indicateurs de mode d’enregistrement, 
d’icône de logement A/B et d’état

Affichage de l’écran

Ecran du viseur

/ zRec Enregistrement

/ Stby Veille

S&Q / zRec Enregistrement en mode 
ralenti et accéléré ou 
mode de fréquence 
d’images élevée

S&Q / Stby Veille en mode ralenti et 
accéléré ou mode de 
fréquence d’images 
élevée

Int /zRec Enregistrement en mode 
Interval Rec
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6. Indicateurs d’icône et d’état de logement 
B

7. Indicateur d’enregistrement RAW 
externe (page 53)

8. Indicateur de profondeur de champ

9. Indicateur de température de couleur 
(page 43)

10. Indicateur de fréquence d’images de S&Q 
Motion (page 90)/Affichage d’intervalle 
d’enregistrement en mode Interval Rec 
(page 48)

11. Indicateur de capacité restante de la 
batterie/de tension DC IN (page 19)

12. Indicateur de format d’enregistrement 
(taille d’image) (page 26, 97)
Affiche la taille d’image pour l’enregistrement 
sur des cartes mémoire XQD.
Le mode de numérisation de capteur d’image 
(F : 2K Full, C : 2K Center) s’affiche à gauche 
de la taille d’image. Seul le mode de 
numérisation s’affiche si Codec est réglé sur 
« RAW » (2KF : 2K Full, 2KC : 2K Center).

13. Indicateur de format d’enregistrement 
(fréquence d’images et méthode de 
balayage)

14. Indicateur de format d’enregistrement 
(codec) (page 42)
Affiche le nom du format pour l’enregistrement 
sur des cartes mémoire XQD.

15. Indicateur de gamma/moniteur LUT 
(page 74, 83)
Affiche le réglage de gamma. Lorsque Shooting 
Mode (page 96) est réglé sur « Cine EI » cela 
affiche le réglage de gamma ou moniteur LUT 
pour l’enregistrement de vidéo sur des cartes 
mémoire XQD.

16. Indicateur de format de sortie externe 
(page 82)

17. Indicateur de verrouillage externe du code 
temporel
Affiche « EXT-LK » en cas de verrouillage sur 
le code temporel d’un dispositif externe.

18. Indicateur d’état de connexion Wi-Fi 
(page 55)
S’affiche lorsque la fonction Wi-Fi est réglée 
sur « Enable ». Lorsque l’IFU-WLM3 n’est pas 
installé sur le caméscope,  n’est pas affiché.

19. Indicateur d’état du GPS (page 52)
Affiche l’état du GPS.

20. Indicateur d’aide à la mise au point 
(page 41)
Affiche un cadre de détection (repère de zone de 
mise au point) indiquant la zone de détection de 
mise au point, et une barre de niveau (indicateur 
d’aide à la mise au point) indiquant le degré de 
mise au point dans cette zone.

21. Moniteur de signal vidéo (page 52)
Affiche une forme d’onde, un vecteurscope ou 
un histogramme.
Lorsque Shooting Mode (page 96) est réglé sur 
Cine EI, les informations du moniteur LUT pour 
l’écran sont aussi affichées (page 52).

22. Indicateur d’état du support du logement 
A/B/ de la capacité restante (page 31)
Enregistrement sur le support lorsque le côté 
gauche de l’icône est orange.
Lecture du support lorsque l’indicateur vert en 
haut à droite de l’icône est allumé. 

23. Indicateur de niveau à bulle
Affiche le niveau horizontal et la pente d’avant 
en arrière en incréments de ±1° à ±20°.

24. Vumètre audio
CH3 et CH4 peuvent être contrôlés sur l’écran 
d’état.

25. Indicateur de nom de plan (page 58)

26. Indicateur de mise au point

27. Affichage des données temporelles 
(page 46)

28. Indicateur de carte SD

29. Indicateur d’état de commande de sortie 
SDI (page 105)

30. Indicateur de mode d’équilibre des blancs 
(page 43)

Int /zStby Mise en attente de 
chargement d’image en 
mode Interval Rec

Int / Stby Mise en attente 
d’enregistrement en 
mode Interval Rec

/ z
Enregistrement en mode 
de cache d’image

/ zCache
Veille en mode de cache 
d’image

zRec Enregistrement

Stby Veille

W:P Mode prédéfini

W:A Mode mémoire A

W:B Mode mémoire B
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31. Indicateur de mode AE (page 42)

32. Indicateur de diaphragme automatique 
(page 42)

33. Indicateur AGC (page 42)

34. Indicateur d’obturateur automatique 
(page 43)

35. Indicateur de mode de mise au point

36. Indicateur de mode de stabilisation 
d’image

37. Indicateur de zone de mise au point
Afiche la zone de mise au point pour la mise au 
point automatique. 

Lorsque Push Auto Focus est disponible

Pendant la mise au point automatique

Non affiché lorsque Focus Area (page 68) est 
réglé sur Wide.

38. Indicateur de position de zoom
Affiche la position du zoom dans une plage de 0 
(grand angle) à 99 (téléobjectif) (si un objectif 
prenant en charge l’affichage du réglage de 
zoom est fixé).
Peut également s’afficher comme graphique en 
barres (page 87).

39. Indicateur de position du diaphragme
Affiche la position du diaphragme (si un objectif 
prenant en charge l’affichage du réglage du 
diaphragme est fixé).

Informations affichées sur l’écran pendant la 
lecture
Les informations suivantes sont superposées sur 
l’image de lecture.

1. Numéro de plan/Nombre total de plans

2. Mode de lecture

3. Indicateur de capacité restante de la 
batterie

4. Indicateur de format de lecture (taille 
d’image)

5. Indicateur de format de lecture (fréquence 
d’images)

6. Indicateur de format de lecture (codec)

7. Indicateur d’état de connexion Wi-Fi 
(page 55)
S’affiche lorsque la fonction Wi-Fi est réglée 
sur « Enable ». Lorsque l’IFU-WLM3 n’est 
pas installé sur le caméscope,  n’est pas 
affiché.

8. Indicateur de support

9. Indicateur de niveau audio
Affiche le niveau audio pendant 
l’enregistrement.

10. Affichage des données temporelles
Lorsque Display On/Off >Timecode dans le 
menu VF est réglé sur « On », les données 
temporelles sont affichées lorsque la touche 
DISPLAY est pressée.

Pour afficher l’écran d’état :
• Appuyez sur la touche STATUS CHECK.

Pour basculer vers l’écran d’état :
• Tournez la molette SEL/SET.
• Déplacez le sélecteur multiple vers le haut ou 

vers le bas.

Ecran d’état
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Pour masquer l’écran d’état :
• Appuyez sur la touche STATUS CHECK.

Ecran d’état de la caméra
Affiche le réglage d’obturateur électronique de la 
caméra et l’état de l’objectif.

Ecran d’état audio
Affiche le réglage d’entrée, le réglage de vumètre 
audio et de réduction anti-vent pour chaque canal.

Ecran d’état du système
Affiche les réglages de signal vidéo.

Ecran d’état de sortie vidéo
Affiche les réglages de sortie SDI, HDMI et 
vidéo.

Ecran d’état de touche attribuable
Affiche les fonctions attribuées à chacune des 
touches attribuables.

ISO/Gain/EI<H> Réglage ISO/Gain/EI<H>

ISO/Gain/EI<M> Réglage ISO/Gain/EI<M>

ISO/Gain/EI<L> Réglage ISO/Gain/EI<L>

Shutter Réglage d’obturation (Speed/
Angle/ECS/Off)

Iris Valeur F-stop obtenue à partir de 
l’objectif

Zebra1 Réglage Zebra1 On/Off et niveau

Zebra2 Réglage Zebra2 On/Off et niveau

Gamma Réglage de sélection de gamma

White Réglages et mode d’équilibre des 
blancs

Focal Length Valeur de longueur focale obtenue 
à partir de l’objectif

AE Level Réglage du niveau AE

AE Speed Réglage de la vitesse de 
commande AE

AGC Limit Réglage de gain maximum de la 
fonction AGC

A.SHT Limit Vitesse d’obturation la plus élevée 
de la fonction d’obturateur 
automatique

AE Mode Réglage du mode AE (Backlight/
Standard/Spotlight)

CH1 level meter Vumètre audio du canal 1

CH1 Source Source d’entrée du canal 1

CH1 Ref./Sens. Niveau de référence d’entrée du 
canal 1

CH1 Wind Filter Réglage du filtre de réduction anti-
vent du microphone du canal 1

CH2 level meter Vumètre audio du canal 2

CH2 Source Source d’entrée du canal 2

CH2 Ref./Sens. Niveau de référence d’entrée du 
canal 2

CH2 Wind Filter Réglage du filtre de réduction anti-
vent du microphone du canal 2

CH3 level meter Vumètre audio du canal 3

CH3 Source Source d’entrée du canal 3

CH3 Wind Filter Réglage du filtre de réduction anti-
vent du microphone du canal 3

CH4 level meter Vumètre audio du canal 4

CH4 Source Source d’entrée du canal 4

CH4 Wind Filter Réglage du filtre de réduction anti-
vent du microphone du canal 4

Audio Input Level Réglage du niveau d’entrée audio

Monitor CH Réglage de canal de contrôle

HDMI Output CH Réglage de combinaison de canal 
audio de sortie HDMI

Headphone Out Réglage du type de sortie casque

Country Réglage de région NTSC ou PAL

Rec Format Format pour l’enregistrement sur 
des cartes mémoire XQD

Picture Size Format d’image pour 
l’enregistrement sur des cartes 
mémoire XQD

Frame Rate Fréquence d’images pour 
l’enregistrement sur des cartes 
mémoire XQD

Rec Function Réglages et format 
d’enregistrement spécial activé

Simul Rec Etat de Simul Rec On/Off

Picture Cache Rec Etat de Picture Cache Rec On/Off

Video Light Set Indicateur d’allumage/extinction 
de la lampe vidéo HVL-LBPC

Imager Scan Mode de numérisation du capteur 
d’image

SDI1 Taille d’image de sortie
Espace de couleurs
Sortie d’affichage d’écran
Gamma

SDI2 Taille d’image de sortie
Espace de couleurs
Sortie d’affichage d’écran
Gamma

HDMI Taille d’image de sortie
Espace de couleurs
Sortie d’affichage d’écran
Gamma

REF Taille d’image de sortie

RAW Taille d’image de sortie

1 Fonction attribuée à la touche 
ASSIGN 1

2 Fonction attribuée à la touche 
ASSIGN 2

3 Fonction attribuée à la touche 
ASSIGN 3

4 Fonction attribuée à la touche 
ASSIGN 4
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Ecran d’état de la batterie
Affiche des informations à propos de la batterie et 
de la source DC IN.

Ecran d’état du support
Affiche la capacité restante et la durée 
d’enregistrement restante du support 
d’enregistrement (cartes mémoire XQD A et B).

Ecran de réglages de la touche Rec
Affiche les réglages des touches d’enregistrement 
START/STOP sur le caméscope et sur la poignée 
(page 39).

5 Fonction attribuée à la touche 
ASSIGN 5

6 Fonction attribuée à la touche 
ASSIGN 6

IRIS Dial Fonction attribuée à la molette 
IRIS

Assignable Dial Fonction attribuée à la molette 
personnalisable

Detected Battery Type de batterie

Remaining Capacité restante (%)

Charge Count Nombre de charges

Capacity Capacité restante (Ah)

Voltage Tension (V)

Manufacture Date Date de fabrication de la batterie

Video Light 
Remaining

Affiche la capacité restante de la 
batterie de la lampe vidéo.

Power Source Source d’alimentation

Supplied Voltage Tension de la source 
d’alimentation

Informations du 
support A

Affiche l’icône de support lorsque 
le support d’enregistrement est 
inséré dans le logement A. 

Protection du 
support A

Affiche l’icône de verrou lorsque 
le support d’enregistrement inséré 
dans le logement A est protégé 
(verrouillé). 

Remarque

Les cartes mémoire XQD ne 
peuvent pas être protégées lors de 
l’utilisation du caméscope.

Mesure de la 
capacité restante 
du support A

Affiche la capacité restante du 
support d’enregistrement inséré 
dans le logement A, exprimée en 
pourcentage sur un graphique en 
barres.

Durée 
d’enregistrement 
restante du 
support A

Affiche une estimation de la durée 
d’enregistrement restante sur le 
support d’enregistrement inséré 
dans le logement A, en minutes et 
sous les conditions 
d’enregistrement actuelles.

Informations du 
support B

Affiche l’icône de support lorsque 
le support d’enregistrement est 
inséré dans le logement B. 

Protection du 
support B

Affiche l’icône de verrou lorsque 
le support d’enregistrement inséré 
dans le logement B est protégé 
(verrouillé). 

Remarque

Les cartes mémoire XQD ne 
peuvent pas être protégées lors de 
l’utilisation du caméscope.

Mesure de la 
capacité restante 
du support B

Affiche la capacité restante du 
support d’enregistrement inséré 
dans le logement B, exprimée en 
pourcentage sur un graphique en 
barres.

Durée 
d’enregistrement 
restante du 
support B

Affiche une estimation de la durée 
d’enregistrement restante sur le 
support d’enregistrement inséré 
dans le logement B, en minutes et 
sous les conditions 
d’enregistrement actuelles.

Informations de la 
carte SD

Affiche l’icône de support lorsque 
le support est inséré dans le 
logement de carte UTILITY SD. 

Protection de carte 
SD

Affiche l’icône de verrou lorsque 
le support inséré dans le logement 
de carte UTILITY SD est protégé 
(verrouillé). 

Mesure de la 
capacité restante 
de la carte SD

Affiche la capacité restante du 
support inséré dans le logement de 
carte UTILITY SD, exprimé en 
pourcentage sur un graphique en 
barres.

Capacité restante 
de la carte SD

Affiche la capacité restante du 
support inséré dans le logement de 
carte UTILITY SD, exprimée en 
Go.

Durée de vie de la 
carte SD

Affiche l’autonomie du support 
dans le logement de carte 
UTILITY SD, exprimée en 
pourcentage.

Rec Button Affiche les logements pour 
enregistrement commandés par la 
touche d’enregistrement START/
STOP.

Handle Rec 
Button

Affiche les logements pour 
enregistrement commandés par la 
touche d’enregistrement START/
STOP sur la poignée.
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Vous pouvez utiliser un pack batterie ou une 
alimentation CA à partir d’un adaptateur CA.
Pour des raisons de sécurité, utilisez uniquement 
les packs batterie et les adaptateurs CA Sony 
énumérés ci-dessous.

Pack batterie au lithium-ion
BP-U30 (fournis)
BP-U60
BP-U60T
BP-U90

Adaptateurs CA/Chargeurs
BC-U1A (fournis)
BC-U2A

Ne rangez pas les packs batteries dans des 
endroits exposés aux rayons directs du soleil, aux 
flammes ou à des températures élevées.

Remarques

• En cas d’alimentation à partir d’une prise électrique, 
utilisez l’adaptateur CA fourni.

• Réglez toujours le commutateur POWER sur la 
position Off avant de retirer ou d’installer un pack 
batterie ou un adaptateur CA. Si le caméscope est retiré 
ou installé avec le commutateur POWER en position 
On, il est possible, dans certains cas, qu’il ne puisse pas 
démarrer.
Si le caméscope ne peut pas être démarré, réglez le 
commutateur POWER sur la position Off et enlevez le 
pack batterie ou l’adaptateur CA de manière 
temporaire, puis attendez environ 30 secondes avant de 
les installer à nouveau. (Si l’adaptateur CA est retiré ou 
installé pendant que le caméscope fonctionne sur le 
pack batterie, ou vice versa, il peut être retiré ou 
installé sans problème avec le commutateur POWER 
en position On.)

Pour raccorder un pack batterie, branchez le pack 
batterie dans la prise (page 10), en l’enfonçant le 
plus loin possible, puis abaissez-le pour le 
verrouiller en place.

Pour enlever un pack batterie, maintenez la 
touche BATT RELEASE (page 10) enfoncée, 
faites glisser le pack batterie vers le haut et 
retirez-le de sa fixation.

Remarques

• Avant de raccorder un pack batterie, chargez la batterie 
en utilisant l’adaptateur CA/chargeur BC-U1A ou BC-
U2A dédié.

• Le fait de recharger une batterie immédiatement après 
son utilisation, alors qu’elle est encore chaude, peut 
empêcher le chargement total de la batterie.

Préparatifs

Alimentation

Danger

Utilisation d’un pack batterie

Touche BATT 
RELEASE
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Vérification de la capacité restante
En cas de prise de vue/lecture à l’aide d’un pack 
batterie, la capacité restante de la batterie est 
affichée dans le viseur (page 13).

Le caméscope indique la capacité restante en 
calculant l’autonomie du pack batterie si 
l’appareil continue de fonctionner selon son 
niveau de consommation électrique actuel.

Lors de l’utilisation d’une unité d’extension
Lors de l’utilisation de l’unité d’extension 
XDCA-FS7, la tension de batterie ou la capacité 
restante de la batterie est affichée, en fonction de 
la batterie utilisée.

Remarque

Le pack batterie du caméscope ne peut pas être utilisé 
quand une unité XDCA-FS7 est fixée au caméscope. 
Vous devez raccorder un pack batterie au XDCA-FS7 ou 
brancher l’appareil sur une source d’alimentation 
externe.

Si le niveau de charge du pack batterie 
devient faible
Si le niveau de charge restant de la batterie tombe 
au-dessous d’un certain niveau au cours du 
fonctionnement (état Low BATT), un message de 
batterie faible s’affiche, l’indicateur 
d’enregistrement commence à clignoter et un 
signal sonore vous avertit.
Si la charge restante de la batterie tombe au-
dessous du niveau auquel le fonctionnement ne 
peut pas continuer (état BATT Empty), un 
message de batterie vide s’affiche.
Remplacez pack par un pack batterie chargé.

Modification des niveaux d’avertissement
Par défaut, le niveau Low BATT est réglé sur 
10 % de la charge de batterie complète et le 
niveau BATT Empty est réglé sur 3 %. Vous 
pouvez changer les réglages de niveau 
d’avertissement en utilisant Camera Battery 
Alarm (page 102) dans le menu System.

Le raccordement du caméscope à une prise 
électrique vous permet de l’utiliser sans avoir à 
vous inquiéter de recharger le pack batterie.

Exemple de connexion : raccordement du BC-
U1A

Connectez l’adaptateur CA au connecteur DC IN 
du caméscope et branchez le cordon 
d’alimentation (fourni) sur la prise électrique. 
Réglez le commutateur de sélection de mode du 
BC-U1A sur la position DC OUT.

Si la tension de sortie de l’adaptateur CA 
devient faible
Si la tension de sortie de l’adaptateur CA tombe 
au-dessous d’un certain niveau au cours du 
fonctionnement (état DC Low Voltage1), un 
message vous informant que la tension de sortie 
de l’adaptateur CA a chuté s’affiche, l’indicateur 
d’enregistrement commence à clignoter et un 
signal sonore est émis.
Si la tension de sortie de l’adaptateur CA tombe 
au-dessous du niveau auquel le fonctionnement 
ne peut pas continuer (état DC Low Voltage2), un 
message vous informant que la tension de sortie 
de l’adaptateur CA est trop faible s’affiche.

    Icône Capacité restante

91 % à 100 %

71 % à 90 %

51 % à 70 %

31 % à 50 %

11 % à 30 %

0 % à 10 %

Utilisation de l’alimentation CA

Connecteur DC IN

Vers la 
prise 
électrique

Cordon 
d’alimentation

BC-U1A
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Si cela se produit, l’adaptateur CA peut être 
défectueux. Vérifiez l’adaptateur CA, le cas 
échéant.

Modification des niveaux d’avertissement
Le niveau DC Low Voltage1 est réglé sur 11,5 V 
et le niveau DC Low Voltage2 est réglé sur 
11,0 V par défaut. Vous pouvez changer les 
réglages de niveau d’avertissement en utilisant 
Camera DC IN Alarm (page 102) dans le menu 
System.

Adaptateurs CA
• Ne connectez pas et n’utilisez pas un adaptateur 

CA dans un espace confiné, comme par 
exemple entre un mur et des meubles.

• Connectez l’adaptateur CA à la prise électrique 
la plus proche. Si un problème se produit lors du 
fonctionnement, débranchez immédiatement le 
cordon d’alimentation de la prise.

• Ne court-circuitez pas les pièces métalliques de 
la fiche de l’adaptateur CA. Cela entraînerait un 
dysfonctionnement.

• La batterie ne peut pas être chargée lorsqu’elle 
est fixée au caméscope, même si l’adaptateur 
CA est branché.

Remarques

• Le support de microphone est fixé dès l’envoi depuis 
l’usine.

• Fixez/retirez le support de microphone lorsque le 
caméscope est hors tension.

• Fixez/retirez le support de microphone avec le 
capuchon de monture fixé afin de ne pas endommager 
le capteur d’image.

1 Insérez le support de microphone dans 
la poignée.

2 Insérez la pièce d’arrêt dans la cavité, 
puis serrez la vis pour fixer le support.

Fixation de dispositifs

Fixation du support de 
microphone

Pièce d’arrêt
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Retrait du support de microphone
Retirez la pièce d’arrêt, puis utilisez la procédure 
inverse de celle utilisée pour fixer le support de 
microphone.

Remarque

Fixez/retirez le viseur lorsque le caméscope est hors 
tension.

1 Détachez l’attache du viseur et insérez 
le viseur dans la saillie sur l’avant de la 
poignée.

2 Ajustez le positionnement gauche/droit 
du viseur, serrez l’attache, puis 
connectez le câble du viseur au 
connecteur de viseur du caméscope.

Remarque

Vérifiez que le viseur est bien fixé. Le viseur peut tomber 
pendant la prise de vue si l’attache est desserrée.

Ajustement de l’angle du viseur
Inclinez le viseur vers le haut/bas pour ajuster 
l’angle du viseur.

Vous pouvez ajuster l’angle de sorte que le viseur 
fasse face au sujet. Le fait de régler le 
commutateur MIRROR (page 50) sur le B/T 
inverse les côtés gauche et droit de l’image sur 
l’écran LCD, mais l’image est enregistrée dans 
l’orientation correcte.

Ajustement du contraste du viseur
Tournez le bouton CONTRAST pour ajuster le 
contraste.

Vous pouvez ajuster la luminosité dans le viseur 
à l’aide de VF Setting >Brightness (page 85) dans 
le menu VF.

Retrait du viseur
Détachez l’attache du viseur et utilisez la 
procédure inverse de celle utilisée pour la fixation 
du viseur.

Fixation du viseur

Attache
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Remarque

Fixez/retirez le viseur lorsque le caméscope est hors 
tension.

1 Fixez les attaches métalliques de 
l’oculaire aux crochets de fixation de 
l’oculaire sur le viseur.

2 Appuyez sur la plaque de verrouillage 
situé sous l’oculaire dans la direction de 
la flèche pour verrouiller l’oculaire.

Ouverture de l’oculaire

Appuyez sur le bouton indiqué par la flèche.

Ouvrez l’oculaire vers le haut après avoir 
déverrouillé la pièce. Le viseur est directement 
visible lorsque l’oculaire est ouvert.

Retrait du viseur
Retirez le verrou de l’oculaire puis retirez 
l’oculaire du viseur.

Fixation de l’oculaire

Crochets de fixation de l’oculaire

Plaque de 
verrouillage
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Objectifs recommandés
SELP28135G
SEL1635Z
SELP18200

Pour de plus amples informations concernant les 
objectifs pouvant être utilisés avec le caméscope, 
contactez votre technicien Sony.

Ne laissez pas l’objectif orienté en plein soleil. 
Les rayons directs du soleil peuvent entrer par 
l’objectif, se concentrer dans le caméscope et 
provoquer un incendie.

Remarques

• Fixez/retirez l’objectif lorsque le caméscope est hors 
tension.

• Un objectif est un composant de précision. Ne placez 
pas l’objectif sur une surface avec le côté de la monture 
d’objectif tourné vers le bas. Fixez le capuchon de la 
monture d’objectif fourni.

Fixation à un trépied
Utilisez les orifices de vis du trépied sur le 
caméscope lorsque vous fixez un trépied. Utiliser 
la monture pour trépied sur l’objectif pourrait 
provoquer des dommages.

Fixation d’un objectif à monture E

1 Retirez le capuchon de l’objectif et le 
couvercle du caméscope et de l’objectif.

2 Alignez le repère de monture d’objectif 
(blanc) avec le caméscope, insérez 
prudemment l’objectif, puis tournez 
l’objectif dans le sens des aiguilles d’une 
montre.

L’objectif émet un clic lorsqu’il se verrouille 
en position.

Fixation d’un objectif à monture A
Pour utiliser un objectif à monture A, fixez un 
adaptateur de monture d’objectif (optionnel), puis 
fixez l’objectif à monture A.

Remarques

• Lors de l’utilisation d’un objectif à monture A, Iris est 
réglé sur Manual.

• Lorsque la mise au point est réglée sur AF avec un 
LA-EA2 ou LA-EA4 fixé, Iris est réglé sur F3.5 ou est 
complètement ouvert.

Retrait d’un objectif
Retirez un objectif en suivant la procédure 
suivante.

1 Maintenez le bouton de déverrouillage 
d’objectif enfoncé et tournez l’objectif 
dans le sens inverse des aiguilles d’une 
montre.

2 Tirez l’objectif vers l’avant pour 
l’extraire.

Remarque

Si aucun autre objectif ne va être fixé dans l’immédiat, 
placez la monture d’objectif dans la partie creuse du 
capuchon de monture d’objectif puis tournez-le dans le 
sens des aiguilles d’une montre.

Fixation d’un objectif

Danger

Repère de monture 
(blanc)
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Réglages de diaphragme pour les 
objectifs dotés d’un commutateur Auto 
Iris
• Quand l’objectif Auto Iris est réglé sur AUTO, 

le diaphragme est automatiquement ajusté et 
peut également être ajusté manuellement depuis 
le caméscope.

• Quand l’objectif Auto Iris est réglé sur 
MANUAL, le diaphragme peut uniquement être 
ajusté grâce à la bague d’objectif. L’utilisation 
du diaphragme depuis le caméscope n’a aucun 
effet.

Réglages de mise au point pour les 
objectifs avec commutateur de mise au 
point
• Quand le commutateur de mise au point de 

l’objectif est réglé sur AF/MF ou AF, la mise au 
point est automatiquement ajustée et peut 
également être ajustée manuellement depuis le 
caméscope.

• Quand le commutateur de mise au point de 
l’objectif est réglé sur Full MF ou MF, la mise 
au point peut uniquement être ajustée grâce à la 
bague d’objectif. L’utilisation de la mise au 
point depuis le caméscope n’a aucun effet.

Remarque

Fixez/retirez la télécommande à poignée lorsque le 
caméscope est hors tension.

1 Fixez le bras sur la fixation de poignée, 
puis serrez la vis.

2 Branchez le câble de télécommande à 
poignée sur le connecteur REMOTE du 
caméscope.Fixation de la télécommande à 

poignée
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Remarques

• Vérifiez que le bras et la télécommande à poignée sont 
bien fixés. Ils peuvent tomber pendant la prise de vue 
si les vis sont desserrées.

• Ne soutenez pas le poids du caméscope en tenant 
uniquement la télécommande à poignée.

Ajustement de la position de la 
télécommande à poignée
Ajustez l’angle de bras (1).
Desserrez les deux vis à l’arrière du bras en 
utilisant une pièce de monnaie ou un objet 
similaire, ajustez la longueur du bras (2), puis 
serrez les deux vis.
Appuyez sur la touche de rotation de la poignée 
(page 11) pour ajuster l’angle de la 
télécommande à poignée (3).

Retrait de la télécommande à poignée

1 Débranchez le câble de télécommande à 
poignée du connecteur REMOTE du 
caméscope.

2 Retirez le bras du caméscope.

L’écran de réglages initiaux s’affiche dans le 
viseur la première fois que le caméscope est mis 
sous tension ou après le déchargement total de la 
batterie de secours.
Réglez la date et l’heure de l’horloge interne en 
utilisant cet écran.

Time Zone
La fonction Time Zone définit le décalage horaire 
par rapport au temps universel. Changez le 
réglage si nécessaire.

Réglage de la date et de l’heure
Tournez la molette SEL/SET (page 9) pour 
sélectionner des éléments et des réglages, puis 
appuyez sur la molette SEL/SET pour appliquer 
les réglages et pour lancer le fonctionnement de 
l’horloge.
Une fois que l’écran de réglages est fermé, vous 
pouvez changer la date, l’heure et le fuseau 
horaire à l’aide de Clock Set (page 101) dans le 
menu System.

Remarques

• Si le réglage d’horloge est perdu pour cause de 
déchargement complet de la batterie de secours suite à 
une longue déconnexion de l’alimentation (pas de pack 
batterie et pas de source d’alimentation DC IN), 
l’écran de réglages initiaux s’affiche lors de la mise 
sous tension suivante du caméscope.

• Pendant que l’écran de réglages initiaux est affiché, 
aucune autre opération n’est possible, sauf la mise hors 
tension, jusqu’à ce que vous finissiez les réglages sur 
cet écran.

• Le caméscope possède une batterie rechargeable 
intégrée afin de stocker la date, l’heure et d’autres 
réglages, même lorsque le caméscope est éteint. Pour 
en savoir plus sur la batterie rechargeable intégrée, voir 
page 109.

Réglage de l’horloge
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Avant la prise de vue, configurez les opérations 
de base du caméscope pour les adapter à 
l’application nécessaire.

Vous pouvez commuter le mode de prise de vue, 
entre le mode « Custom » pour créer une 
souplesse d’images sur place et le mode « Cine 
EI » (pour lequel le caméscope fonctionne 
comme une caméra de film, les métrages étant 
développés en postproduction).
Vous pouvez sélectionner le mode à l’aide de 
Base Setting (page 96) >Shooting Mode dans le 
menu System.

Color Space permet de sélectionner la gamme de 
couleurs de base pour les signaux enregistrés et 
les signaux de sortie.
Quand le mode de prise de vue est réglé sur 
Custom, Color Space est réglé sur « Matrix ».

Matrix : sélectionne la gamme de couleurs à l’aide 
du réglage Matrix, semblable aux caméras 
vidéo traditionnelles.

Quand le mode de prise de vue est réglé sur le 
mode Cine EI, Color Space sélectionne la gamme 
de couleurs de la sortie vidéo avec MLUT réglé 
sur Off.

S-Gamut/SLog2 : Large gamme de couleurs 
comparable aux caméras de films.

S-Gamut3.Cine/SLog3 : gamme de couleurs facile 
à ajuster pour le mode de cinéma numérique 
(DCIP3).

S-Gamut3/SLog3 : large gamme de couleurs, 
permettant la compatibilité avec de futures 
gammes de couleurs standards, optimisée à 
l’aide de la technologie de correction de la 
distorsion d’images de Sony.

Vous pouvez sélectionner la gamme de couleurs à 
l’aide de Base Setting (page 96) >Color Space 
dans le menu System.

Vous pouvez régler le mode de numérisation du 
capteur d’image.
Vous pouvez sélectionner le mode à l’aide de 
Base Setting (page 96) >Imager Scan Mode dans 
le menu System.

Normal : Lorsque vous n’utilisez pas le mode de 
fréquence d’image élevée Slow & Quick 
Motion, il numérise tout l’angle de vue de la 
taille Super 35mm.
Lorsque S&Q Motion (page 90) > High 
Frame Rate Mode dans le menu Recording est 
réglé sur « Full Scan », il numérise tout 
l’angle de la vue de la taille Super 35mm et 
convertit le signal en données 2K. Lorsqu’il 
est réglé sur « Center Scan », il numérise un 
angle de vue 2K de la moitié de la taille 
Super 35mm au centre de l’image.

2K Full : Numérise le plein angle de vue de la taille 
Super 35mm et convertit le signal en 2K.

2K Center : Numérise un angle de vue 2K de la 
moitié de la taille Super 35mm au centre de 
l’image.

Remarque

La résolution de format d’enregistrement est restreinte à 
2K ou inférieure lorsque Imager Scan Mode (page 97) 
est réglé sur 2K Full ou 2K Center.

Configuration des 
opérations de base du 
caméscope

Shooting Mode

Color Space

Mode de numérisation de capteur 
d’image
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Ce caméscope permet d’effectuer des 
enregistrements audio et vidéo sur des cartes 
mémoire XQD (disponibles séparément) insérées 
dans les logements pour cartes.

Utilisez les cartes mémoire XQD Sony suivantes 
dans le caméscope.
Pour plus de détails sur le fonctionnement avec 
des supports provenant d’autres fabricants, 
reportez-vous aux instructions d’utilisation du 
support ou consultez les informations du 
fabricant.

Cartes mémoire XQD de la série S

Cartes mémoire XQD de la série H

Cartes mémoire XQD de la série N

Cartes mémoire XQD de la série M

Cartes mémoire XQD de la série G

L’utilisation de cartes mémoire autres que des 
cartes mémoire Sony XQD n’est pas garantie.

Pour de plus amples informations concernant 
l’utilisation des cartes mémoire XQD et les 
précautions d’utilisation les concernant, reportez-
vous au mode d’emploi de la carte mémoire XQD.

Utilisation de cartes 
mémoire XQD

A propos des cartes mémoire XQD
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Les conditions de fonctionnement garanti varient en fonction des réglages Rec Format et Recording.
Oui : Fonctionnement pris en charge
Non : Le fonctionnement normal n’est pas garanti

Support recommandé

Format XQD G
XQD S
(EB Stream)

XQD N
XQD M

Interrompu
XQD H
XQD S
(non EB 
Stream)

32/64/128 GB 32/64/128 *1 GB 16/32/64 GB

XAVC-I 4096×2160P – 59.94P Oui Non Non

50P Oui Non Non

29.97P Oui Non Non

25P Oui Non Non

24P Oui Non Non

23.98P Oui Non Non

3840×2160 – 59.94P Oui Non Non

50P Oui Non Non

29.97P Oui Non Non

25P Oui Non Non

23.98P Oui Non Non

1920×1080 Mode normal ou 

S&Q (hors HFR*2)

59.94P Oui Non Non

59.94i Oui Oui Non

50P Oui Non Non

50i Oui Oui Non

29.97P Oui Oui Non

25P Oui Oui Non

23.98P Oui Oui Non

S&Q (mode HFR) 59.94P Oui Non Non

50P Oui Non Non

29.97P Oui Non Non

25P Oui Non Non

23.98P Oui Non Non
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*1 M-series uniquement
*2 HFR : Fréquence d’images élevée

XAVC-L 3840×2160 – 59.94P Oui Oui Non

50P Oui Oui Non

29.97P Oui Oui Non

25P Oui Oui Non

23.98P Oui Oui Non

1920×1080 Mode normal ou 
S&Q (hors HFR)

59.94P Oui Oui Oui

50P Oui Oui Oui

59.94i Oui Oui Oui

50i Oui Oui Oui

29.97P Oui Oui Oui

25P Oui Oui Oui

23.98P Oui Oui Oui

1920×1080 S&Q (mode HFR) 59.94P Oui Oui Non

50P Oui Oui Non

29.97P
Oui

50 Mbps : Non
35 Mbps : Oui

Non

25P Oui Non Non

23.98P Oui Non Non

MPEG HD 
422

1920×1080 – 59.94i Oui Oui Oui

50i Oui Oui Oui

29.97P Oui Oui Oui

25P Oui Oui Oui

23.98P Oui Oui Oui

1280×720 – 59.94P Oui Oui Oui

50P Oui Oui Oui

29.97P Oui Oui Oui

25P Oui Oui Oui

23.98P Oui Oui Oui

ProRes 422 
HQ

1920×1080 – 59.94i Oui Non Non

50i Oui Non Non

29.97P Oui Non Non

25P Oui Non Non

23.98P Oui Non Non

ProRes 422 1920×1080 – 59.94i Oui Oui Non

50i Oui Oui Non

29.97P Oui Oui Non

25P Oui Oui Non

23.98P Oui Oui Non

Format XQD G
XQD S
(EB Stream)

XQD N
XQD M

Interrompu
XQD H
XQD S
(non EB 
Stream)

32/64/128 GB 32/64/128 *1 GB 16/32/64 GB
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1 Appuyez sur la touche de 
déverrouillage du cache du support 
(page 10) pour ouvrir le cache du 
support de la section de logement pour 
carte.

2 Insérez une carte mémoire XQD avec 
l’étiquette XQD tournée vers la gauche.

L’indicateur d’accès (page 10) est allumé en 
rouge, puis passe au vert si la carte est 
utilisable.

3 Fermez le cache du support.

Remarques

• La carte mémoire, le logement de carte mémoire et les 
données d’images sur la carte mémoire peuvent être 
endommagés si la carte est enfoncée de force dans le 
logement dans le mauvais sens.

• Lorsque vous enregistrez sur des supports situés dans 
les logements .pour carte XQD A et B, insérez dans ces 
deux logements des supports recommandés pour être 
utilisés avec le format devant être enregistré.

Appuyez sur la touche de déverrouillage du cache 
du support (page 10) pour ouvrir le cache du 
support de la section de logement pour carte et 
appuyez légèrement sur la carte mémoire insérée 
pour l’éjecter.

Remarques

• Si le caméscope est arrêté ou la carte mémoire enlevée 
pendant que le système accède à la carte mémoire, 
l’intégrité des données sur la carte ne peut pas être 
garantie. Toutes les données enregistrées sur la carte 
peuvent être supprimées. Assurez-vous toujours que 
l’indicateur d’accès est allumé en vert ou éteint avant 
d’arrêter le caméscope ou d’enlever la carte mémoire.

• Si une carte mémoire XQD est retirée immédiatement 
après l’enregistrement, elle peut être chaude, mais cela 
n’indique pas un problème.

Quand des cartes mémoire XQD sont chargées 
dans les logements pour carte A et B, vous pouvez 
changer la carte utilisée pour enregistrer en 
appuyant sur la touche SLOT SELECT (page 9).
Si une carte devient pleine pendant 
l’enregistrement, le caméscope passe 
automatiquement à l’autre carte.

Remarque

La touche SLOT SELECT est désactivée pendant la 
lecture. Les cartes mémoire ne sont pas commutées 
même si vous appuyez sur la touche. La touche est 
activée lorsque l’écran de miniatures (page 58) est 
affiché.

Si une carte mémoire XQD non formatée ou une 
carte mémoire XQD formatée selon une 
spécification différente est insérée, le message 
« Media Needs to be Formatted » s’affiche dans 
le viseur.
Formatez la carte en utilisant la procédure 
suivante.

Sélectionnez Format Media (page 93) 
>Media(A) ou Media(B) dans le menu 
Media, puis sélectionnez Execute. 
Lorsqu’un message de confirmation 
apparaît, sélectionnez « Execute » de 
nouveau.

Un message s’affiche pendant le formatage et le 
voyant d’accès est allumé en rouge.
Une fois le formatage terminé, un message 
indiquant la fin de l’opération s’affiche. Appuyez 
sur la molette SEL/SET pour ignorer le message.

En cas d’échec du formatage
Les cartes mémoire XQD protégées et les cartes 
mémoire non prises en charge par le caméscope 
ne peuvent pas être formatées.
Un message d’avertissement est affiché. Suivez 
les instructions pour remplacer la carte par une 
carte mémoire XQD prise en charge.

Remarque

Le formatage d’une carte mémoire efface toutes les 
données, y compris les données vidéo et les fichiers de 
configuration enregistrés.

Insertion d’une carte mémoire 
XQD

Ejection de cartes mémoire XQD

Passage d’une carte mémoire 
XQD à l’autre

Formatage (initialisation) de 
cartes mémoire XQD
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Lors d’une prise de vue (enregistrement/veille), 
vous pouvez surveiller la capacité restante de la 
carte mémoire XQD dans chacun des logements à 
l’aide des indicateurs de capacité de support des 
logements A/B dans le viseur (page 13).
Le temps d’enregistrement restant est calculé à 
partir de la capacité restante du support de chaque 
logement et du format vidéo actuel (débit binaire 
d’enregistrement) et est affiché en unités de 
minutes.

Remarque

Un repère  s’affiche si le support est protégé.

Synchronisation de remplacement de 
carte mémoire XQD
• Quand le temps d’enregistrement total restant 

sur les deux cartes mémoire devient inférieur à 
5 minutes, le message « Media Near Full » 
s’affiche, l’indicateur d’enregistrement 
commence à clignoter et un signal sonore (émis 
à partir du casque) vous avertit. 
Remplacez les cartes par un support ayant de 
l’espace libre.

• Si vous continuez d’enregistrer jusqu’à ce que 
le temps total d’enregistrement restant atteigne 
0, le message passe à « Medial Full » et 
l’enregistrement s’arrête.

Remarque

Un maximum de 600 plans environ peut être enregistré 
sur une carte mémoire XQD.
Si le nombre de plans enregistrés atteint la limite, 
l’indicateur de temps d’enregistrement restant passe à 
« 0 » et le message « Media Full » s’affiche.

Vous pouvez sauvegarder les données de 
configuration de caméra du caméscope sur une 
carte SD (disponible séparément). Des fichiers de 
données sauvegardés peuvent être importés à 
partir de la carte SD.

Cartes mémoire SDHC*
Cartes mémoire SD*
* Désignées collectivement sous le nom de « Cartes 

SD » dans ce manuel.

1 Appuyez sur la touche de 
déverrouillage du cache du support 
(page 10) pour ouvrir le cache du 
support de la section de logement pour 
carte.

2 Insérez la carte mémoire SD avec 
l’étiquette SD tournée vers la gauche.

L’indicateur d’accès (page 10) est allumé en 
rouge, puis s’éteint si la carte est utilisable.

3 Fermez le cache du support.

Appuyez sur la touche de déverrouillage du 
cache du support (page 10) pour ouvrir le 
cache du support de la section de logement 
pour carte et appuyez légèrement sur la 
carte SD insérée pour l’éjecter.

Remarques

• Si le caméscope est arrêté ou la carte SD enlevée 
pendant que le système accède à la carte SD, l’intégrité 
des données sur la carte ne peut pas être garantie. 
Toutes les données enregistrées sur la carte peuvent 
être supprimées. Assurez-vous toujours que 
l’indicateur d’accès est éteint avant d’arrêter le 
caméscope ou d’enlever la carte SD.

• Prenez des précautions pour éviter que la carte SD ne 
soit expulsée lors de l’insertion/éjection de la carte.

Vérification de la durée 
d’enregistrement restante Utilisation d’une carte 

UTILITY SD

Cartes SD prises en charge

Insertion d’une carte SD

Ejection de la carte SD
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Les cartes SD doivent être formatées lors de leur 
première utilisation dans le caméscope.
Les cartes SD devant être utilisées dans le 
caméscope doivent être formatées à l’aide de la 
fonction de formatage du caméscope. Si un 
message s’affiche quand la carte SD est insérée 
dans le caméscope, formatez la carte SD.

Sélectionnez Format Media (page 93) >SD 
Card dans le menu Media, puis sélectionnez 
Execute. Lorsqu’un message de 
confirmation apparaît, sélectionnez 
« Execute » de nouveau.

Un message et l’état de progression s’affichent 
pendant le formatage et l’indicateur d’accès est 
allumé en rouge.
Une fois le formatage terminé, un message 
indiquant la fin de l’opération s’affiche. Appuyez 
sur la molette SEL/SET pour ignorer le message.

Remarque

Le formatage d’une carte SD efface toutes les données 
sur la carte. La carte ne peut pas être restaurée.

Vous pouvez vérifier la capacité restante sur une 
carte SD sur l’écran Media Status (page 17).

Remarque

Un repère  s’affiche si la carte SD est protégée.

Pour utiliser une carte SD formatée sur le 
caméscope dans la fente d’un autre dispositif
Effectuez d’abord une copie de sauvegarde de la 
carte, puis reformatez la carte dans le dispositif à 
utiliser.

Vous pouvez ajouter des fonctions au caméscope, 
comme une batterie à griffe en V ou un signal de 
synchronisation externe, en fixant une unité 
d’extension XDCA-FS7 (optionnelle) au 
caméscope.

Remarques

• Le pack batterie du caméscope ne peut pas être utilisé 
quand une unité XDCA-FS7 est fixée au caméscope. 
Vous devez raccorder un pack batterie au XDCA-FS7 
ou brancher l’appareil sur une source d’alimentation 
externe.

• Fixez/retirez l’unité XDCA-FS7 pendant que le 
caméscope est hors tension.

1 Enlevez le pack batterie (page 18) fixé 
au caméscope.

2 Enlevez le cache du connecteur de 
l’unité d’extension.

Formatage (initialisation) de 
cartes SD

Vérification de la capacité 
restante

Utilisation de l’unité 
XDCA-FS7

Fixation de l’unité XDCA-FS7
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3 Alignez les saillies de l’unité XDCA-FS7 
avec les cannelures gauche et droite du 
caméscope et faites-les glisser 
entièrement, puis faites glisser l’unité 
XDCA-FS7 dans la section du 
connecteur.

4 Serrez les deux vis sur le dessus de 
l’unité XDCA-FS7 pour la fixer.

Le cache du connecteur de l’unité 
d’extension peut être inséré dans la partie 
supérieure de l’unité d’extension.

Desserrez les deux vis sur le dessus de l’unité 
XDCA-FS7 et enlevez l’unité XDCA-FS7 du 
caméscope.

Insérez le pack batterie dans la fixation de pack 
batterie sur l’unité XDCA-FS7.

Cannelures Saillies
Retrait de l’unité XDCA-FS7

Fixation du pack batterie
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Retirez le pack batterie de la fixation de pack 
batterie sur l’unité XDCA-FS7 tout en 
maintenant la touche BATT RELEASE enfoncée.

Vous pouvez commuter l’entrée/sortie de code 
temporel en utilisant le commutateur TC IN/OUT 
(page 12).

Pour en savoir plus, voir page 107.

Vous pouvez enregistrer une vidéo au format 
RAW (page 53) sur un enregistreur RAW 
AXS-R5 (optionnel) à l’aide d’une unité 
d’interface HXR-IFR5 (optionnelle) et d’une 
unité XDCA-FS7 (optionnelle).
Pour plus de détails sur l’installation des unités 
HXR-IFR5 et AXS-R5, consultez le mode 
d’emploi de l’unité HXR-IFR5.

1 Fixez le XDCA-FS7 au caméscope 
(page 32).

2 Raccordez le connecteur RAW OUT de 
l’unité XDCA-FS7 au connecteur SDI 
IN (RAW) de l’unité HXR-IFR5 à l’aide 
d’un câble SDI.

Débranchez le câble SDI du connecteur 
RAW OUT de l’unité XDCA-FS7.

Retrait du pack batterie

Commutation de l’entrée/sortie de 
code temporel

Utilisation de l’unité 
HXR-IFR5 et AXS-R5

Connexion de l’unité HXR-IFR5 au 
caméscope

Retrait de l’unité HXR-IFR5

câble SDI

HXR-IFR5

AXS-R5
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Lors de la première utilisation
Retirez la feuille isolante du support de batterie 
lors de la première utilisation de la télécommande 
à infrarouge fournie. 

Une batterie lithium-ion CR2025 est installée 
dans le support de batterie en usine.

Commande du caméscope à l’aide de la 
télécommande
Pour utiliser la télécommande, commencez par 
mettre le caméscope sous tension, puis activez la 
fonction de télécommande.
Utilisez le menu de configuration pour activer/
désactiver la fonction de télécommande.

Pour activer à l’aide du menu
Appuyez sur la touche MENU pour faire passer le 
caméscope au mode menu, puis réglez IR Remote 
(page 102) dans le menu System sur On.

Remarques

• Dirigez la télécommande vers le capteur du récepteur 
de la télécommande sur le caméscope.

• Installez le caméscope de sorte que le capteur du 
récepteur de la télécommande ne soit pas exposé à la 
lumière directe du soleil ou à la lumière forte d’autres 
sources. Une lumière forte peut empêcher le bon 
fonctionnement de la télécommande.

• D’autres platines vidéo peuvent être actionnées par 
erreur lorsque la télécommande est utilisée pour 
actionner le caméscope. Dans ce cas, commutez le 
commutateur de mode de télécommande sur la platine 
vidéo sur DVD2 ou cachez le capteur du récepteur de 
la télécommande à l’aide d’un papier noir.

Remplacement de la pile de la 
télécommande
La télécommande utilise une pile CR2025 
standard.
N’utilisez pas d’autres piles que celles du type 
CR2025.

1 Poussez la languette vers l’intérieur et 
retirez le support de pile en plaçant un 
ongle dans la cannelure.

2 Insérez une nouvelle pile avec la borne + 
tournée vers le haut.

3 Insérez le support de pile jusqu’à ce 
qu’il se mette en place en émettant un 
déclic.

Ne rangez pas les packs batteries dans des 
endroits exposés aux rayons directs du soleil, aux 
flammes ou à des températures élevées.

Remarque

Le remplacement de la pile par une pile non-spécifiée 
peut entraîner la défaillance de l’appareil. Remplacez 
toujours la pile par une pile spécifiée.
Mettez les piles usagées au rebut conformément aux lois 
fédérales et locales.

Utilisation de la 
télécommande à 
infrarouge

Feuille isolante

Danger

Languette



36

Vous pouvez faire fonctionner le caméscope 
depuis un navigateur Web en raccordant un 
smartphone, une tablette ou un autre dispositif 
prenant en charge un navigateur Web au 
caméscope à l’aide d’une connexion LAN sans 
fil. Cette fonction est appelée télécommande 
Wi-Fi.
Cette fonction est utile pour faire fonctionner le 
caméscope à distance, par exemple, lorsque le 
caméscope est monté sur une grue.
Pour en savoir plus sur la procédure de 
configuration de la télécommande Wi-Fi, voir 
page 57.

Ecran Wi-Fi Remote (smartphone)

Ecran Main

Ecran Playback

Ecran Cursor

Ecran Assign

Utilisation de la 
commande à distance 
Wi-Fi

• Réglages
S&Q FPS, Shutter, 
White, Sensitivity/
Gain/Exposure Index, 
Gamma, MLUT, Color 
Bars, Auto Black, 
Auto White, Rec Start/
Stop, Lock, Iris, Focus, 
Zoom, Auto Iris, Auto 
Shutter, AGC, ATW

• Etat
• Touches de lecture 

Play/Pause, Stop, F 
Fwd, F Rev, Next, Prev

• Etat
• Touches de curseur 

Up, Down, Left, Right, 
Set, Cancel/Back, 
Menu, Status, 
Thumbnail, User 
Menu

• Etat
• Touches 

personnalisables
Touches 
personnalisables 1 à 6
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Ecran Wi-Fi Remote (tablette)

Ecran Main

• Réglages
S&Q FPS, Shutter, White, Sensitivity/Gain/Exposure 
Index, Gamma, MLUT, Color Bars, Auto Black, Auto 
White, Rec Start/Stop, Lock, Iris, Focus, Zoom, Auto 
Iris, Auto Shutter, AGC, ATW

Ecran Playback

• Etat
• Touche de lecture

Play/Pause, Stop, F Fwd, F Rev, Next, Prev

Ecran Cursor

• Etat
• Touches de curseur 

Up, Down, Left, Right, Set, Cancel/Back, Menu, 
Status, Thumbnail, User Menu

Ecran Assign

• Etat
• Touches personnalisables

Touches personnalisables 1 à 6
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La prise de vue de base s’effectue à l’aide de la 
procédure suivante.

1 Connectez les dispositifs nécessaires et 
vérifiez que l’alimentation est branchée.

2 Insérez la/les carte(s) mémoire.

3 Réglez le commutateur POWER sur 
ON.

L’image de caméra s’affiche dans le viseur.

4 Appuyez sur la touche 
d’enregistrement (page 7).

L’indicateur d’enregistrement s’allume et le 
caméscope commence à enregistrer.

5 Pour cesser d’enregistrer, appuyez de 
nouveau sur le bouton 
d’enregistrement.

L’enregistrement s’arrête et le caméscope 
passe au mode STBY (veille).

Remarque

Si la touche d’enregistrement est actionnée dans les 
quelques secondes suivant la mise sous tension du 
caméscope, l’indicateur d’enregistrement s’allume pour 
indiquer que l’unité est en état d’enregistrement, mais 
l’enregistrement sur le support peut ne pas se déclencher 
pour les premières secondes, en fonction du format 
d’enregistrement sélectionné.

Prise de vue (mode Full Auto)
Appuyez sur la touche FULL AUTO ; le voyant 
de la touche s’allume alors.
Les fonctions de diaphragme automatique 
(objectifs compatibles uniquement), AGC, 
d’obturateur automatique, ATW (suivi 
automatique de l’équilibre des blancs) sont 
activées pour contrôler automatiquement la 
luminosité et l’équilibre des blancs (mode Full 
Auto).
Pour contrôler manuellement chaque fonction, 
désactivez le mode Full Auto.

Enregistrement ininterrompu en cas de 
passage d’une carte mémoire à l’autre 
(Enregistrement relais)
Quand des cartes mémoire sont insérées dans les 
logements A et B, l’enregistrement passe 
automatiquement à la seconde carte mémoire 
juste avant que la capacité restante sur la première 
carte atteigne 0.

Remarques

• N’éjectez pas une carte mémoire pendant que des 
données y sont en cours d’enregistrement. Remplacez 
uniquement les cartes mémoire des logements pour 
lesquels l’indicateur d’accès de logement est éteint.

• Quand la capacité restante sur la carte mémoire en 
cours d’enregistrement descend au-dessous d’une 
minute et qu’une carte mémoire enregistrable est 
insérée dans l’autre logement, un message « Will 
Switch Slots Soon » s’affiche. Le message disparaît 
après l’échange de logement de carte mémoire.

• L’enregistrement relais peut ne pas fonctionner si 
l’enregistrement est lancé alors que la capacité restante 
de la carte mémoire est inférieure à une minute. Pour 
un enregistrement relais correct, vérifiez que la 
capacité restante de la carte mémoire est supérieure à 
une minute avant de commencer l’enregistrement.

• La vidéo créée à l’aide de la fonction d’enregistrement 
relais du caméscope ne peut pas être lue sans problème 
sur le caméscope.

• Pour combiner la vidéo créée en utilisant la fonction 
d’enregistrement relais du caméscope, utilisez le 
logiciel Catalyst Browse.

Prise de vue

Procédure d’opération de base
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Enregistrement simultané sur les cartes 
mémoire A et B (Simul Rec)
Vous pouvez enregistrer simultanément sur les 
cartes mémoire A et B.

Réglez Simul Rec >Setting dans le menu 
Recording sur « On ».

Remarque

L’enregistrement simultané n’est pas pris en charge en 
mode ralenti et accéléré (page 90) ou en mode 
d’enregistrement de cache d’images (page 91).
En outre, l’enregistrement simultané n’est pas pris en 
charge pour les formats d’enregistrement suivants 
(page 97).

Région NTSC
XAVC-I
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 24.00P, 4096 × 2160 23.98P, 
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P, 1920 × 1080 59.94P
XAVC-L
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P
RAW (avec XDCA-FS7, HXR-IFR5, et AXS-R5 
connectés)
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 23.98P, 2048 × 1080 59.94P, 
2048 × 1080 29.97P, 2048 × 1080 23.98P
RAW & XAVC-I (avec XDCA-FS7, HXR-IFR5, 
et AXS-R5 connectés)
4096 × 2160 59.94P, 2048 × 1080 59.94P
ProRes 422 HQ, ProRes 422 (avec XDCA-FS7 
connecté)
1920 × 1080 59.94i, 1920 × 1080 29.97P, 
1920 × 1080 23.98P

Région PAL
XAVC-I
4096 × 2160 50P, 4096 × 2160 25P, 
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P
XAVC-L
3840 × 2160 50P, 3840 × 2160 25P
RAW (avec XDCA-FS7, HXR-IFR5, et AXS-R5 
connectés)
4096 × 2160 50P, 4096 × 2160 25P, 
2048 × 1080 50P, 2048 × 1080 25P
RAW & XAVC-I (avec XDCA-FS7, HXR-IFR5, 
et AXS-R5 connectés)
4096 × 2160 50P, 2048 × 1080 50P
ProRes 422 HQ, ProRes 422 (avec XDCA-FS7 
connecté)
1920 × 1080 50i, 1920 × 1080 25P

Changement des réglages des touches 
START/STOP d’enregistrement sur le 
caméscope et la poignée
Lorsque l’enregistrement simultané (Simul Rec) 
est activé, vous pouvez démarrer/arrêter 
l’enregistrement vers chaque carte mémoire 
indépendamment à l’aide des touches 
d’enregistrement START/STOP sur le 
caméscope et la poignée.
Par défaut, les deux touches sont réglées pour 
démarrer/arrêter simultanément l’enregistrement 
vers les deux cartes mémoire A et B.
• « Rec Button [SlotA SlotB] Handle Rec Button 

[SlotA SlotB] »
Lorsque les touches sont réglées pour contrôler 
l’enregistrement de différentes cartes mémoire, 
SDI/HDMI Rec Control et RAW Rec Control 
suivent l’état d’enregistrement de la fente A.

Pour modifier le réglage

Sélectionnez la touche Simul Rec >Rec 
Button Set dans le menu Recording.

Rec Button Set Touches et cartes mémoire
« Rec Button 
[SlotA SlotB] 
Handle Rec 
Button [SlotA 
SlotB] »

Démarrez/arrêtez simultanément 
l’enregistrement vers les cartes 
mémoire A et B à l’aide de l’une 
des touches.

« Rec Button 
[SlotA] Handle 
Rec Button 
[SlotB] »

La touche d’enregistrement 
START/STOP démarre/arrête 
l’enregistrement vers la carte 
mémoire A et la touche 
d’enregistrement START/STOP 
de la poignée démarre/arrête 
l’enregistrement vers la carte 
mémoire B.

« Rec Button 
[SlotB] Handle 
Rec Button 
[SlotA] »

La touche d’enregistrement 
START/STOP démarre/arrête 
l’enregistrement vers la carte 
mémoire B et la touche 
d’enregistrement START/STOP 
de la poignée démarre/arrête 
l’enregistrement vers la carte 
mémoire A.
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Un objectif prenant en charge la mise au point 
automatique est requis. Réglez le commutateur 
FOCUS (page 9) sur le caméscope sur la position 
« AUTO ». Si l’objectif est pourvu d’un 
commutateur de sélection de mise au point, réglez 
le commutateur sur la position « AF/MF » ou 
« AF ». Si le commutateur est réglé sur la position 
« Full MF » ou « MF », la mise au point de 
l’objectif ne peut pas être réalisée depuis le 
caméscope (page 24).

Remarque

Le LA-EA1/3 (en option) prend en charge la fonction 
Push Auto Focus uniquement.

Réglage de la zone de mise au point 
(Focus Area)
Vous pouvez régler la zone cible pour la mise au 
point automatique en utilisant Focus >Focus Area 
(page 68) dans le menu Camera.

Remarque

Avec le LA-EA2/4 (en option), la position ne peut 
pas être réglée.

Arrêt temporaire de la mise au point 
automatique (Focus Hold)
Appuyez sur la touche PUSH AUTO FOCUS 
(page 9) en mode de mise au point automatique 
pour changer la mise au point automatique.
Cela est utile, par exemple, lorsque quelque chose 
passe devant le sujet et que vous ne voulez pas 
faire la mise au point sur cet élément, ou lorsque 
la mise au point automatique est perdue.

Pour ajuster manuellement la mise au point, réglez 
le commutateur FOCUS (page 9) sur « MAN. »
Ceci vous permet d’ajuster manuellement la mise 
au point en fonction des conditions de prise de vue.
La mise au point manuelle est utile pour les types 
suivants de sujets.

- Sujets de l’autre côté d’une fenêtre couverte 
de gouttelettes d’eau

- Sujets avec un contraste faible par rapport à 
l’arrière-plan

- Sujets plus éloignés que les sujets proches

Réglage rapide de la mise au point grâce 
à la mise au point manuelle (Push Auto 
Focus)
Positionnez le sujet sur lequel vous souhaitez 
régler la mise au point au centre de l’image, puis 
appuyez sur la touche PUSH AUTO FOCUS 
(page 9).
La mise au point revient au réglage précédent 
quand vous relâchez la touche.
Cela est utile lorsque vous voulez faire 
rapidement la mise au point sur un sujet avant de 
lancer une prise de vue.
Vous pouvez régler la position pour la mise au 
point en utilisant Focus >Focus Area (Push AF) 
(page 68) dans le menu Camera.

Remarques

• La fonction Push Auto Focus ne fonctionne pas si 
l’objectif est réglé pour la mise au point manuelle.

• Pendant l’utilisation de Push Auto Focus lors de 
l’utilisation de LA-EA2/4, le mode Full Auto est 
activé.

• Pendant l’agrandissement de la mise au point, la mise 
au point se règle pour correspondre à la position 
d’affichage agrandie.

Indicateur de mise au point
Indique l’état de la mise au point.
• (Allumé) : le sujet est mis au point.
• (Clignotant) : le sujet n’est pas mis au point. 

Puisque la mise au point n’est pas automatique, 
modifiez les réglages de composition et de mise 
au point pour réaliser la mise au point.

Mise au point à l’aide de 
l’agrandissement de la mise au point 
(Focus Magnifier)
Par défaut, la fonction Focus Magnifier x4/x8 est 
affectée à la touche ASSIGN4 sur la 
télécommande à poignée (page 46).

Appuyez sur la touche ASSIGN4.

L’écran Focus Magnifier s’affiche avec le centre 
agrandi environ quatre fois. Appuyez de nouveau 
sur la touche pour augmenter l’agrandissement 
jusqu’à environ huit fois. Cette fonction est utile 
pour vérifier la mise au point.
Appuyez de nouveau sur la touche pour revenir à 
l’écran normal.
Vous pouvez déplacer la position à élargir 
pendant l’agrandissement de la mise au point à 
l’aide du sélecteur multiple. Appuyez sur le 
sélecteur multiple pour revenir au centre de 

Réglage automatique de la mise 
au point

Réglage manuel de la mise au 
point
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l’image. Vous pouvez aussi contrôler la position 
à l’aide des touches gauche/droite et la molette 
SEL/SET du caméscope, la télécommande à 
infrarouges ou la télécommande Wi-Fi.
Si Push Auto Focus est utilisé pendant 
l’agrandissement de la mise au point, la mise au 
point se règle pour correspondre à la position 
d’affichage agrandie.

Remarques

• L’image enregistrée ou l’image de sortie SDI/HDMI 
n’est pas agrandie lorsque la mise au point est 
agrandie.

• Pendant l’agrandissement de la mise au point, la 
touche STATUS CHECK et les touches de menu ne 
fonctionnent pas.

• La position de mise au point est effacée lorsque le 
caméscope est mis hors tension. Lorsque le caméscope 
est de nouveau mis sous tension, la position 
d’agrandissement de la mise au point revient au centre 
de l’image lorsque vous commutez sur l’écran 
d’agrandissement de la mise au point.

Réglage de la mise au point à l’aide de 
l’indicateur d’aide à la mise au point

La position de mise au point est indiquée par la 
longueur maximale de la barre. Réglez la mise au 
point pour maximiser la longueur de la barre.

Remarques

• L’indicateur de mise au point peut ne montrer qu’une 
petite varition ou aucune lors de la prise de vue 
d’objets avec une petite variation de surface ou des 
scènes obscures.

• La plage de détection ne peut pas être réglée.

Vous pouvez surveiller l’audio en cours 
d’enregistrement grâce au casque.
En connectant un casque sur le connecteur de 
casque (page 10), vous pourrez surveiller l’audio 
qui est en cours d’enregistrement. Vous pouvez 
également surveiller l’audio lu (page 59) en 
utilisant le haut-parleur intégré (page 10) ou le 
casque.
Vous pouvez sélectionner le canal audio à 
surveiller et ajuster le volume à l’aide d’Audio 
Output (page 81) dans le menu Audio.

Lorsque deux cartes mémoire XQD sont 
chargées, appuyez sur la touche SLOT SELECT 
(page 9) pour passer d’une carte à l’autre.

Remarque

Vous ne pouvez pas passer d’une carte mémoire à l’autre 
en mode de lecture. En outre, la lecture continue d’un 
plan situé sur plusieurs supports dans la fente A et la 
fente B n’est pas prise en charge.

Cadre de la plage de détection de mise au point
(Marqueur de zone de mise au point)

Indicateur d’aide à la mise au point 

In-focus : Position de la 
longueur maximale de la barre

Surveillance de l’audio

Passage d’une carte mémoire 
XQD à l’autre

Plans (données enregistrées)
Quand vous cessez l’enregistrement, la vidéo, 
l’audio et les données correspondantes du début 
à la fin de l’enregistrement sont sauvegardées 
sous forme de « plan » unique sur une carte 
mémoire XQD.

Noms de plans
Chaque plan enregistré par le caméscope reçoit 
automatiquement un nom de plan comportant le 
terme « Clip » et un nombre à 4 chiffres. Le 
nombre à 4 chiffres augmente automatiquement 
d’une unité à chaque enregistrement.
Vous pouvez changer le préfixe « clip » grâce à 
Clip, dans le menu Media.

Durée maximum d’un plan
Jusqu’6 heures par plan.
Les plans multiples sont enregistrés 
successivement pendant l’enregistrement relais, 
mais l’enregistrement s’arrête 
automatiquement après environ 13 heures.



42

Vous pouvez modifier les réglages en fonction de 
l’application vidéo ou des conditions 
d’enregistrement.

Les formats disponibles pour la sélection varient 
en fonction des réglages Country (région 
d’utilisation) et Codec.
Sélectionnez un format à l’aide de Rec Format 
>Video Format dans le menu System.

Vous pouvez régler la luminosité en réglant le 
diaphragme, le gain et la vitesse d’obturateur 
ainsi qu’en utilisant les filtres ND pour ajuster le 
niveau de lumière.
Lors de l’ajustement de la luminosité sans utiliser 
de filtres ND, désactivez le mode Full Auto 
(page 38).
Vous pouvez régler le niveau cible de contrôle de 
la luminosité dans le menu de configuration.

Réglage du niveau cible de contrôle
Réglez le niveau à l’aide d’Auto Exposure 
(page 67) >Level dans le menu Camera.

Remarque

La luminosité ne peut pas être ajustée automatiquement 
en mode Cine EI.

Réglage automatique du diaphragme
Cette fonction règle la luminosité en fonction du 
sujet. Un objectif prenant en charge le 
diaphragme automatique est requis.

1 Si un objectif avec commutateur Auto 
Iris est fixé, placez le commutateur sur 
AUTO.

2 Appuyez sur la touche IRIS (page 46) 
pour activer Auto Iris.

Le réglage bascule entre les modes 
d’activation et de désactivation chaque fois 
que la touche IRIS est enfoncée.

Remarque

Le diaphragme peut être ajusté automatiquement 
sur un objectif monté en A.

Réglage manuel du diaphragme

Appuyez sur la touche IRIS pour désactiver 
Auto Iris, puis ajustez le réglage en utilisant 
la molette IRIS.

Vous pouvez également affecter la fonction IRIS 
à une molette personnalisable (page 46).

Réglage temporaire automatique du diaphragme
Maintenez la touche PUSH AUTO IRIS enfoncée 
pour activer temporairement le diaphragme 
automatique.
Le diaphragme revient au réglage précédent 
quand vous relâchez la touche.

Remarque

Quand le commutateur Auto Iris de l’objectif est réglé 
sur « MANUAL », les fonctions Auto Iris et Push Auto 
Iris du caméscope n’ont aucun effet. Les réglages 
manuels de diaphragme sur le caméscope ne 
fonctionnent également pas.

Réglage automatique du gain
Appuyez sur la touche ISO/Gain (page 9) pour 
activer l’AGC.
Ou sélectionnez Auto Exposure (page 67) >AGC 
dans le menu Camera et réglez-le sur « On ».

Réglage manuel du gain
Vous pouvez surveiller le gain lorsque vous 
souhaitez ajuster l’exposition tout en utilisant un 
réglage de diaphragme fixe ou lorsque vous 
souhaitez éviter que le gain n’augmente à cause 
de l’AGC.

1 Appuyez sur la touche ISO/Gain 
(page 9) pour désactiver l’AGC.

2 Réglez le commutateur GAIN (page 9) 
sur H, M ou L.

Modification des 
réglages de base

Sélection du format 
d’enregistrement

Réglage de la luminosité
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Contrôle du gain (réglage précis)
Tournez la molette IRIS, ou la molette 
personnalisable à laquelle la fonction ISO/Gain/
EI est attribuée, pour ajuster la valeur de gain 
définie par le commutateur GAIN.
Cela est utile lorsque vous souhaitez régler 
l’exposition d’un seul incrément sans changer la 
profondeur de champ.
Le valeur de gain réglée est annulée lors de la 
commutation du commutateur GAIN ou de 
l’activation d’AGC.

Prise de vue à l’aide de la fonction 
d’obturateur automatique
Cette fonction règle automatiquement la vitesse 
d’obturateur par rapport à la luminosité de 
l’image.

Appuyez sur la touche SHUTTER (page 9).

Si l’écran de réglages était affiché, appuyez à 
nouveau sur cette touche.
Ou définissez Auto Exposure (page 67) >Auto 
Shutter dans le menu Camera sur On.

Prise de vue avec un obturateur fixe
Vous pouvez effectuer une prise de vue avec une 
vitesse d’obturateur fixe.
Appuyez sur la touche SHUTTER pour afficher 
un écran avec les valeurs d’obturateur prises en 
charge, puis sélectionnez et réglez une valeur en 
utilisant la molette SEL/SET. Si vous appuyez sur 
la touche SHUTTER à nouveau au lieu de la 
molette SEL/SET, l’obturateur automatique est 
activé.

Réglage dans le menu Camera
Sélectionnez Shutter (page 69) dans le menu 
Camera et réglez le mode et la vitesse 
d’obturateur.

Réglage du niveau de luminosité (filtre 
ND)
Lorsque l’éclairage est trop fort, vous pouvez 
régler la luminosité appropriée en changeant le 
filtre ND.
Tournez la molette ND FILTER (page 9) pour 
sélectionner Clear t 1/4 t 1/16 t 1/64 t 
Clear, dans l’ordre.

Vous pouvez sélectionner le mode de réglage 
pour vous adapter aux conditions de prise de vue.

ATW (suivi automatique de l’équilibre 
des blancs)
Cette fonction ajuste l’équilibre des blancs 
automatiquement à un niveau approprié.
L’équilibre des blancs est automatiquement 
ajusté quand la température de couleur de la 
source de lumière change.
Appuyer sur la touche WHT BAL (page 9) 
permet d’activer/désactiver ATW.
Vous pouvez sélectionner la vitesse de réglage 
(cinq incréments) à l’aide de White >ATW Speed 
(page 72) dans le menu Paint.
Vous pouvez geler le réglage d’équilibre des 
blancs actuel en assignant la fonction ATW Hold 
à une touche personnalisable (page 46) et en 
appuyant sur la touche personnalisable pour 
mettre temporairement le mode ATW en pause.

Remarques

• ATW ne peut pas être utilisé en mode Cine EI.
• Il peut ne pas être possible de s’ajuster sur les couleurs 

appropriées à l’aide d’ATW, en fonction des 
conditions d’éclairage et de sujet.
Exemples :
- Quand une couleur unique domine le sujet, comme 

par exemple le ciel, la mer, la terre ou des fleurs.
- Quand la température de couleur est extrêmement 

élevée ou faible.
Si l’effet approprié ne peut pas être obtenu parce 
que la vitesse de suivi automatique d’ATW est 
lente ou pour d’autres raisons, utilisez l’équilibre 
des blancs automatique.

Réglage manuel de la balance des 
blancs

1 Désactivez le mode Full Auto (page 38).

2 Quand l’équilibre des blancs est réglé 
sur le mode ATW, appuyez sur la 
touche WHT BAL (page 9) pour régler 
le mode manuel.

Réglage pour des couleurs 
naturelles (équilibre des blancs)
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3 Sélectionnez B, A ou PRESET à l’aide 
du commutateur WHT BAL (page 9).

B : mode de mémoire B *
A : mode de mémoire A
PRESET : mode prédéfini
* B peut être attribué à ATW ON.

Mode prédéfini
Ce mode ajuste la température de couleur sur une 
valeur préréglée (la valeur par défaut est 3200K).

Mode de mémoire A/mémoire B
Ce mode ajuste l’équilibre des blancs au réglage 
sauvegardé sous la mémoire A ou la mémoire B, 
respectivement.

Remarque

Les réglages pour le commutateur WHT BAL en mode 
Cine EI sont ajustés comme suit.

B : 5500K
A : 4300K
PRESET : 3200K

Utilisation de l’équilibre des blancs 
automatique

1 Appuyez sur la touche ISO/Gain 
(page 9) pour activer l’AGC.

Ou sélectionnez Auto Exposure (page 67) 
>AGC dans le menu Camera et réglez-le sur 
« On ».

2 Pour sauvegarder une valeur de réglage 
dans la mémoire, sélectionnez le mode 
de mémoire A ou de mémoire B.

3 Placez une feuille de papier blanc (ou 
tout autre objet) dans un lieu 
présentant la même source et les mêmes 
conditions de lumière que le sujet, puis 
effectuez un zoom avant sur le papier 
pour montrer la zone blanche sur 
l’écran.

4 Réglez la luminosité.

Ajustez le diaphragme à l’aide de la 
procédure dans « Réglage manuel du 
diaphragme » (page 42).

5 Appuyez sur la touche WB SET 
(page 7).

Si l’équilibre des blancs automatique est 
réglé sur le mode mémoire, la valeur de 

réglage est sauvegardée dans la mémoire (A 
ou B) sélectionnée à l’étape 2.
Si l’équilibre des blancs automatique est 
réglé sur le mode ATW, le réglage de 
l’équilibre des blancs repasse à l’équilibre 
des blancs du mode ATW à la fin du réglage.

Remarques

• L’équilibre des blancs automatique ne peut pas être 
effectué en mode Cine El.

• Si l’ajustement échoue, un message d’erreur s’affiche 
sur l’écran pendant environ trois secondes. Si le 
message d’erreur persiste après plusieurs tentatives de 
réglage de l’équilibre des blancs, contactez votre 
technicien Sony.

Vous pouvez spécifier l’audio à enregistrer à 
l’aide des connecteurs, des commutateurs et des 
molettes d’entrée du caméscope.

Connecteurs et commutateurs d’entrée audio 
externe
Connecteur INPUT1 (page 10)
Connecteur INPUT2 (page 10)
Commutateur INPUT1 (LINE/MIC/MIC+48V) 
(page 7)
Commutateur INPUT2 (LINE/MIC/MIC+48V) 
(page 7)

Commutateurs permettant de régler le niveau 
audio
Commutateur CH1 LEVEL CONTROL (page 9)
Commutateur CH2 LEVEL CONTROL (page 9)
Molette CH1 INPUT LEVEL (page 9)
Molette CH2 INPUT LEVEL (page 9)

Sélection du dispositif d’entrée audio

1 Sélectionnez le connecteur d’entrée 
audio.

Sélectionnez l’entrée audio en utilisant 
Audio Input >CH1 Input Select ou CH2 
Input Select dans le menu Audio.
Réglez sur INPUT1 ou INPUT2 pour que 
l’entrée corresponde au connecteur pour le 
dispositif connecté. Si vous utilisez un 
microphone à griffe ou un adaptateur XLR, 
spécifiez Shoe 1 ou Shoe 2 de la même 
manière. Pour plus de détails sur l’adaptateur 
XLR, voir « Ajout de connecteurs d’entrée 
audio » (page 54).

Réglage de l’audio sur Record
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Remarque

Le caméscope est équipé avec un microphone 
interne. Bien qu’il ne soit pas adapté pour l’audio 
final, il peut être utilisé pour la syncronisation avec 
d’autres appareils. Dans ce cas, spécifiez MIC 
interne.

2 Sélectionnez la source audio d’entrée.

Réglez les commutateurs INPUT1/INPUT2 
(LINE/MIC/MIC+48V) sur les dispositifs 
raccordés aux connecteurs INPUT1/
INPUT2, respectivement.

• Le fait de sélectionner « MIC+48V » et de 
connecter un microphone qui n’est pas 
compatible avec une source de +48 V peut 
endommager le dispositif connecté. 
Vérifiez le réglage avant de connecter le 
dispositif.

• Si le bruit est un problème sur des 
connecteurs sur lesquels aucun dispositif 
n’est connecté, réglez les commutateurs 
INPUT1/INPUT2 (LINE/MIC/MIC+48V) 
correspondants sur « LINE ».

Réglage automatique du niveau 
d’enregistrement audio
Réglez les commutateurs CH1/CH2 LEVEL 
CONTROL des canaux sur « AUTO » pour qu’ils 
s’ajustent automatiquement.
Pour CH3/CH4, réglez Audio Input >CH3 Level 
Control et CH4 Level Control dans le menu 
Audio sur « Auto » (page 79).

Réglage manuel du niveau 
d’enregistrement audio
Utilisez la procédure suivante pour régler le 
niveau d’enregistrement audio pour CH1/CH2.

1 Réglez les commutateurs CH1/CH2 
LEVEL CONTROL des canaux sur 
« MAN » pour pouvoir les ajuster 
manuellement.

2 Pendant la prise de vue ou la veille, 
tournez les molettes INPUT LEVEL 
(CH1)/(CH2) des canaux 
correspondants pour régler le niveau 
audio.

Vous pouvez également ajuster le niveau 
d’enregistrement en utilisant la molette 
personnalisable (page 46), si la fonction 
Audio Input Level y est attribuée, ou depuis 
le menu de configuration.
Pour CH3/CH4, réglez Audio Input >CH3 
Level Control et CH4 Level Control dans le 
menu Audio sur « Manual », puis réglez le 
niveau d’enregistrement audio dans CH3 
Input Level et CH4 Input Level (page 79).

Remarques

• Les réglages du niveau d’entrée audio peuvent 
être désactivés, en fonction de la combinaison 
de réglages dans le menu Audio. Pour en savoir 
plus, reportez-vous au diagramme dans 
page 135.

• Si Audio Input >CH1 Input Select ou CH2 Input 
Select dans le menu Audio est réglé sur 
« Internal MIC » CH2 est commuté sur 
automatic/manual en conjonction avec le 
commutateur CH1 LEVEL CONTROL. De 
même, le niveau d’enregistrement audio CH2 
est réglé en conjonction avec la molette CH1 
INPUT LEVEL (page 79).

• Le caméscope prend en charge des 
combinaisons de plusieurs réglages. Pour en 
savoir plus, reportez-vous au diagramme dans 
page 135.

Dispositif raccordé Position de 
commutateur

Source audio externe 
(p. ex., table de mixage)

LINE

Microphone dynamique, 
microphone à piles

MIC

Microphone à 
alimentation fantôme de 
+48 V

MIC+48V
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Réglage du code temporel
Réglez le code temporel à enregistrer à l’aide de 
Timecode (page 89) dans le menu TC/UB.

Affichage des données temporelles
Appuyez sur le bouton DISPLAY pour afficher 
les données temporelles sur l’écran (page 14).
Réglez le code temporel à afficher à l’aide de TC 
Display (page 89) >Display Select dans le menu 
TC/UB.
L’activation d’une touche personnalisable 
(page 46) à laquelle DURATION/TC/U-BIT est 
assigné commute l’affichage entre le code 
temporel, les bits d’utilisateur et la durée, dans 
l’ordre.

Il y a six touches personnalisables (page 9, 
page 11) sur le caméscope, auxquelles vous 
pouvez assigner des fonctions.
Vous pouvez également assigner des fonctions à 
la molette IRIS (page 9) sur le caméscope et à la 
molette personnalisable (page 11) sur la 
télécommande à poignée.

Changement de la fonction d’une touche
Utilisez Assignable Button (page 98) dans le 
menu System.
Vous pouvez visionner les fonctions assignées 
sur l’écran Assignable Button Status (page 16).

Fonctions attribuées à chaque touche assignable 
par défaut

Fonctions personnalisables
• Off
• Marker
• Zebra
• Peaking
• Video Signal Monitor
• DURATION/TC/U-BIT
• Focus Magnifier x4/x8
• Focus Magnifier x4
• Focus Magnifier x8
• Push AF/Focus Hold
• Focus Area
• Focus Area (Push AF)
• VF Mode
• IRIS
• AGC
• SHUTTER
• Auto Exposure Level
• Push Auto Iris
• Push AGC
• Spotlight

Spécification des données 
temporelles Fonctions utiles

Touches/molettes 
personnalisables

Touche 1 S&Q Motion
Touche 2 IRIS
Touche 3 User Menu
Touche 4 Focus Magnifier x4/x8
Touche 5 User Menu
Touche 6 Off
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• Backlight
• ATW
• ATW Hold
• SteadyShot
• Color Bars
• User Menu
• Rec Lamp
• S&Q Motion
• Picture Cache Rec
• Rec Review
• Thumbnail
• Shot Mark1
• Shot Mark2
• Clip Flag OK
• Clip Flag NG
• Clip Flag Keep
• High/Low Key

Changement de la fonction d’une molette
Utilisez Assignable Dial (page 100) dans le menu 
System.
Vous pouvez visionner les fonctions assignées 
sur l’écran Assignable Button Status (page 16).
IRIS est assigné par défaut.

Fonctions personnalisables
• Off
• IRIS
• ISO/GAIN/EI
• Focus
• Audio Input Level

Quand le format vidéo (page 96) est réglé sur une 
des valeurs suivantes, vous pouvez spécifier une 
valeur différente pour la fréquence d’images 
d’enregistrement et la fréquence d’images de 
lecture.

Région NTSC
XAVC-I
4096 × 2160 59.94P, 4096 × 2160 29.97P, 
4096 × 2160 24.00P, 4096 × 2160 23.98P, 
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P, 1920 × 1080 59.94P, 
1920 × 1080 29.97P, 1920 × 1080 23.98P
XAVC-L
3840 × 2160 59.94P, 3840 × 2160 29.97P, 
3840 × 2160 23.98P, 1920 × 1080 59.94P 50, 
1920 × 1080 59.94P 35, 1920 × 1080 29.97P 
50, 1920 × 1080 29.97P 35, 1920 × 1080 
23.98P 50, 1920 × 1080 23.98P 35

Région PAL
XAVC-I
4096 × 2160 50P, 4096 × 2160 25P, 
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P, 1920 × 1080 25P
XAVC-L
3840 × 2160 50P, 3840 × 2160 25P, 
1920 × 1080 50P 50, 1920 × 1080 50P 35, 
1920 × 1080 25P 50, 1920 × 1080 25P 35

Vous pouvez régler la fréquence d’images pour 
l’enregistrement en maintenant appuyée une 
touche assignable à laquelle la fonction S&Q 
Motion a été attribuée.

Remarques

• Le mode Slow & Quick Motion ne peut pas être réglé 
pendant l’enregistrement, la lecture ou pendant 
l’affichage de l’écran de miniatures.

• L’enregistrement audio n’est pas pris en charge en 
mode ralenti et accéléré.

• La fonction de mise au point automatique est 
désactivée en mode ralenti et accéléré.

• Les conditions suivantes s’appliquent lors d’une prise 
de vue à des fréquences d’images supérieures à 60 ips.
- L’indicateur d’aide à la mise au point, l’indicateur 

de profondeur de champ, l’indicateur de position 
de mise au point, l’indicateur de position de 
diaphragme et l’indicateur de position de zoom 
sont tous éteints.

Slow & Quick Motion
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Région NTSC

Région PAL

La fonction Interval Rec du camésope permet de 
capturer une vidéo en accéléré dans la mémoire 
interne du caméscope. Cette fonction est un 
moyen efficace pour la prise de vue de sujets en 
mouvement lent.
Lorsque vous commencez l’enregistrement, le 
caméscope enregistre automatiquement un 
nombre spécifique d’images (Number of Frames) 
à intervalles (Interval Time) spécifiés.

Cette fonction est activée lorsque le caméscope 
est réglé sur l’un des formants vidéo suivants 
(page 96).

XAVC-I
XAVC-L*
MPEG HD 422*
* 59.94i et 50i ne sont pas pris en charge.

Lorsque Interval Rec est activé, la lumière de la 
vidéo HVL-LBPC (en option) s’allume 
automatiquement avant le début de 
l’enregistrement, ce qui vous permet 
d’enregistrer des images sous des conditions de 
lumière stable et de température de couleur 
(fonction de pré-éclairage).

Prise de vue et réglages en mode 
Interval Rec 

Remarques

• Il est possible d’utiliser une seule fonction 
d’enregistrement spéciale, tel que l’enregistrement en 
mode Interval Rec. 
Si un autre mode d’enregistrement spécial est activé 
alors que Interval Rec est en cours d’utilisation, ce 
dernier est automatiquement relâché.

• Le mode Interval Rec est automatiquement activé 
après avoir modifié les réglages système tel que le 
format vidéo.

• Les réglages Interval Rec ne peuvent pas être modifiés 
pendant l’enregistrement ou la lecture ou lorsque 
l’écran de miniatures s’affiche.

Pour régler Interval Rec
Réglez Interval Rec (page 91) >Setting dans le 
menu Recording sur On et réglez le nombre 
d’images (Number of Frames) et la durée 
d’intervalle (Interval Time).
Si vous utilisez la lampe vidéo HVL-LBPC 
(en option), réglez la durée d’intervalle pour 
allumer la lampe vidéo avant le démarrage de 
l’enregistrement dans le pré-éclairage Pre-Lighting 
dans le menu Interval Rec, tel que requis.

Format Résolution Fréquence 
d’images

Fréquence 
d’images 
élevée

XAVC-I 2160 1 à 60 ips Non pris en 
charge

(59.94P, 29.97P, 24.00P,  
23.98P)

1080 1 à 60 ips 72/75/80/90/96/
100/110/120/125/
135/144/150/160/
168/175/180 ips

(59.94P, 29.97P, 23.98P)

XAVC-L 2160 1 à 60 ips Non pris en 
charge

(59.94P, 29.97P, 23.98P)

1080 1 à 60 ips 72/75/80/90/96/
100/110/120 ips

(59.94P 50, 59.94P 35, 29.97P 
50, 29.97P 35, 23.98P 50, 
23.98P 35)

Format Résolution Fréquence 
d’images

Fréquence 
d’images 
élevée

XAVC-I 2160 1 à 60 ips Non pris en 
charge

(59P, 25P)

1080 1 à 60 ips 72/75/80/90/96/
100/110/120/125/
135/144/150 ips

(59P, 25P)

XAVC-L 2160 1 à 60 ips Non pris en 
charge

(59P, 25P)

1080 1 à 60 ips 72/75/80/90/96/
100/110/120 ips

(50P 50, 50P 35, 25P 50, 
25P 35)

Enregistrement de la vidéo par 
intermittence (Interval Rec)

Durée d’intervalle (Interval Time)

Nombre d’images en une prise (Number of Frames)
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Remarques

• Si vous voulez allumer la lampe vidéo avant le début 
de l’enregistrement, mettez l’interrupteur de lampe 
vidéo sur AUTO. La lampe vidéo s’allume et s’éteint 
automatiquement en fonction du réglage de Video 
Light Set (page 71) dans le menu Camera.

• Si vous mettez l’interrupteur de la lampe vidéo sur On, 
la lampe reste toujours allumée (la lumière vidéo ne 
s’allume pas et ne s’éteint pas automatiquement). 

• Si la lampe vidéo est configurée pour s’éteindre 
pendant 5 secondes ou moins, la lampe vidéo ne 
s’éteint pas.

Le caméscope quitte le mode Interval Rec 
lorsqu’il est mis hors tension mais les réglages de 
nombre d’images (Number of Frames), de durée 
d’intervalle (Interval Time) et de pré-éclairage 
(Pre-Lighting) sont maintenus. Vous n’aurez pas 
besoin de les régler de nouveau la fois suivante 
lorqque vous effectuez une prise de vue en mode 
Interval Rec.

Prise de vue en mode Interval Rec
Appuyez sur la touche d’enregistrement pour 
démarrer l’enregistrement. « Int / zRec » 
et « Int / zStby » s’affichent 
alternativement dans le viseur.
Si vous utilisez la fonction de pré-éclairage, la 
lampe de la vidéo s’allume avant le démarrage de 
l’enregistrement.

Pour arrêter la prise de vue
Arrêtez l’enregistrement.
A la fin de la prise de vue, les données vidéo 
enregistrées dans la mémoire à ce point sont 
enregistrées sur le support.

Pour quitter le mode Interval Rec
Effectuez l’une des actions suivantes.
• Réglez le commutateur POWER sur Off.
• En mode d’attente d’enregistrement, réglez 

Interval Rec > dans le menu Recording sur Off.
De même, le mode Interval Rec est 
automatiquement relâché lorsque le caméscope 
est redémarré.

Limitations pendant l’enregistrement
• L’audio n’est pas enregistré.
• Le passage en revue de l’enregistrement (Rec 

Review) n’est pas possible.
• Genlock n’est pas appliqué.

Si le caméscope est mis hors tension pendant 
l’enregistrement
• Si le commutateur POWER du caméscope est 

réglé sur la position Off, l’accès au support 
s’effectue pendant plusieurs secondes pour 

enregistrer les images sauvegardées dans la 
mémoire jusqu’à ce moment, puis l’appareil se 
met automatiquement hors tension.

• Si l’alimentation est coupée car la batterie est 
retirée, le cordon d’alimentation CD débranché 
ou l’alimentation coupée à partir de l’adaptateur 
CA, les données vidéo et audio prises jusqu’à ce 
point peuvent être perdues (maximum 
10 secondes). 
Faites attention en remplaçant la batterie.

La fonction d’enregistrement en mode de cache 
d’image vous permet de tourner des vidéos à 
posteriori lorsque vous démarrez 
l’enregistrement, puis de les enregistrer sur des 
cartes mémoire XQD en maintenant une mémoire 
cache interne d’une durée déterminée lors du 
tournage. La durée d’enregistrement en mode de 
cache d’image est réglée grâce à Picture Cache Rec 
>Cache Rec Time (page 91) dans le menu 
Recording.

Formats d’enregistrement pris en charge

*1 : XAVC-I 59.94P et 50P ne sont pas pris en charge.

Remarques

• Picture Cache Rec ne peut pas être activé en même 
temps que Interval Rec, ou Slow & Quick Motion. 
Lorsque Picture Cache Rec est activé, ces autres modes 
d’enregistrement sont désactivés de force.

• Le mode Picture Cache Rec ne peut pas être 
sélectionné lorsqu’un enregistrement ou Rec Review 
est en cours.

• Lorsque Picture Cache Rec est activé, le code temporel 
est enregistré en mode Free Run, quel que soit le 
réglage dans le menu TC/UB (page 89).

• Le réglage Output Format ne peut pas être configuré en 
mode Picture Cache Rec. Si celà se produit, désactivez 
temporairement Picture Cache Rec, puis modifiez le 
réglage.

Enregistrement en mode de cache 
d’image (Picture Cache Rec)

Format
d’enregistre
ment

Résolution Durée de cache
[s]

RAW 4096×2160
2048×1080

Non pris en charge

XAVC *1 4096×2160
3840×2160

0 à 2

1920×1080 0 à 2/2 à 4/4 à 6/6 à 8

MPEG-2 1920×1080 0 à 2/2 à 4/4 à 6/6 à 
8/8 à 10/13 à 15

ProRes422 1920×1080 Non pris en charge
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Configuration avant la prise de vue
Configurez Picture Cache Rec (page 91) dans le 
menu Recording avant la prise de vue.
Vous pouvez également attribuer la fonction 
Picture Cache Rec >Setting à une touche 
personnalisable (page 46) et activer/désactiver 
Picture cache Rec en utilisant cette touche.
Lorsqu’il est configuré, l’indicateur z (vert) 
apparaît dans le viseur (page 13).

Enregistrement en mode de cache 
d’image
Lorsque vous appuyez sur la touche 
d’enregistrement, celui-ci démarre et la vidéo est 
inscrite sur les cartes mémoire XQD, en 
commençant par la vidéo stockée dans la 
mémoire cache.

Pour annuler Picture Cache Rec
Désactivez Picture Cache Rec >Setting dans le 
menu Recording ou appuyez sur une touche 
personnalisable à laquelle est attribuée la fonction 
Picture Cache Rec.

Remarques

• Si vous modifiez le format d’enregistrement, la vidéo 
dans la mémoire cache stockée jusqu’à présent est 
effacée, et la mise en cache d’une nouvelle vidéo 
démarre. Ainsi, il est impossible d’enregistrer des 
images en mode d’enregistrement de cache d’image 
avant le changement de format, même si vous 
commencez immédiatement à enregistrer après avoir 
changé le format.

• Si Picture Cache Rec est activé/désactivé 
immédiatement après avoir inséré une carte mémoire 
XQD, les données de cache peuvent ne pas être 
enregistrées sur la carte.

• La vidéo est stockée dans la mémoire cache lorsque la 
fonction d’enregistrement en cache est activée. La 
vidéo précédant l’activation de la fonction n’est pas 
mise en cache.

• La vidéo n’est pas stockée dans la mémoire cache tant 
qu’une carte mémoire XQD est en cours d’accès, 
comme lors de la lecture, de Rec Review ou de 
l’affichage de l’écran de miniatures. Il est impossible 
d’enregistrer des vidéos en mode d’enregistrement de 
cache d’image pendant cet intervalle.

• Vous pouvez changer le réglage de durée 
d’enregistrement de cache en utilisant le menu pendant 
que l’enregistrement est en cours, mais la nouvelle 
valeur ne devient effective qu’une fois 
l’enregistrement terminé.

Vous pouvez vérifier à l’écran la vidéo du plan le 
plus récemment enregistré.

Quand l’enregistrement est arrêté, appuyez 
sur la touche personnalisable (page 46) à 
laquelle Rec Review est assigné.

Le plan est lu jusqu’à la fin, Rec Review prend fin 
et le caméscope revient en mode STBY (veille). 
Maintenez le bouton enfoncé pour démarrer la 
lecture dans le sens inverse. Lorsque vous 
relâchez la touche, le plan est lu jusqu’à la fin.

Pour arrêter Rec Review
Appuyez sur la touche personnalisable à laquelle 
Rec Review est assigné.

Remarque

Rec Review n’est pas pris en charge si le format vidéo est 
modifié après l’enregistrement d’un plan.

Vous pouvez renverser l’image dans le viseur 
(page 11) verticalement ou horizontalement/
verticalement à l’aide du commutateur 
MIRROR.
Ceci vous permet de tourner le viseur à 180º vers 
l’objectif.

Passage en revue d’un 
enregistrement (Rec Review)

Mode Self Portrait
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OFF
L’image n’est pas inversée.

B/T
L’image est renversée verticalement.
L’affichage des informations est renversé 
verticalement et horizontalement. 

ROT
L’image est renversée verticalement et 
horizontalement.
L’affichage des informations est également 
renversé verticalement et horizontalement.

Remarque

Les affichages B/T et ROT sont affichés uniquement 
dans le viseur. La vidéo produite et enregistrée reste 
inchangée.
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Vous pouvez activer/désactiver le contour de 
couleur en appuyant sur la touche PEAKING sur 
le viseur (page 11).
Vous pouvez activer/désactiver le contour de 
couleur et régler le type et la fréquence de contour 
de couleur à l’aide de Peaking (page 85) dans le 
menu VF.

Vous pouvez activer/désactiver l’affichage des 
zébrures en appuyant sur la touche ZEBRA sur le 
viseur (page 11).
Vous pouvez activer/désactiver l’affichage des 
zébrures et régler le type et le niveau d’affichage 
des zébrures à l’aide de Zebra (page 85) dans le 
menu VF.

Remarque

Le caméscope mesure l’image dans le viseur. En mode 
Cine EI, réglez le niveau d’affichage et d’autres 
paramètres en fonction du réglage du moniteur LUT 
(page 83) du viseur.

Vous pouvez régler le type de signal vidéo à afficher 
sur l’écran du viseur sur forme d’onde, vecteurscope 
ou histogramme en utilisant Video Signal Monitor >
Setting (page 88) dans le menu VF.
Le moniteur du signal vidéo du caméscope mesure 
le signal vidéo dans l’étape de sortie vidéo. En 
conséquence, si le signal vidéo est coupé aux bords 
par rapport à la vidéo enregistrée, le composant du 
signal rogné ne sera pas mesuré. Lorsque ceci se 
produit, « EC » s’affiche en haut à gauche du 
moniteur du signal vidéo.
Lorsque la sortie vidéo est réglée sur 2K ou moins 
en mode Cine EI, vous pouvez mesurer le signal 
vidéo à partir du système SDI1 ou système SDI2 en 
utilisant Video Signal Monitor >Source (page 88) 
dans le menu VF. Le réglage du moniteur LUT 
(page 83) du système SDI spécifié s’affiche en 
haut à droite du moniteur du signal vidéo.

Remarques

• Lorsque Display On/Off >Setting (page 87) est réglé 
sur Off dans le menu VF, le moniteur du signal vidéo 
ne s’affiche pas.

• Lorsque le réglage du moniteur LUT du système SDI 
spécifié est réglé sur Off, le réglage Color Space 
(page 96) s’affiche en haut à droite du moniteur du 
signal vidéo.

Réglez GPS sur « On » dans le menu System.

 est affiché lorsque le caméscope cherche des 
satellites GPS. Lorsque la géolocalisation est 
établie, les informations de lieu sont enregistrées 
lors du tournage d’une vidéo.

Remarques

• Le réglage GPS ne peut pas être réglé sur « On » dans 
le menu System lorsque la poignée n’est pas fixée car 
le récepteur GPS est inclu dans la poignée.

• L’icône affichée varie, en fonction de la réception du 
signal des satellites GPS.

• GPS est réglé sur « On » par défaut. Lorsque la 
géolocalisation est activée, les informations de lieu et 
d’heure de la vidéo tournée sont enregistrées par le 
caméscope.

Affichage du contour de couleur

Affichage des zébrures

Moniteur de signal vidéo

Obtention d’informations de lieu 
(GPS)

Etat de 
géolocali-
sation

Affichage Etat de réception 
GPS

Off Pas 
d’affichage

GPS est réglé sur « Off » 
ou une erreur s’est 
produite.

Géolocalisa-
tion non dis-
ponible

Les informations de lieu 
n’ont pas pu être 
obtenues car aucun 
signal GPS n’a pu être 
reçu. Déplacez-vous vers 
un lieu présentant une 
vision dégagée du ciel.

Recherche de 
satellites

Recherche de satellites 
GPS. L’acquisition des 
satellites peut prendre 
plusieurs minutes.

Géolocalisa-
tion

Un signal GPS faible est 
reçu.

Un signal GPS est reçu. 
Les informations de lieu 
peuvent être acquises.

Un signal GPS fort est 
reçu. Les informations de 
lieu peuvent être 
acquises.
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• Si une icône de positionnement ne s’affiche pas au 
bout de plusieurs minutes, il se peut qu’il y ait un 
problème de réception du signal. Commencez à filmer 
sans informations de lieu ou déplacez-vous vers un 
endroit disposant d’une vision dégagée du ciel. Le fait 
de filmer quand l’icône de géolocalisation n’est pas 
affichée signifie que les informations de lieu ne sont 
pas enregistrées.

• Le signal de GPS peut ne pas être reçu en intérieur à 
proximité de structures élevées. Déplacez-vous vers un 
lieu présentant une vision dégagée du ciel.

• L’enregistrement des informations de lieu peut être 
interrompu, en fonction de la force du signal reçu, 
même si une icône de positionnement est affichée.

Ce mode reproduit la manière dont une caméra de 
film fonctionne, et part du principe que le 
« développement » est réalisé en postproduction.

Contraintes du mode Cine EI
• Fonctions ne pouvant pas être ajustées 

automatiquement (suivi)
- Equilibre des blancs
- Gain
- Obturateur
- Diaphragme
- Exposition automatique

• Fonctions ne pouvant pas être configurées
- Gain
- Réglages du menu Paint
- Fichier de scène
- Fichier d’objectif

Fonctions disponibles en mode Cine EI 
uniquement
• Index d’exposition
• Moniteur LUT
• High/Low Key
• Enregistrement d’une vidéo RAW

Vous pouvez enregistrer une vidéo au format 
RAW sur une unité AXS-R5 (optionnelle) en 
convertissant la sortie de signal du connecteur 
RAW OUT d’une unité XDCA-FS7 (optionnelle) 
raccordée au caméscope à l’aide d’une unité 
HXR-IFR5 (optionnelle) (page 34).

1 Installez l’unité d’enregistreur RAW 
externe (page 34).

2 Réglez Base Setting >Shooting Mode 
dans le menu System sur Cine El.

3 Réglez Codec >Select dans le menu 
System sur RAW. 

La sélection de RAW & XAVC-I permet 
d’enregistrer simultanément la vidéo RAW 
sur l’enregistreur RAW externe et la vidéo 
HD sur les cartes mémoire XQD dans le 
caméscope.

4 Réglez la résolution à l’aide d’Imager 
Scan Mode dans le menu System.

Lorsqu’il est réglé sur Normal, la résolution 
RAW est de 4096×2160.

5 Réglez la fréquence d’image dans Rec 
Format >RAW Output Format dans le 
menu System.

6 Vérifiez que l’enregistreur externe est 
activé, puis appuyez sur la touche 
d’enregistrement sur le caméscope.

Les formats de sortie RAW pris en charge sont 
indiqués ci-dessous.

Région NTSC

Région PAL

Indicateur de l’état d’enregistrement
Si Display On/Off (page 87) >HXR-IFR5 Rec 
Control dans le menu VF est réglé sur « On », 
l’état d’enregistrement RAW est affiché dans le 
viseur à l’aide d’une icône.

Prise de vue en mode Cine EI

Enregistrement d’une vidéo au 
format RAW

Réglage Codec 
>Select

Formats de sortie RAW

RAW / RAW & 
XAVC-I / RAW &
XAVC-L / RAW &
MPEG HD422

4096 × 2160 59.94P
4096 × 2160 29.97P
4096 × 2160 23.98P
2048 × 1080 59.94P
2048 × 1080 29.97P
2048 × 1080 23.98P

Réglage Codec 
>Select

Formats de sortie RAW

RAW / RAW &
XAVC-I / RAW &
XAVC-L / RAW &
MPEG HD422

4096 × 2160 50P
4096 × 2160 25P
2048 × 1080 50P
2048 × 1080 25P
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Enregistrement en ralenti et accéléré
Si S&Q Motion >Setting dans le menu Recording 
est réglé sur « On », la vidéo RAW est enregistrée 
en mode ralenti et accéléré.
La sortie RAW Slow & Quick Motion est prise en 
charge uniquement pour la résolution 2K à 120/
240 ips (NTSC) et 100/200 ips (PAL).

Remarques

• Le connecteur RAW OUT du caméscope contrôle 
uniquement l’enregistrement en transmettant un signal 
Rec Control à l’enregistreur externe. C’est pourquoi le 
caméscope peut indiquer que l’enregistrement vidéo 
RAW est en cours alors que l’enregistreur externe 
n’est pas réellement en train d’enregistrer. Vérifiez 
l’indicateur sur l’enregistreur externe pour connaître 
l’état de fonctionnement réel.

• Lorsque l’enregistrement est démarré sur un 
enregistreur externe sans utiliser la touche 
d’enregistrement sur le caméscope, il est possible que 
les clips ne soient pas correctement enregistrés.

Vous pouvez connectez jusqu’à quatre canaux de 
dispositifs audio XLR au caméscope en même 
temps en utilisant un adaptateur XLR-K2M XLR 
(non fourni).
Fixez l’adaptateur XLR à la griffe MI et réglez 
Audio Input >CH3 Input Select sur « Shoe 1 » et 
CH4 Input Select sur « Shoe 2 » dans le menu 
Audio.
Les fonctions du caméscope qui se superposent 
seront désactivées pour les canaux sur lesquels 
l’adapatateur XLR est sélectionné comme entrée. 
Utilisez les commutateurs et les molettes sur 
l’adaptateur XLR pour effectuer les réglages.

Remarques
• Si Audio Input >CH3 Level et CH4 Level dans le 

menu Audio sont réglés sur « Audio Input Level », 
Audio Input Level du caméscope sera réglé pour 
correspondre au niveau réglé sur l’adaptateur XLR. 
Audio Input Level est également activé lorsque le 
commutateur de l’adaptateur XLR est réglé sur AUTO. 
Lorsque « Through » est spécifié, l’audio sera 
enregistré au niveau réglé avec l’adaptateur XLR 
(page 136).

• Vous pouvez aussi assigner à CH1 et CH2 en fixant un 
adaptateur XLR et en réglant Audio Input >CH1 Input 
Select et CH2 Input Select dans le menu Audio 
respectivement sur « Shoe 1 » et « Shoe 2 ». Par contre, 
si l’entrée de l’adaptateur XLR est assignée à CH1 et 
CH2, l’entrée à partir des connecteurs INPUT1/
INPUT2 sur le caméscope ne peut plus être assignée à 
ces canaux.

Ajout de connecteurs d’entrée 
audio
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Le caméscope peut se connecter à des 
smartphones, tablettes et autres dispositifs à 
l’aide d’une connexion LAN sans fil s’il est 
raccordé au module USB LAN sans fil 
IFU-WLM3 (fourni) ou à un adaptateur sans fil 
CBK-WA100 (optionnel).

Remarque

Les modules sans fil USB autres que l’IFU-WLM3 ne 
sont pas pris en charge.

Les fonctions suivantes sont prises en charge depuis des 
dispositifs connectés par LAN sans fil.
• Commande à distance

Permet de commander à distance le caméscope.
• Surveillance vidéo (CBK-WA100 uniquement)

Permet de surveiller la vidéo depuis la caméscope.
Le CBK-WA100 (optionnel) et l’application 
Content Browser Mobile sont nécessaires.

Pour de plus amples informations concernant 
l’application Content Browser Mobile, contactez un 
représentant ou un technicien Sony.

Dispositifs compatibles
Vous pouvez utiliser un smartphone, une tablette 
ou un ordinateur pour configurer et utiliser le 
caméscope. Les dispositifs, le système 
d’exploitation et les navigateurs pris en charge 
sont affichés dans le tableau suivant.

Branchez l’IFU-WML3 dans le connecteur de 
module USB LAN sans fil (page 7).
Après avoir fixé l’unité, réglez Wi-Fi >Wi-Fi 
(page 102) dans le menu System sur « Enable » 
pour activer le LAN sans fil.

Remarque

Fixez/retirez l’IFU-WLM3 pendant que le caméscope est 
hors tension.

Remarque

Fixez/retirez le CBK-WA100 pendant que le caméscope 
est hors tension.

1 Fixez le CBK-WA100 sur le support de 
montage, et serrez les deux vis.

Connexion de dispositifs 
à l’aide du LAN sans fil

Dispositif Système 
d’exploitation

Navigateur

Smartphone Android 5.1 Chrome

iOS 9 Safari

Tablette Android 5.1 Chrome

iOS 9 Safari

Ordinateur Microsoft Windows 7/
Microsoft Windows 8.1/
Microsoft Windows 10

Chrome

Mac OS 10.10/10.11 Safari

Fixation de l’IFU-WLM3

Fixation du CBK-WA100
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2 Fixez le support de montage 
CBK-WA100 sur le caméscope, et 
serrez les vis.

3 Raccordez le câble USB CBK-WA100 
au connecteur du module LAN sans fil 
USB (1), et le câble SDI sur le 
connecteur SDI OUT (2).

4 Allumez le CBK-WA100, puis mettez le 
caméscope sous tension.

5 Lorsque le branchement est terminé, le 
LAN sans fil doit être activé en réglant 
Wi-Fi >Wi-Fi (page 102) dans le menu 
System sur Enable.

Remarque

Le réglage de sortie SDI OUT doit être configuré pour 
utiliser le CBK-WA100 avec le caméscope. Par contre, 
le caméscope ne peut pas émettre un signal compatible 
avec le CBK-WA100 lors de l’utilisation de XAVC-I 
24.0P ou ProRes 23.98P (page 82).

A propos du CBK-WA100
Le CBK-WA100 possède des fonctions 
d’enregistrement de fichiers à basse résolution 
proxy sur une carte SD et de transfert de fichiers 
vers un serveur par LAN sans fil. Pour plus de 
détails, reportez-vous au mode d’emploi du 
CBK-WA100.

Les dispositifs prenant en charge la technologie 
NFC peuvent être connectés (connexion une 
touche) à l’aide de la NFC.

1 Fixez un IFU-WLM3 sur le caméscope 
(page 55) et réglez Wi-Fi >Wi-Fi 
(page 102) dans le menu System sur 
« Enable » pour activer le LAN sans fil.

 s’affiche à l’écran.

Connexion une touche des 
dispositifs équipés de la 
technologie NFC (à l’aide de 
l’IFU-WLM3 uniquement)
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2 Ouvrez « Settings » sur le dispositif, 
sélectionnez « More », et cochez la case 
NFC.

Les différents réglages varient en fonction du 
dispositif. Pour plus de détails, reportez-vous 
au mode d’emploi du dispositif.

3 Touchez le caméscope avec le dispositif.

Le dispositif se connecte au caméscope, 
lance un navigateur Web et affiche la 
commande à distance Wi-Fi. Une 
authentification est nécessaire la première 
fois que le dispositif se connecte.

Remarques

• Désactivez le mode de veille et le verrouillage d’écran 
à l’avance.

• Touchez et maintenez le dispositif immobile jusqu’à ce 
que l’application « Content Browser Mobile » démarre 
(1 à 2 secondes).

L’écran Wi-Fi Remote est automatiquement 
redimensionné pour s’adapter à la taille de l’écran 
du dispositif connecté.

1 Connectez le caméscope et le dispositif à 
l’aide d’une connexion LAN sans fil 
(page 56).

2 Démarrez un navigateur sur le 
dispositif et saisissez « http://<adresse 
IP du caméscope (Wi-Fi >IP Address 
dans le menu System)>/rm.html » dans 
la barre d’URL.

Par exemple, si l’adresse IP est 192.168.1.1, 
saisissez « http://192.168.1.1/rm.html » dans 
la barre d’URL.

3 Saisissez le nom d’utilisateur et le mot 
de passe (Basic Authentication >User 
Name and Password dans le menu 
System).

Quand la connexion est réussie, l’écran 
Wi-Fi Remote s’affiche sur le dispositif.
Vous utilisez l’écran Wi-Fi Remote pour 
commander le caméscope.
Vous pouvez désactiver le fonctionnement 
de la touche d’enregistrement en faisant 
glisser le bouton Lock vers la droite.

Remarques

• Pour afficher la page pour un smartphone, remplacez 
« rm.html » par « rms.html » dans l’URL. Pour 
afficher la page pour une tablette, remplacez 
« rm.html » par « rmt.html » dans l’URL. Quand 
« rm.html » est saisi, la page s’affiche 
automatiquement sur le dispositif correspondant. 
Cependant, la page appropriée peut ne pas être 
affichée, en fonction du dispositif.

• L’écran Wi-Fi Remote peut ne pas correspondre aux 
réglages du caméscope dans les circonstances 
suivantes. Si ceci se produit, rechargez la fenêtre du 
navigateur.
- Si le caméscope est remis en marche alors qu’il est 

connecté
- Si le caméscope est utilisé directement alors qu’il 

est connecté
- Si le dispositif a été reconnecté
- Si les touches Forward/Back du navigateur ont été 

utilisées
• Wi-Fi remote control peut ne pas fonctionner si la 

force du signal sans fil devient faible.

Affichage de Wi-Fi 
remote control
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L’écran de miniatures apparaît si vous appuyez sur la touche THUMBNAIL (page 9). L’écran de 
miniatures affiche les plans stockés sur les cartes mémoire XQD sous forme de miniatures (images 
d’index).
Vous pouvez sélectionner un plan dans l’écran de miniatures et démarrer la lecture de ce plan. L’image 
de lecture peut être affichée sur le viseur et sur un moniteur externe.
Appuyer à nouveau sur la touche THUMBNAIL ferme l’écran de miniatures et revient à l’image de 
caméra.

Remarques

• Seuls les plans enregistrés au format d’enregistrement actuellement sélectionné sont affichés dans l’écran de 
miniatures. Si un plan enregistré que vous vous attendiez à voir n’est pas affiché, vérifiez le format d’enregistrement. 
Gardez ceci à l’esprit avant de formater (initialiser) le support.

• Lorsque Codec >Select dans le menu System est réglé sur l’une des options suivantes, l’enregistrement ne peut pas 
commencer pendant la lecture ou lorsque l’écran miniature est affiché. 
RAW & XAVC-I, RAW & XAVC-L, RAW & MPEG HD422

Les informations du plan à la position du curseur sont affichées au bas de l’écran.

1. Miniature (image d’index)
Affiche l’image d’index d’un plan. Lorsqu’un 
plan est enregistré, sa première image est 
automatiquement définie comme image 
d’index.
Les informations du plan/de l’image sont 
affichées sous la miniature. Vous pouvez 
changer les informations affichées en utilisant 

Customize View (page 92) >Thumbnail 
Caption dans le menu de miniatures.

2. Nom de plan
Affiche le nom du plan sélectionné.

3. Format vidéo pour l’enregistrement
Affiche le format de fichier du plan sélectionné.

Ecran de miniatures

Ecran de miniatures

Disposition de l’écran

Numéro de plan/Nombre total de plans

Curseur 
(jaune)

Indicateur de la carte mémoire XQD actuellement sélectionnée
(Une icône de verrou s’affiche si la carte est protégée.)



59

4. Informations d’enregistrement spécial
Affiche le mode d’enregistrement uniquement si 
le plan a été enregistré à l’aide d’un mode 
d’enregistrement spécial.
Pour les plans en ralenti et accéléré, la fréquence 
d’images est affichée à droite.

5. Durée du plan

6. Date de création
Lorsque le caméscope est en mode de veille 
d’enregistrement (Stby), vous pouvez lire les 
plans enregistrés.

1 Insérez une carte mémoire XQD pour la 
lecture.

2 Appuyez sur la touche THUMBNAIL.

3 Tournez la molette SEL/SET (page 9) 
pour déplacer le curseur vers la 
miniature du plan que vous souhaitez 
lire.

4 Appuyez sur la molette SEL/SET.
La lecture commence au début du plan 
sélectionné.

Vous pouvez contrôler la lecture en appuyant sur 
l’une des touches suivantes.
Molette SEL/SET :

Fait une pause dans la lecture. 
Appuyez de nouveau sur la molette pour 
revenir à la lecture normale.

Appuyez sur les touches gauche/droite :
Passe au début du plan/du plan suivant.

Appuyez et maintenez les touches 
gauche/droite enfoncées :

Lecture accélérée arrière/avant. 
Revient en lecture normale lorsque vous 
relâchez la touche.

Touche CANCEL/BACK :
Arrête la lecture et revient en mode de veille 
d’enregistrement.

Remarques

• Il peut y avoir une interruption temporaire de l’image 
ou une image fixe entre les clips. Vous ne pouvez pas 
utiliser le caméscope durant cette période.

• Lorsque vous sélectionnez un plan dans l’écran de 
miniatures et commencez la lecture, il peut y avoir une 
interruption temporaire de l’image au début du plan. 
Pour voir le début du plan sans interruption, mettez le 
caméscope en mode de lecture, mettez la lecture en 
pause, puis utilisez la touche gauche de la molette 
SEL/SET pour revenir au début du plan et redémarrez 
la lecture.

• Vous pouvez également contrôler la lecture en utilisant 
la télécommande fournie.

Lecture de plans

Lecture de plans enregistrés
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Sur l’écran de miniatures, vous pouvez utiliser 
des plans ou vérifier les propriétés d’un plan en 
utilisant le menu de miniatures.
Le menu de miniatures (page 92) apparaît lorsque 
vous appuyez sur la touche MENU et 
sélectionnez une miniature.

Tournez la molette SEL/SET (page 9) pour 
sélectionner une fonction, puis appuyez sur la 
molette SEL/SET.
Appuyez sur la touche CANCEL/BACK (page 9) 
pour retourner à l’écran précédent.

Remarque

Certains éléments ne peuvent pas être sélectionnés, selon 
l’état lorsque le menu a été affiché.

Display Clip Properties
Set Index Picture
Thumbnail View
Set Shot Mark
Set Clip Flag
Lock/Unlock Clip
Delete Clip
Filter Clips
Customize View
Pour plus de détails concernant les menus 
d’opérations sur les plans, voir « Menu 
Thumbnail » (page  92).

Affichage des propriétés de plan
Sélectionnez Display Clip Properties (page 92) 
dans le menu de miniatures pour afficher l’écran 
de propriétés de plan.

Affichage de l’écran de miniatures de 
repères 
Sélectionnez Thumbnail View (page 92) 
>Essence Mark Thumbnail dans le menu de 
miniatures et sélectionnez le type de repère pour 
afficher un affichage en miniature des images 
possédant le repère spécifié.

Affichage de l’écran de miniatures de 
plans filtré
Sélectionnez Filter Clips (page 92) dans le menu 
de miniatures et sélectionnez un type de balise de 
plan pour afficher uniquement les plans qui 
possèdent la balise spécifiée.
Pour afficher tous les plans, sélectionnez 
Thumbnail View >Essence Mark Thumbnail dans 
le menu Thumbnail sur All.

Suppression de plans
Vous pouvez supprimer des plans sur les cartes 
mémoire XQD.
Sélectionnez Delete Clip >Select Clip ou All 
Clips dans le menu de miniatures.
Select Clip :

Supprime le plan sélectionné. Il est possible 
de sélectionner plusieurs plans.

All Clips :
Supprime tous les plans affichés.

Modification des informations affichées 
sur l’écran de miniatures
Vous pouvez modifier les informations de plans/
images affichées sous la miniature.
Sélectionnez Customize View >Thumbnail 
Caption dans le menu de miniatures et 
sélectionnez les informations à afficher.
Date Time :

Affiche la date et l’heure à laquelle le plan a 
été créé et modifié pour la dernière fois.

Time Code :
Affiche le code temporel.

Duration :
Affiche la durée du plan.

Sequential Number :
Affiche un numéro séquentiel sur chaque 
miniature.

Opérations sur les plans

Opérations sur le menu de 
miniatures

Eléments du menu de miniatures



61

Appuyez sur la touche MENU pour afficher le 
menu de configuration dans le viseur pour 
spécifier divers éléments pour la prise de vue, 
l’enregistrement et la lecture (le menu peut 
également être affiché sur un moniteur externe). 
Le menu de configuration se compose des menus 
suivants.
Menu User :

Contient des éléments de menu configurés 
par l’utilisateur depuis le menu Edit User.

Menu Edit User :
Contient des éléments de menu pour éditer le 
menu User.

Menu Camera :
Contient des réglages liés à la prise de vue.

Menu Paint :
Contient des réglages liés à la qualité 
d’image.

Menu Audio :
Contient des réglages liés à l’audio.

Menu Video :
Contient des réglages liés à la sortie vidéo.

Menu VF :
Contient des réglages pour l’affichage du 
viseur.

Menu TC/UB :
Contient des réglages liés au code temporel 
et aux bits d’utilisateur.

Menu Recording :
Contient des réglages liés à l’enregistrement.

Menu Thumbnail :
Contient des réglages liés à l’affichage de 
miniatures.

Menu Media :
Contient des réglages liés aux supports.

Menu File :
Contient des réglages liés aux fichiers.

Menu System :
Contient des réglages liés au système.

Affichage et réglages de menu

Configuration et hiérarchie du menu de configuration

Organisation du menu de 
configuration

User
(réglages par 
défaut)

Country

Base Setting

Rec Format

Codec

S&Q Motion

Picture Cache Rec

Simul Rec

Output Format

Monitor LUT

Clip

VF Setting

Assignable Button

Assignable Dial

Format Media

Edit User Menu

Edit User Add Item

Customize Reset

Camera ISO/Gain/EI

Auto Exposure

Focus

Shutter

Color Bars

Noise Suppression

Flicker Reduce

SteadyShot

Handle Zoom

Auto Black Balance

AF Micro Adjustment

Video Light Set

Paint White

Offset White

Black

Gamma

Black Gamma

Knee

White Clip

Detail(HD Mode)

Skin Detail

Aperture

Matrix 

Multi Matrix 

Maintenance
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Audio Audio Input

Audio Output

Video Output On/Off

Output Format

Output Setting

Monitor LUT

Output Display

VF VF Setting

Peaking

Zebra

Marker

Display On/Off

Video Signal Monitor

TC/UB Timecode

TC Display

Users Bit

HDMI TC Out

Recording S&Q Motion

Interval Rec

Picture Cache Rec

Simul Rec

SDI/HDMI Rec Control

Thumbnail Display Clip Properties

Set Index Picture

Thumbnail View

Set Shot Mark

Set Clip Flag

Lock/Unlock Clip

Delete Clip

Filter Clips

Customize View

Support Update Media

Format Media

Clip

File All File

Scene File

User Menu Item

User Gamma

Monitor LUT

Monitor 3D LUT

Lens File

System Base Setting

Codec

Rec Format

Genlock 

Assignable Button

Assignable Dial

Rec Lamp

Fan Control 

HOLD Switch Setting

Lens

Language

Clock Set

Country

Hours Meter

Basic Authentication

Wi-Fi 

GPS

IR Remote

Camera Battery Alarm

Camera DC IN Alarm

Ext. Unit Battery Alarm

Ext. Unit DC IN Alarm

All Reset

APR

Camera Config

Version
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Appuyez sur la touche MENU pour afficher le 
menu de configuration dans le viseur pour 
spécifier divers éléments pour la prise de vue, 
l’enregistrement et la lecture (le menu peut 
également être affiché sur un moniteur externe).

Commandes de menu

Touche MENU (page 9)
Active/désactive le mode de menu pour les 
commandes du menu de configuration.

Touche gauche/droite (page 9) 
Molette SEL/SET (page 9)
Appuyez sur la touche gauche/droite pour 
déplacer le curseur vers la gauche/droite pour 
sélectionner des éléments ou des réglages de 
menu.
Tournez la molette SEL/SET pour déplacer le 
curseur vers le haut/bas pour sélectionner des 
éléments ou des réglages de menu.
Appuyez sur la molette SEL/SET pour appliquer 
l’élément sélectionné.

Touche CANCEL/BACK (page 9)
Annule un réglage avant qu’il soit appliqué et fait 
avancer d’un niveau dans la hiérarchie de menu.

Remarque

Le menu de configuration ne peut pas être actionné en 
mode Focus magnifier (page 40).

Réglage d’éléments de menu
Tournez la molette SEL/SET pour déplacer le 
curseur vers l’élément de menu à régler, puis 
appuyez sur la molette SET/SEL pour 
sélectionner l’élément.
• La zone de sélection d’élément de menu affiche 

jusqu’à huit lignes. Si les options disponibles 
pour un élément ne peuvent pas être affichées 
en même temps, faites défiler l’affichage en 
déplaçant le curseur vers le haut/bas.

• Si un élément a une grande plage d’options 
disponibles (par exemple, –99 à +99), la zone de 
sélection n’est pas affichée. Le paramètre actuel 
est mis en surbrillance pour indiquer que la 
valeur peut être changée.

• Le fait de sélectionner [Execute] pour une 
fonction permet d’exécuter la fonction 
correspondante.

• Le fait de sélectionner un élément qui nécessite 
confirmation avant exécution cache 
temporairement le menu et affiche un message 
de confirmation. Vérifiez le message, puis 
sélectionnez l’exécution ou l’annulation de la 
fonction.

Saisie d’une chaîne de caractères
Quand vous sélectionnez un élément, tel qu’un 
nom de fichier, qui exige la saisie de caractères, 
l’écran de saisie de caractères s’affiche.

1 Tournez la molette SEL/SET pour 
sélectionner un type de caractère, puis 
appuyez sur la molette. 

ABC : lettres majuscules
abc : lettres minuscules
123 : caractères numériques
!#$ : caractères spéciaux

2 Sélectionnez un caractère du type de 
caractères sélectionné, puis appuyez sur 
la molette.

Le curseur passe au champ suivant.
Espace : permet de saisir un espace au niveau 
du curseur.
T/t : permet de déplacer le curseur.
BS : permet de supprimer le caractère à 
gauche du curseur (espacement arrière).

3 Lorsque vous avez terminé, sélectionnez 
[Done] et appuyez sur la molette.

La chaîne de caractères est confirmée et 
l’écran de saisie de caractères disparaît.

Opérations du menu de 
configuration
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Cette section décrit la fonction et les réglages des éléments de chaque menu.
Les réglages par défaut sont affichés en gras (par exemple, 18dB).

Liste du menu de configuration

Menu User

User

Elément Réglage de sous-éléments Description

Country
Réglages de région

Voir Country dans le menu 
System.

Base Setting
Réglages de base

Voir Base Setting dans le menu 
System.

Rec Format
Réglages du format 
d’enregistrement

Voir Rec Format dans le menu 
System.

Codec
Réglages de codec

Voir Codec dans le menu System.

S&Q Motion
Réglages du mode ralenti et 
accéléré

Voir S&Q Motion dans le menu 
Recording.

Picture Cache Rec
Réglages du mode 
d’enregistrement de cache 
d’images

Voir Picture Cache Rec dans le 
menu Recording.

Simul Rec
Réglages d’enregistrement 
simultané

Voir Simul Rec dans le menu 
Recording.

Output Format
Réglages du format de sortie

Voir Output Format dans le menu 
Video.

Monitor LUT
Réglages de Monitor LUT

Voir Monitor LUT dans le menu 
Video.

Clip
Réglages relatifs aux noms de 
plans

Voir Clip dans le menu Media.

VF Setting
Réglages du viseur

Voir VF Setting dans le menu VF.

Assignable Button
Réglages permettant d’assigner 
des fonctions aux touches 
personnalisables

Voir Assignable Button dans le 
menu System.

Assignable Dial
Réglages permettant d’assigner 
des fonctions aux molettes 
personnalisables

Voir Assignable Dial dans le menu 
System.

Format Media
Formate (initialise) les cartes 
mémoire

Voir Format Media dans le menu 
Media.
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Le menu Edit User est affiché au niveau supérieur quand « Edit User Menu » est sélectionné dans le menu 
User.

Edit User Menu
Editer les éléments du menu User

Edite les éléments dans le menu User.
Quand « Edit User Menu » est sélectionné, le 
menu Edit User passe au niveau supérieur et 
les éléments de menu s’affichent.

User

Elément Réglage de sous-éléments Description

Menu Edit User

Edit User

Elément Réglage de sous-éléments Description

Add Item
Ajouter un élément au menu User

Ajoute un élément de menu au menu User.

Customize Reset
Réinitialiser les éléments dans le 
menu User

Restaure les éléments de menu enregistrés 
dans le menu User aux réglages par défaut.

Elément de menu sélectionné 
pendant l’édition

Delete Supprime l’élément de menu enregistré du 
menu User.

Move Réorganise les éléments de menu enregistrés 
du menu User.

Edit Sub Item Supprime les sous-éléments de menu 
enregistrés dans le menu User.

Menu Camera

Camera

Elément Réglage de sous-éléments Description

ISO/Gain/EI
Réglages du gain

Mode
ISO/dB

Sélectionne le mode de réglage du gain.

ISO/Gain<H>
Lorsque Mode est réglé sur ISO et 
la plage dynamique est 460% :

ISO 800 / ISO 1000 / 
ISO 1250 / ISO 1600 / 
ISO 2000 / ISO 2500 / 
ISO 3200 / ISO 4000 / 
ISO 5000 / ISO 6400 

Lorsque Mode est réglé sur ISO et 
la plage dynamique est 800% :

ISO 1600 / ISO 2000 /
ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 /
ISO 6400 / ISO 8000 /
ISO 10000 / ISO 12500

Règle la valeur prédéfinie de gain <H>.
Quand le mode est réglé sur ISO et que la plage dynamique est 
de 1300% (la catégorie gamma est réglée sur S-Log2 ou 
S-Log3) :

ISO 2000 / ISO 2500 / ISO 3200 /
ISO 4000 / ISO 5000 / ISO 6400 /
ISO 8000 / ISO 10000 / ISO 12500 /
ISO 16000

Quand le mode est réglé sur dB :
–3dB / 0dB / 3dB / 6dB /
9dB / 12dB / 18dB

La plage dynamique est déterminée par gamma.

Gamma Plage 
dynamique

STD / HG1 / HG2 / HG3 / HG4 460%

HG7 / HG8 / User 800%

S-Log2 / S-Log3 1300%
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ISO/Gain<M>
(Mêmes réglages que ISO/
Gain<H>)

Règle la valeur prédéfinie de gain <M>.
Les valeurs par défaut sont indiquées ci-dessous.
Lorsque Mode est réglé sur ISO et la plage dynamique est 
460% :

ISO1600
Lorsque Mode est réglé sur ISO et la plage dynamique est 
800% :

ISO3200
Quand le mode est réglé sur ISO et que la plage dynamique est 
de 1300% (la catégorie gamma est réglée sur S-Log2 ou 
S-Log3) :

ISO4000
Quand le mode est réglé sur dB :

6dB

ISO/Gain<L>
(Mêmes réglages que ISO/
Gain<H>)

Règle la valeur prédéfinie de gain <L>.
Les valeurs par défaut sont indiquées ci-dessous.
Lorsque Mode est réglé sur ISO et la plage dynamique est 
460% :

ISO800
Lorsque Mode est réglé sur ISO et la plage dynamique est 
800% :

ISO1600
Quand le mode est réglé sur ISO et que la plage dynamique est 
de 1300% (la catégorie gamma est réglée sur S-Log2 ou 
S-Log3) :

ISO2000
Quand le mode est réglé sur dB :

0dB

Exposure Index<H>
500EI / 4.0E
640EI / 4.3E
800EI / 4.7E
1000EI / 5.0E
1250EI / 5.3E
1600EI / 5.7E
2000EI / 6.0E
2500EI / 6.3E
3200EI / 6.7E
4000EI / 7.0E
5000EI / 7.3E
6400EI / 7.7E
8000EI / 8.0E

Règle la valeur d’indice de pose <H>.
Disponible en mode Cine EI uniquement.

Exposure Index<M>
(Mêmes réglages qu’Exposure 
Index<H>)

Règle la valeur d’indice de pose <M>.
La valeur par défaut est 1600EI / 5.7E

Exposure Index<L>
(Mêmes réglages qu’Exposure 
Index<H>)

Règle la valeur d’indice de pose <L>.
La valeur par défaut est 800EI / 4.7E

Shockless Gain
On/Off

Active/désactive la fonction Shockless gain.

Camera

Elément Réglage de sous-éléments Description
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Auto Exposure
Réglages 
d’ajustement de 
l’exposition 
automatique

Level
–2.0 / –1.75 / –1.5 / –1.25 / 
–1.0 / –0.75 / –0.5 / –0.25 / 0 / 
+0.25 / +0.5 / +0.75 / +1.0 / 
+1.25 / +1.5 / +1.75 / +2.0

Règle le niveau de luminosité pour l’exposition détectée de 
manière automatique.

Mode
Backlight/Standard/Spotlight

Règle le mode de commande.
Backlight :

Mode rétroéclairage (mode qui atténue l’obscurité d’un 
sujet lorsque le sujet est rétroéclairé)

Standard :
Mode standard

Spotlight :
Mode spotlight (mode qui atténue les blancs écrêtés 
lorsque le sujet est éclairé par la lumière d’un spot)

Speed
–99 à +99 (±0)

Règle la vitesse d’ajustement.

AGC
On/Off

Active/désactive la fonction AGC (commande de gain 
automatique).

AGC Limit
Quand le mode >ISO/Gain/EI est 
réglé sur dB :

3dB / 6dB / 9dB / 12dB / 
15dB / 18dB

Lorsque le mode >ISO/Gain/EI est 
réglé sur ISO et la plage 
dynamique est 460% :

ISO1000 / ISO1600 / ISO2000 / 
ISO3200 / ISO4000 / ISO6400

Règle le gain maximum de la fonction AGC.
Lorsque le mode >ISO/Gain/EI est réglé sur ISO et la plage 
dynamique est 800% :

ISO2000 / ISO3200 / ISO4000 / ISO6400 / ISO8000 / 
ISO12500

Lorsque le mode >ISO/Gain/EI est réglé sur ISO et la plage 
dynamique est 1300% :

ISO2500 / ISO4000 / ISO5000 / ISO8000 / ISO10000 / 
ISO16000

Auto Shutter
On/Off

Active/désactive la fonction de commande d’obturateur 
automatique.

A.SHT Limit
1/100 / 1/150 / 1/200 / 
1/250 / 1/2000

Règle la vitesse d’obturateur la plus rapide de la fonction 
d’obturateur automatique.

Clip High light
On/Off

Active/désactive la fonction qui ignore les zones les plus 
lumineuses pour fournir une réaction plus plate à une 
luminance élevée.

Detect Window
1 / 2 / 3 / 4 / 5 / 6

Règle la plage d’intégrateur de lumière pour l’ajustement 
automatique de la pose en fonction de la luminosité du sujet. 
(Non disponible en cas de réglage manuel de la pose)

Detect Window Indication
On/Off

Active/désactive la fonction Detect Window.

Camera

Elément Réglage de sous-éléments Description
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Focus
Réglages de mise 
au point

Focus Area
Wide / Center / Flexible

Règle la zone cible pour la mise au point automatique 
(page 40).
Wide :

Recherche un sujet dans un grand angle de l’image lors de 
la mise au point.

Center :
Effectue la mise au point sur un sujet au centre de l’image.

Flexible Spot :
Effectue la mise au point sur une position spécifique dans 
l’image.

Focus Area (Push AF)
Center / Flexible

Règle la zone cible pour Push Auto Focus (page 40).
Center :

Effectue la mise au point sur un sujet au centre de l’image.
Flexible Spot :

Effectue la mise au point sur une position spécifique dans 
l’image.

Remarque

Avec le LA-EA2/4 (en option), la position ne peut pas être 
réglée.

AF Assist
On/Off

Quand ce réglage est réglé sur On, il est possible de changer 
temporairement la mise au point automatique et d’effectuer la 
mise au point manuellement.

Camera

Elément Réglage de sous-éléments Description
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Shutter
Réglages des 
conditions de 
fonctionnement de 
l’obturateur 
électronique

Mode
Speed / Angle / ECS / Off

Sélectionne le mode de fonctionnement de l’obturateur 
électronique.
Speed/angle (mode standard) :

Utilisé pour filmer de manière nette des sujets se déplaçant 
rapidement. Sélectionne le mode pour régler la vitesse 
d’obturateur en secondes (Speed) ou comme angle 
d’obturateur (Angle).

ECS (Extended Clear Scan) :
Utilisé pour la prise de vue sans faire défiler les barres 
horizontales qui apparaissent sur l’écran du moniteur.

Shutter Speed
1/3 à 1/9000

Règle la vitesse d’obturateur quand Mode est réglé sur Speed. 
Les réglages disponibles varient en fonction de la fréquence 
d’images du format vidéo sélectionné.
59.94P/59.94i :

1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250, 
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000, 
1/4000, 1/6000, 1/9000

50P/50i :
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 1/120, 1/150, 1/215, 
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500, 
1/3500, 1/6000, 1/9000

29.97P :
1/4, 1/8, 1/15, 1/30, 1/60, 1/90, 1/100, 1/125, 1/180, 1/250, 
1/350, 1/500, 1/725, 1/1000, 1/1500, 1/2000, 1/3000, 
1/4000, 1/6000, 1/9000

25P :
1/3, 1/6, 1/12, 1/25, 1/50, 1/60, 1/100, 1/120, 1/150, 1/215, 
1/300, 1/425, 1/600, 1/1000, 1/1250, 1/1750, 1/2500, 
1/3500, 1/6000, 1/9000

24P :
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100, 
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200, 
1/2400, 1/4800, 1/9000

23.98P :
1/3, 1/6, 1/12, 1/24, 1/40, 1/48, 1/50, 1/60, 1/96, 1/100, 
1/120, 1/144, 1/192, 1/200, 1/288, 1/400, 1/576, 1/1200, 
1/2400, 1/4800, 1/9000

Remarque

1/1 peut être réglé lorsque la fréquence d’images de 
l’enregistrement S&Q est réglé sur 1fps.

Shutter Angle
5.625° / 11.25° / 22.5° / 45° / 
90° / 120° / 144° / 150° / 
172.8° / 180° / 216° / 300°

Règle l’angle d’obturateur quand Mode est réglé sur Angle.

ECS Frequency
23.99 à 8000

Règle la fréquence d’ECS quand Mode est réglé sur ECS. Les 
réglages disponibles varient en fonction de la fréquence 
d’images du format vidéo sélectionné.
Les valeurs par défaut sont données ci-dessous.
59.94P : 60.00
59.94P : 60.00
50P : 50.00
50i : 50.00
29.97P : 30.00
24P: 24.02
23.98P : 23.99
25P : 25.02

Camera
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Color Bars
Réglages de barres 
de couleur

Setting
On / Off

Active/désactive les barres de couleur.

Remarque

Ne peut pas être activé lorsqu’il est configuré pour enregistrer 
une vidéo RAW.

Type
ARIB / SMPTE / 75% / 100%

Sélectionne le type de barres de couleur.

Noise 
Suppression
Réglages de 
suppression de 
bruit

Setting
On / Off

Active/désactive la fonction de suppression de bruit.
Les valeurs par défaut sont désactivées si le mode Base Setting 
>Shooting dans le menu System est réglé sur Cine EI.

Level
Low / Mid / High

Règle le niveau de suppression de bruit.

Flicker Reduce
Réglages de 
correction de 
scintillement

Mode
Auto / On / Off

Règle le mode de correction de scintillement.

Frequency
50Hz / 60Hz

Règle la fréquence de la source d’alimentation qui fournit 
l’éclairage qui cause le scintillement.

SteadyShot
Réglages de 
stabilisation 
d’image

Setting
Active SteadyShot / 
SteadyShot / Off

Active/désactive la fonction de stabilisation d’image.

Remarque

Activé lorsqu’un objectif compatible est fixé.

Handle Zoom
Réglages de zoom 
à poignée

Zoom Speed Type
Fix / Variable / Off

Règle le mode du levier de zoom sur la poignée.

Remarque

Désactivé lorsque la poignée n’est pas fixée.

Zoom Speed
1 à 8 (3)

Règle la vitesse du zoom à poignée.
(Activé quand Zoom Speed Type est réglé sur Fix)

Remarque

Désactivé lorsque la poignée n’est pas fixée.

Auto Black 
Balance
Réglages 
automatiques de 
l’équilibre des 
noirs

Auto Black Balance
Execute/Cancel

Exécute la fonction automatique d’équilibre des noirs.

Remarques

• Exécutez la fonction automatique d’équilibre des noirs avec 
le capuchon d’objectif fixé.

• Ne peut pas être utilisé pendant l’enregistrement ou 
l’affichage de la barre de couleur.

• Ne peut pas être exécuté en mode Interval Rec ou Slow & 
Quick Motion.

Camera

Elément Réglage de sous-éléments Description
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AF Micro 
Adjustment
Micro-réglage de 
la position de mise 
au point
(Activé quand LA-
EA2/4 (optionnel) 
est utilisé)

Setting
On/Off

Active/désactive la fonction de micro-réglage de mise au point 
automatique.

Amount
–20 à 0 à +20

Règle le niveau de micro-réglage de mise au point 
automatique.
Utilisez la procédure suivante pour ajuster les objectifs à 
monture A.
1 Fixez l’objectif que vous souhaitez ajuster grâce à un 

LA-EA2/4 (optionnel).
2 Réglez Setting sur On, puis ajustez la valeur Amount. 

Les valeurs positives déplacent la mise au point derrière le 
sujet, et les valeurs négatives déplacent la mise au point à 
l’avant du sujet.
Il est recommandé de vérifier le résultat grâce à la fonction 
one-push AF, par exemple pendant l’ajustement de la mise 
au point.

Clear All
Execute/Cancel

Initialise les valeurs de réglage sauvegardées.

Video Light 
Set
Réglages de lampe 
vidéo (lors de 
l’utilisation de 
HVL-LBPC 
(optionnel))

Video Light Set
Power Link / Rec Link / Rec 
Link + Stby

Règle la méthode de contrôle d’éclairage pour la lumière 
vidéo fixée à la griffe d’interface multiple.
Power Link :

Allume/éteint l’éclairage vidéo quand le caméscope est en 
marche/à l’arrêt.

Rec Link :
Allume/éteint l’éclairage vidéo quand le caméscope 
commence/arrête l’enregistrement.

Rec Link + Stby :
Allume/éteint l’éclairage vidéo quand le caméscope 
enregistre ou est en mode de veille.

Camera
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Menu Paint

Paint

Elément Réglage de sous-éléments Description

White
Réglages de 
l’équilibre des 
blancs

Preset White
2100K à 10000K (3200K)

Règle la valeur prédéfinie de l’équilibre des blancs.

Color Temp <A>
1500K à 50000K (3200K)

Affiche la température de couleur de l’équilibre des blancs 
stockée dans la mémoire A.

Color Temp. Balance <A>
–99 à +99 (±0)

Règle la valeur de gain de l’équilibre des blancs stockée dans 
la mémoire A (gain R et gain B associés).

R Gain <A>
–99 à +99 (±0)

Règle la valeur de gain R de l’équilibre des blancs stockée 
dans la mémoire A.

B Gain <A>
–99 à +99 (±0)

Règle la valeur de gain B de l’équilibre des blancs stockée 
dans la mémoire A.

Color Temp <B>
1500K à 50000K (3200K)

Affiche la température de couleur de l’équilibre des blancs 
stockée dans la mémoire B.

Color Temp. Balance <B>
–99 à +99 (±0)

Règle les valeurs de gain de l’équilibre des blancs stockées 
dans la mémoire B (gain R et gain B associés).

R Gain <B>
–99 à +99 (±0)

Règle la valeur de gain R de l’équilibre des blancs stockée 
dans la mémoire B.

B Gain <B>
–99 à +99 (±0)

Règle la valeur de gain B de l’équilibre des blancs stockée 
dans la mémoire B.

Filter White Memory
On/Off

Active/désactive la fonction de réglage de la zone de mémoire 
d’équilibre des blancs pour chaque filtre ND.
On : règle la mémoire d’équilibre des blancs pour chaque filtre 
ND.
Off : règle la mémoire d’équilibre des blancs commune à tous 
les filtres ND.

Shockless White
Off/1/2/3

Règle la vitesse de réaction d’équilibre des blancs en cas de 
commutation du mode d’équilibre des blancs.
Off : commute instantanément.
1 à 3 : plus la valeur est élevée, plus la commutation est lente.

White Switch<B>
Memory/ATW

Sélectionne le mode de réglage d’équilibre des blancs 
sélectionné quand le commutateur WHT BAL est réglé sur B.

ATW Speed
1 / 2 / 3 / 4 / 5

Règle la vitesse de réaction en mode ATW.
1 : vitesse de réaction la plus rapide
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Offset White
Réglages de 
correction de 
l’équilibre des 
blancs

Offset White <A>
On/Off

Choisit d’ajouter (On) ou non (Off) une valeur de décalage à 
l’équilibre des blancs dans la mémoire A.

Warm Cool <A>
–99 à +99 (±0)

Règle la correction supplémentaire ajoutée à l’équilibre des 
blancs dans la mémoire A comme une température de couleur 
quand Offset White <A> est réglé sur « On ».

Warm Cool Balance <A>
–99 à +99 (±0)

Règle une température de couleur plus précise, à utiliser 
lorsqu’il n’est pas possible d’obtenir une image satisfaisante 
avec le réglage Warm Cool <A>.

Offset White <B>
On/Off

Permet de choisir d’ajouter (On) ou de ne pas ajouter (Off) 
une valeur de correction à l’équilibre des blancs dans la 
mémoire B.

Warm Cool <B>
–99 à +99 (±0)

Règle la correction supplémentaire ajoutée à l’équilibre des 
blancs dans la mémoire B comme une température de couleur 
quand Offset White <B> est réglé sur « On ».

Warm Cool Balance <B>
–99 à +99 (±0)

Règle une température de couleur plus précise, à utiliser 
lorsqu’il n’est pas possible d’obtenir une image satisfaisante 
avec le réglage Warm Cool <B>.

Offset White<ATW>
On/Off

Permet de choisir d’ajouter (On) ou de ne pas ajouter (Off) 
une valeur de correction à l’équilibre des blancs ATW.

Warm Cool<ATW>
–99 à +99 (±0)

Règle la correction supplémentaire ajoutée à l’équilibre des 
blancs ATW comme une température de couleur quand Offset 
White <ATW> est réglé sur « On ».

Warm Cool Balance<ATW>
–99 à +99 (±0)

Règle une température de couleur plus précise, à utiliser 
lorsqu’il n’est pas possible d’obtenir une image satisfaisante 
avec le réglage Warm Cool<ATW>.

Black
Réglages des noirs

Setting
On/Off

Active/désactive la correction des noirs.

Master Black
–99 à +99 (±0)

Règle le niveau de noir maître.

Remarque

Le réglage précis est pris en charge lorsque vous tournez 
lentement la molette SEL/SET. Dans ce cas, il est possible que 
la valeur affichée ne change pas.

R Black
–99 à +99 (±0)

Règle le niveau de noir R.

B Black
–99 à +99 (±0)

Règle le niveau de noir B.

Paint

Elément Réglage de sous-éléments Description
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Gamma
Réglages de 
correction gamma

Setting
On/Off

Active/désactive la fonction de correction gamma.

Step Gamma
0.35 à 0.45 à 0.90

Définit une valeur de correction gamma par incréments de 
0,05.

Master Gamma
–99 à +99 (±0)

Définit le niveau gamma maître.

R Gamma
–99 à +99 (±0)

Définit le niveau gamma R.

G Gamma
–99 à +99 (±0)

Définit le niveau gamma V.

B Gamma
–99 à +99 (±0)

Définit le niveau gamma B.

Gamma Category
STD / HG / User / S-Log2 / 
S-Log3

Sélectionne l’utilisation de gamma standard (STD), 
d’HyperGamma (HG), de gamma utilisateur (User), de 
S-Log2 ou de S-Log3.

Gamma Select
Quand la catégorie Gamma est 
réglée sur STD :

STD1 DVW / STD2 x 4.5 / 
STD3 x 3.5 / STD4 240M / 
STD5 R709 / STD6 x 5.0

Quand la catégorie Gamma est 
réglée sur HG :

HG1 3250G36 / HG2 4600G30 
/ HG3 3259G40 / HG4 
4609G33 / HG7 8009G40 / 
HG8 8009G33

Quand la catégorie Gamma est 
réglée sur User :

User 1 / User 2 / User 3 / User 4 
/ User 5

Quand la catégorie Gamma est 
réglée sur S-Log2 :

S-Log2
Quand la catégorie Gamma est 
réglée sur S-Log3 :

S-Log3

Sélectionne le tableau gamma utilisé pour la correction 
gamma.
Consultez le tableau ci-dessous pour les détails sur 
l’hypergamma et S-Log2/S-Log3.

Black Gamma Setting
On/Off

Active/désactive la fonction de correction gamma du noir.
(Activé quand Gamma >Gamma Category est réglé sur STD)

Remarque

Les fonctions Black Gamma et Knee >Knee Saturation ne 
peuvent pas être utilisées en même temps.

Range
Low/Mid/High

Sélectionne la plage effective de la correction gamma du noir.

Master Black Gamma
–99 à +99 (±0)

Règle le niveau de gamma du noir maître.

Paint
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Nom
Plage 
dynamique

Limite 
blanche

Sortie vidéo 
de carte 
grise 18% 
(20% entrée 
vidéo)

HG1 3250G36 325% 100% 36%

HG2 4600G30 460% 100% 30%

HG3 3259G40 325% 109% 40%

HG4 4609G33 460% 109% 33%

HG7 8009G40 800% 109% 40%

HG8 8009G33 800% 109% 33%

S-Log2 1300% – 32%

S-Log3 1300% – 41%
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Knee Setting
On/Off

Active/désactive la fonction de correction de courbe.
(Activé quand Gamma >Gamma Category est réglé sur STD)

Auto Knee
On/Off

Active/désactive la fonction de correction de courbe 
automatique.

Point
75% à 109% (90%)

Règle le point de courbe.

Slope
–99 à +99 (±0)

Règle la pente de courbe.

Knee Saturation
On/Off

Active/désactive le réglage de saturation de courbe (ajuste la 
coloration au-dessus du point de courbe).

Remarque

Les fonctions Black Gamma et Knee >Knee Saturation ne 
peuvent pas être utilisées en même temps.

Knee Saturation Level
–99 à +99 (±0)

Règle le niveau d’ajustement de la coloration au-dessus du 
point de courbe (saturation de courbe).

White Clip
Réglages 
d’ajustement 
d’écrêtage du 
blanc

Setting
On/Off

Active/désactive la fonction d’ajustement d’écrêtage du blanc.

Remarques

• Le réglage est réinitialisé sur On lorsque le caméscope est 
mis hors tension. Pour que le réglage soit sur Off en 
permanence, réglez Level sur 109%.

• Ne peut pas être réglé lorsque Gamma >Gamma Category 
est réglé sur S-Log2 ou S-Log3.

Level
90.0% à 109.0%

Le réglage par défaut dépend du 
pays/de la région d’achat.

Région NTSC : 108.0%
Région PAL : 105.0%

Règle le niveau d’écrêtage du blanc.

Paint
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Detail
Réglages 
d’ajustement des 
détails

Setting
On/Off

Active/désactive la fonction d’ajustement de détail.

Level
–99 à +99 (±0)

Règle le niveau de détail.

H/V Ratio
–99 à +99 (±0)

Règle le rapport de mélange entre le niveau de détail H et le 
niveau de détail V.

Crispening
–99 à +99 (±0)

Règle le niveau de netteté.

Level Depend
On/Off

Active/désactive la fonction d’ajustement de dépendance du 
niveau.

Level Depend Level
–99 à +99 (±0)

Règle le niveau de dépendance du niveau.

Frequency
–99 à +99 (±0)

Règle la fréquence centrale du détail (épaisseur de détail).
Le détail est plus mince lorsque la fréquence centrale est plus 
élevée et plus épais lorsque la fréquence centrale est plus 
basse.

Knee Aperture
On/Off

Active/désactive la fonction de correction d’ouverture de 
courbe.

Knee Aperture Level
–99 à +99 (±0)

Règle le niveau d’ouverture de courbe.

Limit
–99 à +99 (±0)

Règle les limites de détail pour les côtés blanc et noir.

White Limit
–99 à +99 (±0)

Règle la limite de détail pour le côté blanc.

Black Limit
–99 à +99 (±0)

Règle la limite de détail pour le côté noir.

V Black Limit
–99 à +99 (±0)

Règle la limite de détail V pour le côté noir.

V Detail Creation
NAM / Y / G / G+R

Règle la source de signal pour créer le détail V sur NAM (G 
ou R, en fonction de celui qui est le plus élevé), Y, G ou G+R.

Skin Detail
Réglages de 
correction des 
détails du teint

Setting
On/Off

Active/désactive la fonction de correction des détails du teint.

Area Detection
Execute/Cancel

Détecte la couleur utilisée pour la correction des détails de la 
peau.
Execute : exécuter la détection

Area Indication
On/Off

Active/désactive la fonction qui affiche les motifs de zébrure 
dans les zones de la couleur utilisée pour la correction des 
détails de la peau.

Level
–99 à +99 (±0)

Règle le niveau des détails du teint.

Saturation
–99 à +99 (±0)

Règle la saturation de la couleur cible pour la correction des 
détails du teint.

Hue
0 à 359

Règle la teinte de la couleur cible pour la correction des détails 
du teint.

Width
0 à 90 (40)

Règle la plage de la teinte de la couleur cible de la correction 
des détails du teint.

Paint
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Aperture
Réglages de 
correction 
d’ouverture

Setting
On/Off

Active/désactive la correction d’ouverture (traitement qui 
améliore la résolution en ajoutant des signaux d’ouverture 
haute fréquence au signal vidéo, ce qui corrige la détérioration 
due aux caractéristiques de haute fréquence).

Level
–99 à +99 (±0)

Règle le niveau de correction d’ouverture.

Matrix
Réglages de 
correction de 
matrice

Setting
On/Off

Active ou désactive la fonction de correction de matrice.

Adaptive Matrix
On/Off

Active/désactive la fonction de matrice d’adaptation.

Preset Matrix
On/Off

Active/désactive la fonction de matrice prédéfinie.

Preset Select
Standard
High Saturation
FL Light
Cinema
F55 709 Like

Sélectionne une matrice prédéfinie.

User Matrix
On/Off

Active ou désactive la fonction de correction de matrice 
utilisateur.

Level
–99 à +99 (±0)

Ajuste la saturation de couleur de l’image entière. 

Phase
–99 à +99 (±0)

Ajuste la nuance de couleur (phase) de l’image entière.

User Matrix R-G
–99 à +99 (±0)

Règle une matrice utilisateur R-V définie par l’utilisateur.

User Matrix R-B
–99 à +99 (±0)

Règle une matrice utilisateur R-B définie par l’utilisateur.

User Matrix G-R
–99 à +99 (±0)

Règle une matrice utilisateur V-R définie par l’utilisateur.

User Matrix G-B
–99 à +99 (±0)

Règle une matrice utilisateur V-B définie par l’utilisateur.

User Matrix B-R
–99 à +99 (±0)

Règle une matrice utilisateur B-R définie par l’utilisateur.

User Matrix B-G
–99 à +99 (±0)

Règle une matrice utilisateur B-V définie par l’utilisateur.

Paint
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Multi Matrix
Réglages de 
correction de 
matrice multiple

Setting
On/Off

Active/désactive la fonction de correction de matrice multiple.

Area Indication
On/Off

Active/désactive la fonction d’indication de zone.

Color Detection
Execute/Cancel

Détecte la couleur utilisée pour la correction de matrice 
multiple.

Axis
B/B+/MG–/MG/MG+/ 
R / R+ / YL– / YL / YL+ / G– / 
G / G+ / CY / CY+ / B–

Sélectionne l’axe.

Hue
–99 à +99 (±0)

Règle la teinte de la couleur utilisée pour la correction de 
matrice multiple.

Saturation
–99 à +99 (±0)

Règle la saturation de la couleur utilisée pour la correction de 
matrice multiple.

Maintenance
Réglages 
d’entretien

Test Saw
On/Off

Active/désactive le signal test.

Paint
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Menu Audio

Audio

Elément Réglage de sous-éléments Description

Audio Input
Réglages d’entrée 
audio

CH1 Input Select
INPUT1 / Internal MIC / 
Shoe 1

Commute la source d’entrée pour l’enregistrement sur le canal 
1.

CH2 Input Select
INPUT1 / INPUT2 / 
Internal MIC / Shoe 2

Commute la source d’entrée pour l’enregistrement sur le canal 
2.

CH3 Input Select
Off / Internal MIC / Shoe 1

Commute la source d’entrée pour l’enregistrement sur le canal 
3.

CH4 Input Select
Off / Internal MIC / Shoe 2

Commute la source d’entrée pour l’enregistrement sur le canal 
4.

INPUT1 MIC Reference
–60dB / –50dB / –40dB

Règle le niveau d’enregistrement de référence pour l’entrée du 
microphone XLR à partir d’INPUT1.

INPUT2 MIC Reference
–60dB / –50dB / –40dB

Règle le niveau d’enregistrement de référence pour l’entrée du 
microphone XLR à partir d’INPUT2.

CH1 Wind Filter
On / Off

Active/désactive le filtre de réduction anti-vent pour 
l’enregistrement sur le canal 1.

CH2 Wind Filter
On / Off

Active/désactive le filtre de réduction anti-vent pour 
l’enregistrement sur le canal 2.

CH3 Wind Filter
On / Off

Active/désactive le filtre de réduction anti-vent pour 
l’enregistrement sur le canal 3.

CH4 Wind Filter
On / Off

Active/désactive le filtre de réduction anti-vent pour 
l’enregistrement sur le canal 4.

CH3 Level Control
Auto / Manual

Sélectionne le réglage du niveau d’entrée audio ou le réglage 
manuel pour le canal d’enregistrement 3.

Remarque

Si CH3 Input Select ou CH4 Input Select est réglé sur 
« Internal MIC », CH4 est commuté sur automatic/manual en 
conjonction avec ce réglage.

CH4 Level Control
Auto / Manual

Sélectionne le réglage du niveau d’entrée audio ou le réglage 
manuel pour le canal d’enregistrement 4.

Remarque

Si CH3 Input Select ou CH4 Input Select est réglé sur 
« Internal MIC », CH4 est commuté sur automatic/manual en 
conjonction avec le réglage CH3 Level Control.
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CH3 Input Level
0 à 99 (49)

Règle le niveau d’entrée audio pour le canal d’enregistrement 
3.

Remarque

Si CH3 Input Select ou CH4 Input Select est réglé sur 
« Internal MIC », CH4 Input Level est commuté en 
conjonction avec ce réglage.

CH4 Input Level
0 à 99 (49)

Règle le niveau d’entrée audio pour le canal d’enregistrement 
4.

Remarque

Si CH3 Input Select ou CH4 Input Select est réglé sur 
« Internal MIC », CH4 Input Level est commuté en 
conjonction avec le réglage CH3 Input Level.

Audio Input Level
0 à 99

Règle le niveau d’entrée audio.
Peut être utilisé comme volume principal en fonction des 
réglages de CH1 Level à CH4 Level.

Limiter Mode
Off/–6dB/–9dB/–12dB/ 
–15dB/–17dB

Sélectionne la caractéristique du limiteur pour les forts 
signaux d’entrée lors du réglage manuel du niveau d’entrée 
audio.

CH1&2 AGC Mode
Mono / Stereo

Règle le mode de réglage automatique de niveau pour le canal 
d’enregistrement 1 et canal 2.

CH3&4 AGC Mode
Mono / Stereo

Règle le mode de réglage automatique de niveau pour le canal 
d’enregistrement 3 et canal 4.

AGC Spec
–6dB/–9dB/–12dB/ 
–15dB/–17dB

Sélectionne la caractéristique AGC.

1kHz Tone on Color Bars
On/Off

Active/désactive le signal de tonalité de référence de 1 kHz 
lors de l’affichage des barres de couleur.

Remarque

Lorsqu’il est activé, le signal de tonalité de référence de 1 kHz 
est réglé pour l’enregistrement sur le canal 3 et canal 4, même 
si CH3 Input Select et CH4 Input Select sont désactivés.

CH1 Level
Entrée sans adaptateur XLR

Audio Input Level / Side / 
Level+Side

Entrée avec adaptateur XLR 
(page 54)

Audio Input Level / Through

Règle la combinaison des ajustements de niveau d’entrée 
audio activés pour le canal d’enregistrement 1.

Remarque

« Side » se rapporte à la molette CH1 INPUT LEVEL sur le 
côté du caméscope. Lorsque Level+Side est sélectionné, le 
niveau d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et dial 
(page 135).

CH2 Level
Entrée sans adaptateur XLR

Audio Input Level / Side / 
Level+Side

Entrée avec adaptateur XLR 
(page 54)

Audio Input Level / Through

Règle la combinaison des ajustements de niveau d’entrée 
audio activés pour le canal d’enregistrement 2.

Remarque

« Side » se rapporte à la molette CH2 INPUT LEVEL sur le 
côté du caméscope. Lorsque Level+Side est sélectionné, le 
niveau d’enregistrement audio est déterminé par la 
combinaison des réglages Audio Input Level et dial 
(page 135).

Audio

Elément Réglage de sous-éléments Description
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CH3 Level
Entrée sans adaptateur XLR

Audio Input Level / CH3 Input 
Level / Level+CH3 Input 
Level

Entrée avec adaptateur XLR 
(page 54)

Audio Input Level / Through

Règle la combinaison des ajustements de niveau d’entrée 
audio activés pour le canal d’enregistrement 3.

Remarque

Lorsque Level+CH3 Input Level est sélectionné, le niveau 
d’enregistrement audio est déterminé par la combinaison des 
réglages Audio Input Level et CH3 Input Level (page 136).

CH4 Level
Entrée sans adaptateur XLR

Audio Input Level / CH4 Input 
Level / Level+CH4 Input 
Level

Entrée avec adaptateur XLR 
(page 54)

Audio Input Level / Through

Règle la combinaison des ajustements de niveau d’entrée 
audio activés pour le canal d’enregistrement 4.

Remarque

Lorsque Level+CH4 Input Level est sélectionné, le niveau 
d’enregistrement audio est déterminé par la combinaison des 
réglages Audio Input Level et CH4 Input Level (page 136).

Audio Output
Réglages de sortie 
audio

Monitor CH
CH1/CH2 / CH3/CH4 / MIX 
ALL / CH1 / CH2 / CH3 / CH4

Sélectionne la sortie du canal audio vers le connecteur de 
casque et le haut-parleur intégré.

Remarque

Si l’audio pour plusieurs canaux est réglée sur la sortie 
simultanée, le niveau de sortie pour chaque canal est réduit 
pour la sortie pour éviter le détourage.

Monitor Volume
0 à 15 (7)

Ajuste la sortie de niveau audio du moniteur vers le 
connecteur de casque et le haut-parleur intégré.

Headphone Out
Mono/Stereo

Sélectionne le mode de sortie du connecteur de casque : 
monaural (Mono) ou stéréo (Stereo).

Alarm Volume
0 à 7 (4)

Ajuste le volume de l’alarme.

Output Limiter
On/Off

Active/désactive le limiteur de sortie audio.

HDMI Output CH
CH1/CH2 / CH3/CH4

Règle la combinaison des canaux audio sur la sortie HDMI.

Audio

Elément Réglage de sous-éléments Description
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Menu Video

Video

Elément Réglage de sous-éléments Description

Output On/Off
Réglages de sortie 
vidéo

SDI
On/Off

Active/désactive la sortie SDI.

HDMI
On/Off

Active/désactive la sortie HDMI.

Output Format
Réglages du 
format de sortie

SDI Règle la résolution de sortie SDI et HDMI.
Pour de plus amples informations concernant les réglages, 
reportez-vous à « Formats vidéo et signaux de sortie » 
(page 110).

Remarque

Le réglage Output Format ne peut pas être configuré en mode 
Picture Cache Rec. Si celà se produit, désactivez 
temporairement Picture Cache Rec, puis modifiez le réglage.

HDMI

REF

Output Setting
Réglages de mode 
de conversion de 
sortie

HDMI Target Device
Recorder / Monitor

Règle le type de dispositif à entrée HDMI connecté à la sortie 
HDMI.
Recorder :

Sort la même vidéo en SDI1 vers HDMI en mode Cine EI.
Monitor :

Sort la même vidéo en SDI2 vers HDMI en mode Cine EI.

4K/2K à HD Conv.
Edge Crop / Letter Box

Règle le mode de conversion pou la sortie vidéo HD de la 
vidéo 17:9.
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Monitor LUT
Réglages de 
Monitor LUT
Disponible en 
mode Cine EI 
uniquement.

Remarque

Le Monitor LUT 
risque de ne pas 
être réglable 
indépendamment 
pour chaque 
système 
(page 122).

Category
LUT / Look Profile / User 3D 
LUT

Règle le type de Look appliqué au Monitor LUT.
LUT :

Emet une vidéo avec le préréglage appliqué LUT ou User 
LUT.

Look Profile :
Emet une vidéo proche d’un film positif ou d’une vidéo qui 
est adaptée comme gradation de point de couleur de 
commencement, en sélectionnant un numéro Look.

User 3D LUT :
Emet une vidéo avec User 3D LUT appliqué.

Remarque

User 3D LUT ne peut pas être sélectionné si Base Setting 
>Color Space est réglé sur S-Gamut/S-Log2 dans le menu 
System.

LUT Select
P1 : 709(800%)
P2 : HG8009G40
P3 : HG8009G33
P4 : S-Log2
P5 : S-Log3
U1
U2
U3
U4
U5
U6

Sélectionne le type LUT quand Monitor LUT >Category est 
réglé sur LUT.
709(800%) :

Signal avec courbe de base ITU-R709 avec gamme 
dynamique étendue jusqu’à 800%.

HG8009G40 :
Signal utilisant HyperGamma avec gamme dynamique de 
800%, limite blanche de 109% et une carte grise de 18% à 
40% de sortie vidéo.

HG8009G33 :
Signal utilisant HyperGamma avec gamme dynamique de 
800%, limite blanche de 109% et carte grise de 18% à 33% 
de sortie vidéo.

S-Log2 :
Signal de journalisation avec gamme dynamique de 1300% 
qui prend en compte la visibilité sur un moniteur vidéo 
avec prise de séquence en post production.
(Activé lorsque Base Setting >Color Space dans le menu 
System est réglé sur SGamut/SLog2)

S-Log3 :
Signal de journalisation avec gamme dynamique de 1300% 
qui reproduit des caractéristiques de film, proche de la 
courbe Cineon Log.
(Activé lorsque Base Setting >Color Space dans le menu 
System est réglé sur S-Gamut3.Cine/SLog3 ou S-Gamut3/
SLog3)

U1 à U6 :
Signaux User LUT importés d’une carte SD.

Remarque

Sélectionnez F55/F5 comme format de sortie lors de la 
création d’un LUT grâce à RAW Viewer.
Créez et déployez les fichiers LUT dans le dossier suivant sur 
une carte SD.
\PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Look Profile Select
1 : LC-709
2 : LC-709typeA
3 : SLog2-709
4 : Cine+709

Sélectionne le type de profil Look, quand Monitor LUT 
>Category est réglé sur Look Profile.

Video
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User 3D LUT Select
User 3D-1
User 3D-2
User 3D-3
User 3D-4

Sélectionne le type d’utilisateur 3D LUT.

SDI1 & Internal Rec
MLUT On / MLUT Off

Sélectionne l’application ou non de Monitor LUT à la sortie 
vidéo SDI OUT1 et à la vidéo enregistrée sur des cartes 
mémoire XQD.

SDI2
MLUT On / MLUT Off

Sélectionne l’application ou non de Monitor LUT à la sortie 
vidéo SDI OUT2.

HDMI
MLUT On / MLUT Off

Indique si Monitor LUT est appliqué ou non à la sortie vidéo 
HDMI (page 122).

Viseur
MLUT On / MLUT Off

Sélectionne l’application ou non de Monitor LUT à la sortie 
vidéo du viseur.

Output Display
Réglages du signal 
de sortie

SDI2
On/Off

Sélectionne la superposition ou non des menus et des états sur 
le signal de sortie SDI et le signal de sortie HDMI.

HDMI
On/Off

Video

Elément Réglage de sous-éléments Description
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Menu VF

VF

Elément Réglage de sous-éléments Description

VF Setting
Réglages du viseur

Brightness
–99 à +99 (±0)

Permet d’ajuster la luminosité de l’image du viseur.

Color Mode
Color/B&W

Sélectionne le mode d’affichage du viseur dans le mode E-E/
enregistrement.

Peaking
Réglages du 
contour

Setting
On/Off

Active/désactive la fonction de réglage du contour.

Peaking Type
Normal / Color

Sélectionne le type de réglage du contour.
Normal : réglage du contour normal
Color : réglage de contour de couleur

Frequency
Normal/High

Sélectionne la fréquence de réglage du contour.

Normal Peaking Level
0 à 99 (50)

Règle le niveau normal de réglage du contour.

Color
B&W / Red / Yellow / Blue

Sélectionne la couleur du signal de réglage du contour de 
couleur.

Color Peaking Level
0 à 99 (50)

Règle le niveau de réglage du contour de couleur.

Zebra
Réglages du motif 
de zébrures

Setting
On/Off

Active/désactive la fonction des zébrures.

Zebra Select
1 / 2 / Both

Sélectionne le type de motif de zébrures (Zebra 1, Zebra 2, 
Both).

Zebra1 Level
0% à 107% (70%)

Définit le niveau d’affichage de Zebra 1.

Zebra1 Aperture Level
1% à 20% (10%)

Définit le niveau d’ouverture de Zebra 1.

Zebra2 Level
0% à 109% (100%)

Définit le niveau d’affichage de Zebra 2.
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Marker
Réglages 
d’affichage de 
repère

Setting
On/Off

Active/désactive l’affichage de tous les repères.

Color
White / Yellow / Cyan / Green / 
Magenta / Red / Blue

Sélectionne la couleur du signal de repère.

Center Marker
1 / 2 / 3 / 4 / Off

Active/désactive le repère central.

Safety Zone
On/Off

Active/désactive le repère de la zone de sécurité.

Safety Area
80% / 90% / 92.5% / 95%

Sélectionne la taille du repère de la zone de sécurité (en tant 
que pourcentage de la taille totale de l’écran).

Aspect Marker
Line/Mask/Off

Sélectionne le type de marqueur de format.

Aspect Mask
0 à 15 (12)

Règle le niveau du signal vidéo en dehors du marqueur, par 
rapport au signal à l’intérieur du marqueur, en tant que 
pourcentage.

Aspect Safety Zone
On/Off

Active/désactive le repère de la zone de sécurité.

Aspect Safety Area
80% / 90% / 92.5% / 95%

Sélectionne la taille du repère de la zone de sécurité de format 
(en tant que pourcentage de la taille totale de l’écran).

Aspect Select
4:3 / 1.66:1 / 
1.85:1 / 2.35:1 / 2.4:1

Règle le mode en affichant le marqueur de format.

User Box
On/Off

Active/désactive l’affichage du curseur.

User Box Width
3 à 479 (240)

Règle la largeur du curseur (distance du centre aux bords 
gauche et droit).

User Box Height
3 à 269 (135)

Règle la hauteur du curseur (distance du centre aux bords haut 
et bas).

User Box H Position
–476 à +476 (0)

Règle la position horizontale du centre du curseur.

User Box V Position
–266 à +266 (0)

Règle la position verticale du centre du curseur.

100% Marker
On/Off

Active/désactive le repère 100%.

Guide Frame
On/Off

Active/désactive l’affichage du cadre guide.

VF
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Display On/Off
Réglages de 
l’élément 
d’affichage

Setting
On/Off

Sélectionne les éléments à afficher dans le viseur.

Shutter Setting
On/Off

ND Filter Position
On/Off

Gain Setting
On/Off

Rec /Play Status
On/Off

HXR-IFR5 Rec Control
On/Off

Color Temp.
On/Off

Frame Rate / Interval
On/Off

Battery Remain
On/Off

Timecode
On/Off

Audio Manual
On/Off

Audio Level Meter
On/Off

Media Status
On/Off

Focus Position
Meter/Feet/Off

Iris Position
On/Off

Zoom Position
Number / Bar / Off

SteadyShot
On/Off

Focus Mode
On/Off

Focus Area Indicator
On/Off

Focus Area Ind. (Push AF)
On / Off

Focus Indicator
On/Off

Auto Shutter
On/Off

AGC
On/Off

Auto Iris
On/Off

VF
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AE Mode
On/Off

Auto Exposure Level
On/Off

White Balance Mode
On/Off

SDI/HDMI Rec Control
On/Off

Rec Format
On/Off

Gamma
On/Off

Timecode Lock
On/Off

Wi-Fi Condition
On/Off

Clip Name
On/Off

Focus Assist Indicator
On/Off

Focus Area Marker
On/Off

Video Level Warning
On/Off

Clip Number
On/Off

GPS
On/Off

Level Gauge
On/Off

Lens Info
Meter/Feet/Off

Notice Message
On/Off

Video Signal 
Monitor
Réglages du 
moniteur de signal 
vidéo (page 52)

Setting
Off / Waveform / Vector / 
Histogram

Règle le type de moniteur de signal vidéo.

Remarque

Non affiché lorsque Display On/Off >Setting est réglé sur Off.

Source
Mode Cine EI avec la résolution 
de sortie vidéo 2K ou inférieure :

SDI1 & Internal Rec / SDI2 
En mode Custom ou Cine EI 
avec la résolution de sortie 
vidéo supérieure à 2K :

Internal Rec

Règle la source de mesure du moniteur de signal vidéo.

VF
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Menu TC/UB

TC/UB

Elément Réglage de sous-éléments Description

Timecode
Réglages du code 
temporel

Mode
Preset / Regen / Clock

Règle le mode de fonctionnement du code temporel.
Preset :

Commence à fonctionner à partir d’une valeur préréglée.
Regen :

Commence à fonctionner à partir du code temporel de la fin 
du plan précédent.

Clock :
Utilise l’horloge interne comme code temporel.

Run
Rec Run / Free Run

Rec Run : fonctionne uniquement en cours d’enregistrement.
Free Run : fonctionne en permanence, quelle que soit 
l’opération réalisée par le caméscope.

Setting Règle le code temporel sur une valeur arbitraire.
SET : règle la valeur.

Reset
Execute/Cancel

Réinitialise le code temporel sur 00:00:00:00.
Execute : réinitialise le code temporel

TC Format
DF/NDF

Règle le format de code temporel.
DF : mode temps réel
NDF : mode temps non réel

TC Display
Réglages 
d’affichage des 
données 
temporelles

Display Select
Timecode / Users Bit / 
Duration

Commute l’affichage des données temporelles.

Users Bit
Paramètres liés 
aux bits 
d’utilisateur.

Mode
Fix/Time

Règle le mode de bit d’utilisateur.
Fix : utilise une valeur fixe arbitraire dans les bits d’utilisateur.
Time : utilise l’heure actuelle dans les bits d’utilisateur.

Setting Règle les bits d’utilisateur sur une valeur arbitraire.

HDMI TC Out Setting
On/Off

Règle s’il faut envoyer le code temporel vers des dispositifs à 
d’autres fins à l’aide de la sortie HDMI. 
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Menu Recording

Recording

Elément Réglage de sous-éléments Description

S&Q Motion
Réglages du mode 
ralenti et accéléré 
(page 47)

Setting
On/Off

Active/désactive le mode ralenti et accéléré.
Lorsqu’il est activé, les fonctions suivantes sont désactivées.
• Auto Iris
• Auto focus 

High Frame Rate Mode
Off / Full Scan / Center Scan

Permet une imagerie à une vitesse supérieure à 60P.
Off :

L’imagerie à une vitesse supérieure à 60P est désactivée.
Full Scan :

Imagerie à grande vitesse d’un angle de vue de taille 
Super 35mm.

Center Scan :
Imagerie à grande vitesse de la moitié d’un angle de vue de 
taille Super 35mm au centre de l’image.

Remarque

Ce réglage ne peut pas être défini conformément à Imager 
Scan Mode lorsque Imager Scan Mode est réglé sur 2K Full 
ou 2K Center.

Frame Rate
Jusqu’à 240 ips

Règle la fréquence d’images pour la prise de vue au ralenti et 
accéléré.

Remarque

La valeur initiale varie en fonction des réglages Codec, 
Country, Video Format et RAW Output Format.
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Interval Rec
Réglages Interval 
Rec (page 48) 

Setting
On / Off

Active/désactive le mode d’enregistrement par intervalles. (Le 
réglage de ce mode sur On met tous les autres mode spéciaux 
sur Off.)

Interval Time
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 
10 / 15 / 20 / 30 / 40 / 50 (sec) 
1 / 2 / 3 / 4 / 5 / 6 / 7 / 8 / 9 / 10 / 
15 / 20 / 30 / 40 / 50 / (min) 1 / 
2 / 3 / 4 / 6 / 12 / 24 (heure)

Règle l’intervalle entre les enregistrement en mode 
d’enregistrement Interval Rec (lorque Interval Rec est réglé 
sur On).

Number of Frames
1frame / 2frames / 3frames / 
6frames / 9frames / 12frames

Règle l’e nombre d’images à enregistrer par prise en mode 
d’enregistrement Interval Rec (lorque Interval Rec est réglé 
sur On).
Les réglages disponibles varient en fonction de la fréquence 
d’images du format vidéo sélectionné.
50P/59.94P :

2frames / 6frames / 12frames
23.98P / 25P / 29.97P / 50i / 59.94i :

1frame / 3frames / 6frames / 9frames

Pre-Lighting
Disponible uniquement lors de 
l’utilisation du HVL-LBPC 
(optionnel).

Off / 2sec / 5sec / 10sec

Règle le nombre de secondes après lesquelles la lampe vidéo 
s’allume avant le démarrage de l’enregistrement en mode 
d’enregistrement Interval Rec.

Picture Cache 
Rec
Réglages du mode 
d’enregistrement 
de cache d’images 
(page 49)

Setting
On/Off

Active/désactive la fonction d’enregistrement de cache 
d’image.

Cache Rec Time
0-2sec / 2-4sec / 4-6sec / 
6-8sec / 8-10sec / 10-12sec / 
12-14sec / 13-15sec

Règle le temps d’enregistrement de cache d’image, quand la 
fonction Picture Cache Rec est réglée sur On.

Simul Rec
Réglages 
d’enregistrement 
simultané 
(page 39)

Setting
On/Off

Active/désactive la fonction d’enregistrement simultané et 
définit le support de destination d’enregistrement.

Rec Button Set
« Rec Button [SlotA SlotB] 
Handle Rec Button [SlotA 
SlotB] » / « Rec Button 
[SlotA] Handle Rec Button 
[SlotB] » / « Rec Button 
[SlotB] Handle Rec Button 
[SlotA] »

Assigne les touches d’enregistrement utilisées pour contrôler 
chaque support d’enregistrement.

SDI/HDMI Rec 
Control
Réglages de 
contrôle 
d’enregistrement 
SDI/HDMI

Setting
On/Off

Active/désactive le contrôle de démarrage/d’arrêt 
d’enregistrement pour un dispositif externe raccordé, à l’aide 
des sorties SDI/HDMI. 
Lorsque différentes touches sont attribuées en utilisant Rec 
Button Set, le signal de contrôle de l’enregistrement suit l’état 
d’enregistrement de la fente A.

Remarque

Lorsqu’il est réglé sur On, démarre/arrête l’enregistrement sur 
un périphérique externe connecté, même si aucune carte XQD 
n’est insérée.

Recording

Elément Réglage de sous-éléments Description
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Menu Thumbnail

Thumbnail

Elément Réglage de sous-éléments Description

Display Clip 
Properties
Afficher l’écran de 
propriétés de plans

Affiche l’écran de propriétés de plans.

Set Index 
Picture
Réglages d’image 
d’index de plan

Règle l’image d’index d’un plan.

Thumbnail 
View
Réglages d’écran 
miniature

Essence Mark Thumbnail
All / Rec Start / Shot Mark1 / 
Shot Mark2 / Shot Mark3 / 
Shot Mark4 / Shot Mark5 / 
Shot Mark6 / Shot Mark7 / 
Shot Mark8 / Shot Mark9 / 
Shot Mark0

Affiche des miniatures d’images marquées de repères.

Clip Thumbnail Affiche des miniatures de plans enregistrés.

Set Shot Mark
Réglages de repère 
de prise de vue

Add Shot Mark1 Ajoute le repère Shot Mark1.

Delete Shot Mark1 Supprime le repère Shot Mark1.

Add Shot Mark2 Ajoute le repère Shot Mark2.

Delete Shot Mark2 Supprime le repère Shot Mark2.

Set Clip Flag
Réglages de 
balises de plans

Add OK Ajoute une balise OK.

Add NG Ajoute une balise NG.

Add KEEP Ajoute une balise KEEP.

Delete Clip Flag Supprime toutes les balises.

Lock/Unlock
Clip
Protection de plan

Select Clip Sélectionne et verrouille/déverrouille un plan.

Lock All Clips Verrouille tous les plans.

Unlock All Clips Déverrouille tous les plans.

Delete Clip
Supprime des 
plans

Select Clip Supprime le plan sélectionné.

All Clips Supprime tous les plans affichés.

Filter Clips
Réglages 
d’affichage du 
plan filtré

OK Affiche uniquement les plans comportant une balise OK.

NG Affiche uniquement les plans comportant une balise NG.

KEEP Affiche uniquement les plans comportant une balise KEEP.

None Affiche uniquement les plans ne comportant pas de balise.

Customize 
View
Réglages d’écran 
miniature

Thumbnail Caption
Date Time / Time Code / 
Duration / Sequential Number

Commute l’information affichée sous les miniatures.



93

Menu Media

Media

Elément Réglage de sous-éléments Description

Update Media
Met à jour les 
cartes mémoire

Media(A)
Execute/Cancel

Met à jour le fichier de gestion sur la carte mémoire XQD 
dans la fente A.
Execute : met à jour une carte

Media(B)
Execute/Cancel

Met à jour le fichier de gestion sur la carte mémoire XQD 
dans la fente B.
Execute : met à jour une carte

Format Media
Formate (initialise) 
les cartes mémoire

Media(A)
Execute/Cancel

Initialise la carte mémoire XQD dans la fente A.
Execute : initialise une carte

Media(B)
Execute/Cancel

Initialise la carte mémoire XQD dans la fente B.
Execute : initialise une carte

SD Card
Execute/Cancel

Initialise la carte UTILITY SD.
Execute : initialise une carte

Clip
Réglages de noms 
de plans

Auto Naming
Cam ID + Reel# / Title

Règle la méthode pour nommer les plans.
Cam ID + Reel# :

Camera ID + Reel Number + Shot Number + Date + 
chaîne aléatoire

Title :
Chaîne définie à l’aide du préfixe de titre + numéro de plan

Remarque

Lorsque Simul Rec est activé, Cam ID + Reel# ne peut pas 
être configuré.

Camera ID
A à Z

Règle l’ID de caméra quand Auto Naming est réglé sur Cam 
ID + Reel#.

Reel Number
001 à 999

Règle la partie numérique de Reel Number quand Auto 
Naming est réglé sur Cam ID + Reel#.

Camera Position
C / L / R

Règle le préfixe de Shot Number quand Auto Naming est réglé 
sur Cam ID + Reel#.

Title Prefix Règle la portion de titre du nom de plan quand Auto Naming 
est réglé sur Title.
(La valeur initiale est une identification spécifique à un 
modèle, comportant les trois derniers chiffres du numéro de 
série.)
(La valeur est saisie à l’aide de l’écran de saisie de caractères 
(page 63).)

Number Set
0001 à 9999

Règle la portion numérique du nom de plan quand Auto 
Naming est réglé sur Title.
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Menu File

File

Elément Réglage de sous-éléments Description

All File
Réglages liés aux 
fichiers ALL.

Load SD Card
Execute/Cancel

Charge un fichier ALL.
Execute : charge un fichier

Save SD Card
Execute/Cancel

Sauvegarde un fichier ALL.
Execute : sauvegarde un fichier

File ID Attribue un nom au fichier.

Scene File
Réglages du 
fichier de scène

Recall Internal Memory
Execute/Cancel

Charge un fichier de scène depuis la mémoire interne.
Execute : charge un fichier

Store Internal Memory
Execute/Cancel

Sauvegarde un fichier de scène dans la mémoire interne.
Execute : sauvegarde un fichier

Load SD Card
Execute/Cancel

Charge un fichier de scène depuis une carte SD.
Execute : charge un fichier

Save SD Card
Execute/Cancel

Sauvegarde un fichier de scène sur une carte SD.
Execute : sauvegarde un fichier

File ID Attribue un nom au fichier.

Scene White Data
On/Off

Règle l’application ou non des données d’équilibre des blancs 
lors du chargement de fichiers de scène.

User Menu 
Item
Réglages 
d’éléments du 
menu User

Load SD Card
Execute/Cancel

Charge les réglages du menu User sur une carte SD dans une 
mémoire interne.
Execute : charge les réglages

Save SD Card
Execute/Cancel

Sauvegarde les réglages de menu User sur une carte SD.
Execute : sauvegarde les réglages

File ID Affiche l’identification de fichier spécifiée pour le fichier 
chargé à l’aide de Load SD Card. Règle (édite) également 
l’identification de fichier lors de la sauvegarde d’un fichier à 
l’aide de ce menu.

User Gamma
Réglages de 
fichiers gamma 
d’utilisateur

Current Settings Affiche une liste des réglages de fichiers gamma d’utilisateur 
actuels (noms de fichiers).

Load SD Card
Execute/Cancel

Charge les réglages gamma d’utilisateur sur une carte SD dans 
une mémoire interne.
Execute : charge le gamma
Pour utiliser les fichiers gamma utilisateur créés à l’aide de 
CvpFileEditor™ V4.2 avec le caméscope, enregistrez les 
fichiers dans le dossier suivant sur la carte SD.
PRIVATE\SONY\PRO\CAMERA\HD_CAM

Reset
1 / 2 / 3 / 4 / 5 / All
Valeur initiale : 709(800%)

Réinitialise les fichiers gamma d’utilisateur dans une mémoire 
interne aux valeurs par défaut.
1 à 5 : réinitialise le gamma d’utilisateur individuel
All : réinitialise tous les gammas d’utilisateur
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Remarque

Placez les fichiers dans les dossiers suivants sur la carte SD.
ALL files, Scene files, User Menu Item :

PRIVATE\Sony\PRO\CAMERA\PXW-FS7
Fichiers gamma d’utilisateur :

PRIVATE\Sony\PRO\CAMERA\HD_CAM
Fichiers Monitor LUT, fichiers monitor 3D LUT :

PRIVATE\Sony\PRO\CAMERA\PMWF55_F5

Monitor LUT
Réglages de 
fichiers Monitor 
LUT

Current Settings Affiche une liste des réglages actuels de fichiers Monitor LUT 
(noms de fichiers).

Load SD Card
Execute/Cancel

Charge les réglages de Monitor LUT d’une carte SD dans une 
mémoire interne.
Execute : charge les réglages LUT
Enregistrez les fichiers LUT utilisateur générés à l’aide de 
RAW Viewer dans le dossier suivant sur la carte SD.
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Reset
1 / 2 / 3 / 4 / 5 / 6 / All

Réinitialise les données de Monitor LUT dans une mémoire 
interne aux valeurs par défaut.
1 à 6 : réinitialise un Monitor LUT individuel
All : réinitialise tous les Monitor LUT

Monitor 3D 
LUT
Réglages de 
fichiers Monitor 
3D LUT

Current Settings Affiche une liste des réglages actuels de fichiers Monitor 3D 
LUT (noms de fichiers).

Load SD Card
Execute/Cancel

Charge les réglages de Monitor 3D LUT sur une carte SD dans 
une mémoire interne.
Execute : charge les réglages 3D LUT
Vous pouvez importer des fichiers CUBE (*.cube) avec la 
résolution lattice de 17 ou 33 créés à l’aide de Catalyst 
Browse, RAW Viewer ou BMD Da Vinci Resolve*.
* Vérifié avec Resolve V9.0, V10.0 et V11.0.
Si vous créez un fichier CUBE à l’aide de Catalyst Browse ou 
RAW Viewer, effectuez le réglage Source dans Catalyst 
Browse ou le réglage Input dans RAW Viewer sur 
S-Gamut3.Cine/S-Log3.
Réglez Format sur Resolve lors de l’exportation du fichier 
CUBE.
Enregistrez les données 3D LUT créés (fichier 3D LUT 
utilisateur) dans le dossier suivant sur la carte SD.
PRIVATE\SONY\PRO\CAMERA\PMWF55_F5

Remarque

La fonction monitor 3D LUT ne peut pas être utilisée si Base 
Setting >Color Space est réglé sur S-Gamut/S-Log2 dans le 
menu System du caméscope.

Reset
1 / 2 / 3 / 4 / All

Réinitialise les données de Monitor 3D LUT dans une 
mémoire interne aux valeurs par défaut.
1 à 4 : réinitialise un Monitor 3D LUT individuel
All : réinitialise tous les Monitor 3D LUT

Lens File
Réglages du 
fichier d’objectif

White Offset R
–99 à +99 (±0)

Règle la valeur de correction du canal R de décalage 
d’équilibre des blancs dans le fichier d’objectif.

White Offset B
–99 à +99 (±0)

Règle la valeur de correction du canal B de décalage 
d’équilibre des blancs dans le fichier d’objectif.

File

Elément Réglage de sous-éléments Description



96

Menu System

System

Elément Réglage de sous-éléments Description

Base Setting
Réglages de base

Shooting Mode
Custom / Cine EI

Règle le mode de prise de vue.

Color Space
S-Gamut/SLog2 / 
S-Gamut3.Cine/SLog3 / 
S-Gamut3/SLog3 / Matrix

Règle l’espace de couleur.

Imager Scan Mode
Normal / 2K Full / 2K Center

Règle le mode de numérisation pour les informations de 
capture avec le capteur d’image (page 26).

Codec
Réglages de codec

Select
RAW / RAW & XAVC-I / RAW 
& XAVC-L / RAW & MPEG 
HD 422 / XAVC-I / XAVC-L / 
MPEG HD 422 / ProRes 422 
HQ / ProRes 422

Règle le mode d’enregistrement/de lecture.

Remarques

• RAW / RAW & XAVC-I / RAW & XAVC-L / RAW & 
MPEG HD 422 sont disponibles lorsqu’un XDCA-FS7 est 
connecté et Base Setting >Shooting Mode est réglé sur Cine 
EI.

• ProRes 422 HQ / ProRes 422 sont disponibles uniquement 
lorsqu’un XDCA-FS7 est connecté.
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Rec Format
Réglages du 
format 
d’enregistrement

Video Format

• Pour les systèmes NTSC :
Lorsque Codec >Select est réglé 
sur XAVC-I :

4096×2160 59.94P
4096×2160 29.97P
4096×2160 24.00P
4096×2160 23.98P
3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P
1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Lorsque Codec >Select est réglé 
sur XAVC-L :

3840×2160 59.94P
3840×2160 29.97P
3840×2160 23.98P
1920×1080 59.94P 50
1920×1080 59.94P 35
1920×1080 59.94i 50
1920×1080 59.94i 35
1920×1080 59.94i 25
1920×1080 29.97P 50
1920×1080 29.97P 35
1920×1080 23.98P 50
1920×1080 23.98P 35

Lorsque Codec >Select est réglé 
sur MPEG HD422 :

1920×1080 59.94i 50
1920×1080 29.97P 50
1920×1080 23.98P 50
1280×720 59.94P 50
1280×720 29.97P 50
1280×720 23.98P 50

Lorsque Codec >Select est réglé 
sur ProRes 422 HQ ou ProRes 
422 :

1920×1080 59.94i
1920×1080 29.97P
1920×1080 23.98P

Règle le format d’enregistrement.

• Pour les systèmes PAL :
Lorsque Codec >Select est réglé sur XAVC-I :

4096×2160 50P
4096×2160 25P
3840×2160 50P
3840×2160 25P
1920×1080 50P
1920×1080 50i
1920×1080 25P

Lorsque Codec >Select est réglé sur XAVC-L :
3840×2160 50P
3840×2160 25P
1920×1080 50P 50
1920×1080 50P 35
1920×1080 50i 50
1920×1080 50i 35
1920×1080 50i 25
1920×1080 25P 50
1920×1080 25P 35

Lorsque Codec >Select est réglé sur MPEG HD422 :
1920×1080 50i 50
1920×1080 25P 50
1280×720 50P 50
1280×720 25P 50

Lorsque Codec >Select est réglé sur ProRes 422 HQ ou 
ProRes 422 :

1920×1080 50i
1920×1080 25P

Remarques

• « --- » est grisé lorsque Codec >Select est réglé sur RAW.
• Les valeurs fixées sont grisées lorsque Codec >Select est 

réglé sur RAW & XAVC-I, RAW & XAVC-L, ou RAW & 
MPEG HD 422.

• Le format d’enregistrement ne peut pas être réglé sur 
4096×2160 ou 3840×2160 lorsque Imager Scan Mode est 
réglé sur 2K Full ou 2K Center.

System

Elément Réglage de sous-éléments Description
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RAW Output Format

• Pour les systèmes NTSC :
Lorsque Codec >Select est réglé 
sur un élément qui comprend RAW 
et Imager Scan Mode est réglé sur 
Normal :

4096×2160 59.94P
4096×2160 29.97P
4096×2160 23.98P

Lorsque Codec >Select est réglé 
sur un élément qui comprend RAW 
et Imager Scan Mode est réglé sur 
2K Full or 2K Center :

2048×1080 59.94P
2048×1080 29.97P
2048×1080 23.98P

Règle le format d’enregistrement pour un enregistreur RAW 
externe.
• Pour les systèmes PAL :
Lorsque Codec >Select est réglé sur un élément qui comprend 
RAW et le mode Imager Scan est réglé sur Normal :

4096×2160 50P
4096×2160 25P

Lorsque Codec >Select est réglé sur un élément qui comprend 
RAW et Imager Scan Mode est réglé sur 2K Full or 2K 
Center :

2048×1080 50P
2048×1080 25P

Genlock
Réglages du 
verrouillage de la 
synchronisation

Reference
Internal / External(HD) / 
External(SD)

Affiche l’état de verrouillage de la synchronisation. Affiche le 
type de signal si le verrouillage de la synchronisation est 
appliqué.
Internal : verrouillage de la synchronisation externe non 
appliqué.
External(HD) : verrouillage de la synchronisation au signal HD.
External(SD) : verrouillage de la synchronisation au signal SD.

Assignable 
Button
Réglages de 
touches 
personnalisables

<1> à <6>
Off / Marker / Zebra / Peaking / 
Video Signal Monitor / Focus 
Magnifier x4/x8 / Focus Magnifier 
x4 / Focus Magnifier x8 / Focus 
Area / Focus Area (Push AF) / VF 
Mode / IRIS / Push Auto Iris / 
AGC / Push AGC / SHUTTER / 
Auto Exposure Level / Spotlight / 
Backlight / ATW / ATW Hold / 
Push AF/Focus Hold / SteadyShot 
/ Color Bars / User Menu / Rec 
Lamp / S&Q Motion / Picture 
Cache Rec / Rec Review / 
Thumbnail / Shot Mark1 / Shot 
Mark2 / Clip Flag OK / Clip Flag 
NG / Clip Flag Keep / 
DURATION/TC/U-BIT / High/
Low Key

Attribue des fonctions aux touches personnalisables.
Marker :

Active/désactive la fonction de marqueur.
Zebra :

Active/désactive la fonction des zébrures.
Peaking :

Active/désactive la fonction de réglage du contour.
Video Signal Monitor :

Commute le moniteur de signal vidéo (tel que le moniteur 
de forme d’onde).

Focus Magnifier x4/x8 :
Focus Magnifier x4 :
Focus Magnifier x8 :

Active/désactive la fonction d’agrandissement de la mise 
au point.

Focus Area :
Focus Area (Push AF) :

Ouvre l’écran de réglage du Focus Area.
VF Mode :

Commute l’affichage du viseur entre couleur et noir et 
blanc.

IRIS :
Commute la fonction de diaphragme entre automatique et 
manuel.

Push Auto Iris :
Active la fonction de diaphragme automatique pendant 
l’activation de la touche.

AGC :
Active/désactive la fonction AGC.

System

Elément Réglage de sous-éléments Description
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Push AGC :
Active la fonction AGC pendant l’activation de la touche.

SHUTTER :
Commute la fonction d’obturateur entre automatique et 
manuel.

Auto Exposure Level :
Ouvre l’écran Auto Exposure Level.

Spotlight :
Bascule entre les fonctions Spotlight et Standard.

Backlight :
Bascule entre les fonctions Backlight et Standard.

ATW :
Active/désactive la fonction ATW.

ATW Hold :
Met la fonction ATW en pause.

Push AF/Focus Hold :
Exécute la fonction Push Auto Focus ou la fonction Focus 
Hold.

SteadyShot :
Commute entre Active SteadyShot, SteadyShot, et Off.

Color Bars :
Active/désactive les barres de couleur.

User Menu :
Ouvre/ferme le User Menu.

Rec Lamp :
Allume/éteint l’indicateur d’enregistrement.

S&Q Motion :
Active/désactive le mode ralenti et accéléré.
Règle la fréquence d’images d’enregistrement si elle est 
maintenue appuyée.

Picture Cache Rec :
Active/désactive le mode d’enregistrement de cache 
d’image.

Rec Review :
Active/désactive la fonction Rec Review.

Thumbnail :
Ouvre/ferme l’écran de miniatures.

Shot Mark1 :
Exécute la fonction Add Shot Mark1.

Shot Mark2 :
Exécute la fonction Add Shot Mark2.

Clip Flag OK :
Exécute la fonction Add OK.
Appuyez deux fois pour exécuter Delete Clip Flag.

Clip Flag NG :
Exécute la fonction Add NG.
Appuyez deux fois pour exécuter Delete Clip Flag.

System

Elément Réglage de sous-éléments Description
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Clip Flag Keep :
Exécute la fonction Add KEEP.
Appuyez deux fois pour exécuter Delete Clip Flag.

DURATION/TC/U-BIT :
Commute entre Time Code, Users Bit et Duration.

High/Low Key :
Commute entre High Key (affichage pour vérifier les 
blancs éclatants), Low Key (affichage pour vérifier les 
zones sous-exposées) et Off (affichage normal) dans cet 
ordre.
Applicable pour les systèmes ou le Monitor LUT est réglé 
sur On.

Assignable 
Dial
Réglages de 
molettes 
personnalisables

Assignable Dial
Off / ISO/Gain/EI / IRIS / 
Focus / Audio Input Level

Assigne des fonctions à la molette personnalisable sur la 
télécommande à poignée.
ISO/Gain/EI : ajuste le gain ou EI.
IRIS : ajuste le diaphragme.
Focus : ajuste la mise au point.
Audio Input Level : ajuste le niveau audio.

IRIS Dial
(Mêmes réglages que pour 
Assignable Dial)

Assigne des fonctions à la molette IRIS.

Assignable Dial Direction
Normal / Opposite

Règle le sens de rotation de la molette personnalisable sur la 
télécommande à poignée.
Normal : tourne vers l’avant.
Opposite : tourne dans le sens opposé.

IRIS Dial Direction
Normal / Opposite

Règle la direction de rotation de la molette IRIS.
Normal : tourne vers l’avant.
Opposite : tourne dans le sens opposé.

Rec Lamp
Réglages 
d’indicateur 
d’enregistrement

Rec Lamp
On/Off

Allume/éteint l’indicateur d’enregistrement.

Fan Control
Réglages de mode 
de commande du 
ventilateur

Setting
Auto / Minimum / Off in Rec

Règle le mode de commande du ventilateur du caméscope.

Remarque

Même lorsque « Off in Rec » est sélectionné, le ventilateur 
fonctionnera si la température interne du caméscope dépasse 
une certaine valeur.

HOLD Switch 
Setting
Réglages du 
commutateur Hold

with Rec Button
On/Off

Règle le verrouillage ou non de la touche d’enregistrement.

with Hand Grip Remote
On/Off

Règle s’il faut verrouiller le fonctionnement de la 
télécommande à poignée.

System
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Lens
Réglages 
d’objectif

Zoom Ring Direction
Left(W)/Right(T) / Right(W)/
Left(T)

Règle la direction du fonctionnement de la bague de zoom.

Remarque

Activé uniquement lors de l’utilisation d’un objectif à monture 
E prenant en charge le changement de direction de la bague de 
zoom.

Distortion Comp.
Auto / Off

Active/désactive la compensation automatique de distorsion.

Remarques

• Non disponible en mode d’enregistrement de cache d’image 
ou pendant l’enregistrement.

• La compensation de distorsion n’est pas appliquée pendant 
l’enregistrement 4K ou QFHD.

• Lorsque « Auto » est sélectionné, il y a certaines restrictions 
pour le moniteur LUT (page 122).

Language
Réglages de 
langue

Select Règle la langue d’affichage.
SET : règle la langue.

Clock Set
Réglages de 
l’horloge interne

Time Zone
UTC 12:00 Kwajalein à UTC 
+14:00

Règle le décalage horaire par rapport au temps universel, par 
incréments de 30 minutes.

Date Mode
YYMMDD/MMDDYY/
DDMMYY

Sélectionne le format d’affichage pour les dates.
YYMMDD : année, mois, jour
MMDDYY : mois, année, jour
DDMMYY : jour, mois, année

12H/24H
12H/24H

Sélectionne le format d’affichage de l’horloge.
12H : mode 12 heures
24H : mode 24 heures

Date Règle la date actuelle.
SET : règle la valeur.

Time Règle l’heure actuelle.
SET : règle la valeur.

Country
Réglages de région

NTSC/PAL Area
NTSC Area / PAL Area

Le réglage par défaut dépend du 
pays/de la région d’achat.

Règle la région d’utilisation.

Hours Meter
Réglages du 
compteur horaire

Hours (System) Affiche les heures d’utilisation cumulées (ne peut pas être 
réinitialisé).

Hours(Reset) Affiche les heures d’utilisation cumulées (peut être 
réinitialisé).

Reset
Execute/Cancel

Réinitialise l’affichage de Hours (Reset) à 0.
Execute : réinitialisation

Basic 
Authentication
Réglages 
d’authentification 
de réseau de base

User Name 
(admin)

Règle le nom d’utilisateur souhaité, composé d’1 à 16 
caractères.
SET : règle la valeur.

Password
(pxw-fs7)

Règle un mot de passe, composé d’1 à 16 caractères.
SET : règle la valeur.

System

Elément Réglage de sous-éléments Description
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Wi-Fi
Réglages de 
connexion par 
LAN sans fil

Wi-Fi
Enable/Disable

Permet d’activer (Enable) ou de désactiver (Disable) la 
connexion Wi-Fi.

SSID & Password Affiche le SSID et le mot de passe.

Wi-Fi Direct Connection
Execute/Cancel

Lance une connexion au réseau « Wi-Fi Direct ».
Execute : connecte

Client Affiche des informations concernant le dispositif client 
connecté (le nom du modèle et l’adresse MAC).

IP Address
192.168.1.1

Affiche l’adresse IP du caméscope.

Remarque

Ne s’affiche pas lors de l’utilisation du CBK-WA100.

Subnet Mask
255.255.0.0

Affiche le masque de sous-réseau.

Remarque

Ne s’affiche pas lors de l’utilisation du CBK-WA100.

MAC Address Affiche l’adresse MAC du module Wi-Fi raccordé au 
caméscope.

Regenerate Password
Execute/Cancel

Crée un nouveau mot de passe.
Execute : défilement

GPS
Réglages GPS

GPS
On/Off

Active/désactive la fonction GPS.

Remarque

Le module GPS est intégré à la poignée.

IR Remote
Réglages de 
télécommande

Setting
On/Off

Active/désactive la commande à partir de la télécommande 
infrarouge fournie.

Camera 
Battery Alarm
Réglages d’alarme 
de basse tension de 
batterie

Low BATT
5% / 10% / 15% / ··· / 45% / 
50%

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de basse tension de batterie (par 
incréments de 5 %).

BATT Empty
3% à 7%

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de batterie vide.

Camera DC IN 
Alarm
Réglages d’alarme 
de tension en 
entrée

DC Low Voltage1
11.5 V à 17.0 V

Règle la tension nécessaire pour déclencher l’affichage d’une 
alarme de basse tension en entrée DC IN.

DC Low Voltage2
11.0 V à 14.0 V

Règle la tension nécessaire pour déclencher l’affichage d’une 
alarme de tension insuffisante en entrée DC IN.

System

Elément Réglage de sous-éléments Description
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Ext. Unit 
Battery Alarm
Réglages de la 
batterie de XDCA-
FS7

Near End:Info Battery
5% à 100%

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de basse tension de batterie Info-
Lithium (par incréments de 5 %).

End:Info Battery
0% à 5%

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de batterie Info-Lithium vide et pour 
arrêter l’accès au support.

Near End:Sony Battery
11.5V à 17.0V

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de basse tension de batterie pour une 
batterie autre qu’une batterie Info-Lithium.

End:Sony Battery
11.0V à 11.5V

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de batterie vide pour une batterie 
autre qu’une batterie Info-Lithium et pour arrêter l’accès au 
support.

Near End:Other Battery
11.5V à 17.0V (11.8V)

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de basse tension de batterie pour une 
batterie Anton/Bauer.

End:Other Battery
11.0V à 14.0V

Règle le niveau de batterie devant rester pour déclencher 
l’affichage d’une alarme de batterie vide pour une batterie 
Anton/Bauer et pour arrêter l’accès au support.

Detected Battery Affiche le type de batterie connectée à l’unité XDCA-FS7.
Si une batterie est connectée à l’unité XDCA-FS7, « Info 
Battery », « Sony Battery » ou « Other Battery » s’affiche. Si 
une source CC est connectée, « DC IN » s’affiche.
En cas d’alimentation par batterie ou source CC raccordée au 
caméscope, « --- » s’affiche.

Ext. Unit DC IN 
Alarm
Réglages d’alarme 
de tension en 
entrée de 
XDCA-FS7

DC Low Voltage1
11.5V à 17.0V

Règle la tension nécessaire pour déclencher l’affichage d’une 
alarme de basse tension en entrée DC IN.

DC Low Voltage2
11.0V à 14.0V

Règle la tension nécessaire pour déclencher l’affichage d’une 
alarme de tension insuffisante en entrée DC IN.

All Reset
Réinitialise les 
réglages par défaut

Reset
Execute/Cancel

Réinitialise tous les réglages à leurs valeurs par défaut.
Execute : réinitialisation

APR
Exécute l’APR

APR
Execute/Cancel

Exécute l’APR (restauration automatique des pixels) pour 
l’ajustement automatique du capteur d’images.
Execute : défilement

Remarque

Fixez toujours le capuchon de l’objectif avant d’exécuter 
l’APR.

Camera Config
Réglages de sortie 
par conversion 
descendante

HD/2K Modulation
High / Low

Règle la bande passante de sortie de conversion descendante 
pour la conversion vers HD et 2K

System

Elément Réglage de sous-éléments Description
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Version
Affiche la version

Number
x.xx

Affiche la version du logiciel du caméscope.

Version Up
Execute/Cancel

Met le caméscope à niveau.*
Execute : défilement
* La mise à niveau met le logiciel du caméscope à jour.

Ext. Unit Version Number
x.xx

Affiche la version du logiciel de l’unité XDCA-FS7.

Ext. Unit Version Up
Execute/Cancel

Met l’unité XDCA-FS7 à niveau.*
Execute : défilement
* La mise à niveau met le logiciel de l’unité XDCA-FS7 à 

jour.

System

Elément Réglage de sous-éléments Description
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Pour afficher les images enregistrées/lues sur un 
moniteur externe, sélectionnez le signal de sortie 
du caméscope et utilisez un câble approprié pour 
le moniteur à raccorder.
Vous pouvez également raccorder des dispositifs 
d’enregistrement, tels qu’un magnétoscope, et 
enregistrer le signal de sortie depuis le 
caméscope.
Vous pouvez afficher les mêmes informations qui 
sont visibles dans le viseur, telles que les 
informations d’état et les menus, sur un moniteur 
externe. Réglez Output Display (page 84) dans le 
menu Video sur « On » pour le type de signal à 
émettre au moniteur correspondant.

Connecteur SDI OUT (de type BNC)
Activez/désactivez la sortie et réglez le format de 
sortie en utilisant le menu Video (page 82).
Utilisez un câble coaxial de 75 Ω disponible dans 
le commerce pour le branchement.

Remarque

Vérifiez que le branchement entre le caméscope et le 
dispositif externe est mis à la terre avant d’allumer les 
dispositifs.
(Il est recommandé d’allumer le caméscope et le 
dispositif externe après avoir branché le câble coaxial de 
75 Ω.)
Si le dispositif externe doit être raccordé au caméscope 
pendant que la caméscope est allumé, raccordez d’abord 
le câble coaxial de 75 Ω au dispositif externe, puis 
raccordez-le au caméscope.

Pour commencer l’enregistrement sur le 
caméscope et sur le dispositif externe de 
manière simultanée
Lorsque la sortie de signal SDI est activée, réglez 
SDI/HDMI Rec Control (page 91) >Setting dans 
le menu Recording sur « On » pour activer la 
sortie d’un signal de déclenchement REC vers le 
dispositif externe raccordé au connecteur SDI 
OUT. Cela permettra de synchroniser 
l’enregistrement sur le dispositif externe avec le 
caméscope.

Remarques

• Si un dispositif externe raccordé ne prend pas en 
charge le signal de déclenchement REC, le dispositif 
ne peut pas être utilisé.

• Lorsque la touche d’enregistrement START/STOP et 
celle d’enregistrement START/STOP de la poignée 
sont réglées pour commander un support différent, le 
signal de déclenchement REC est émis en fonction de 
l’opération de la fente A.

• Seul le signal de déclenchement REC est émis 
lorsqu’aucun support n’est inséré.

Connecteur HDMI OUT (connecteur de 
type A)
Activez/désactivez la sortie et réglez le format de 
sortie en utilisant le menu Video (page 82).
Utilisez un câble HDMI haute vitesse disponible 
dans le commerce pour le branchement.
Sélectionnez le type dispositif raccordé grâce à 
HDMI Target Device (page 121) dans le menu 
Video.

Connecteur RAW OUT (de type BNC)
Le fait de fixer l’unité d’extension XDCA-FS7 au 
caméscope permet de prendre en charge un 
enregistreur RAW externe, tel que le AXS-R5, à 
raccorder au connecteur RAW OUT du 
XDCA-FS7 (page 34).

Connexion de dispositif externe

Connexion des moniteurs externes et des dispositifs 
d’enregistrement
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Pendant une prise de vue avec plusieurs 
caméscopes, ces derniers peuvent être 
synchronisés sur un signal de référence spécifique 
ou des codes temporels synchronisés via le 
connecteur de synchronisation des unités 
XDCA-FS7 (page 12) fixées aux caméscopes.

Remarque

Le pack batterie du caméscope ne peut pas être utilisé 
quand une unité XDCA-FS7 est fixée au caméscope. 
Vous devez raccorder un pack batterie à l’unité 
XDCA-FS7 ou brancher l’appareil sur une source 
d’alimentation externe.

Synchronisation de la phase des signaux 
vidéo (synchronisation)
Activez la synchronisation en fournissant un 
signal de référence au connecteur de 
synchronisation (page 12) des unités XDCA-FS7 
connectées aux caméscopes.
Les signaux de référence pouvant être utilisés 
varient en fonction de la fréquence d’images du 
format d’enregistrement sélectionné.

Pour la région NTSC

Pour la région PAL

Remarques

• Si le format d’enregistrement sélectionné est 
1280×720 60P, vous devez fournir un signal vidéo et 
un signal temporel.

• Si le signal de référence est instable, la synchronisation 
ne peut pas être achevée.

• La sous-porteuse n’est pas synchronisée.

Verrouillage du code temporel sur 
d’autres dispositifs
Réglez l’appareil fournissant le code temporel sur 
un mode dans lequel la sortie de code temporel 
continue à défiler (comme Free Run ou Clock).

1 Réglez Timecode dans le menu TC/UB 
de la manière suivante.

Mode : prédéfini
Défilement : défilement libre

2 Appuyez sur la touche personnalisable 
(page 46) à laquelle la fonction 
DURATION/TC/U-BIT consistant à 
afficher le code temporel sur l’écran est 
attribuée.

3 Vérifiez que le commutateur TC IN/
OUT (page 12) sur le XDCA-FS7 est 
réglé sur la position IN, et fournissez un 
signal vidéo de référence HD ou SD et 
un code temporel synchronisé avec le 
signal vidéo sur les connecteurs de 
synchronisation et TC IN/OUT, 
respectivement.

Le générateur de code temporel du caméscope 
acquiert le verrou avec le code temporel de 
référence et « EXT-LK » apparaît à l’écran.
Une fois que 10 secondes environ se sont 
écoulées après le verrouillage du code temporel, 
l’état de verrouillage externe est maintenu, même 
si la source de code temporel de référence externe 
est déconnectée.

Remarques

• Vérifiez que le code temporel de référence et le signal 
vidéo de référence fournis sont en relation de phase 
conforme à la norme de code temporel SMPTE.

• Lors de l’utilisation d’un verrou externe, le code 
temporel acquiert instantanément le verrou avec le 
code temporel externe et la valeur de code temporel 
externe apparaît dans la zone d’affichage des données. 
Cependant, ne commencez pas immédiatement 
l’enregistrement. Patientez quelques secondes le temps 

Synchronisation externe

Fréquence d’images 
du format 
d’enregistrement

Signaux de référence 
valides

59.94P 1920 × 1080 59.94i
720 × 486 59.94i
1280 × 720 59.94P

29.97P 1920 × 1080 59.94i
720 × 486 59.94i

24.0P 1920×1080 48i (24PsF)

23.98P 1920 × 1080 47.95i 
(23.98PsF)

59.94i 1920 × 1080 59.94i
720 × 486 59.94i

Fréquence d’images 
du format 
d’enregistrement

Signaux de référence 
valides

50P 1920 × 1080 50i
720 × 576 50i
1280 × 720 50P

25P 1920 × 1080 50i
720 × 576 50i

50i 1920 × 1080 50i
720 × 576 50i



107

que le générateur de code temporel se stabilise avant 
l’enregistrement.

• Si la fréquence du signal vidéo de référence et la 
fréquence d’images sur le caméscope ne sont pas les 
mêmes, un verrou ne peut pas être acquis et le 
caméscope ne fonctionnera pas correctement. Si cela 
se produit, le code temporel n’acquerra pas de verrou 
correctement avec le code temporel externe.

• Si la source de code temporel externe est déconnectée, 
le code temporel peut changer d’une image par heure, 
par rapport au code temporel de référence.

Pour déverrouiller le verrou externe
Changez le réglage Timecode dans le menu TC/
UB ou éteignez le caméscope.
Le verrou externe est également déverrouillé si 
vous commencez l’enregistrement en mode 
ralenti et accéléré.

Synchronisation du code temporel d’un 
autre dispositif avec le code temporel du 
caméscope
Réglez l’appareil fournissant le code temporel sur 
un mode dans lequel la sortie de code temporel 
continue à défiler (comme Free Run ou Clock).

1 Réglez le code temporel du caméscope 
en utilisant Timecode (page 89) dans le 
menu TC/UB.

2 Vérifiez que le commutateur TC IN/
OUT (page 12) est réglé sur la position 
OUT, et connectez le connecteur TC IN/
OUT et le connecteur de 
synchronisation (page 12) sur l’entrée 
de code temporel et l’entrée de signal de 
référence, respectivement, du dispositif 
que vous souhaitez synchroniser.

Utilisation d’un lecteur de carte XQD (en 
option)
Raccordez un lecteur de cartes XQD MRW-E80 
(en option) à l’aide d’un câble USB, et insérez 
une carte mémoire dans le logement. La carte 
mémoire est reconnue comme un lecteur 
d’extension de l’ordinateur.

Utilisation du mode de stockage de 
masse
Raccordez le caméscope à l’aide d’un câble USB, 
et insérez une carte mémoire dans le logement. La 
carte mémoire est reconnue comme un lecteur 
d’extension de l’ordinateur.

1 Placez le commutateur POWER du 
caméscope sur ON.

Un message apparaît sur l’écran ou sur le 
viseur, vous demandant si vous souhaitez 
activer la connexion USB.

Le message de confirmation de connexion USB 
n’est pas affiché tant qu’un autre message de 
confirmation ou de progression est affiché, par 
exemple, lors du formatage ou de la restauration 
d’une carte mémoire XQD. 
Le message de confirmation est affiché lorsque 
l’exécution du formatage ou de la restauration est 
terminée. Le message de confirmation USB n’est 
pas non plus affiché lorsque l’écran des propriétés 
du plan est affiché. Le message est affiché lorsque 
le traitement se termine ou lorsque vous revenez à 
l’écran de miniatures.

2 Tournez la molette SEL/SET et 
sélectionnez Execute.

Gestion/Edition de plans 
grâce à un ordinateur

Connexion à l’aide d’un câble USB

Remarque
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3 Sous Windows, vérifiez que la carte est 
ajoutée en tant que disque amovible 
dans la fenêtre « Poste de travail ». 
Sous Mac, vérifiez que le dossier appelé 
« NO NAME » ou « Untitled » 
(éditable) est créé sur le bureau.

Remarques

• N’effectuez pas les opérations suivantes si la lampe 
d’accès est allumée en rouge.
- Mise hors tension ou déconnexion du cordon 

d’alimentation
- Retrait de la carte mémoire XQD
- Déconnexion du câble USB

• Le fonctionnement n’est pas garanti avec tous les 
ordinateurs.

Utilisation de systèmes de montage non 
linéaire
Dans un système de montage non linéaire, un 
logiciel de montage (en option) qui prend en 
charge les formats enregistrés par le caméscope 
est nécessaire.
Utilisez un logiciel d’application dédié pour 
enregistrer au préalable les plans que vous 
souhaitez éditer sur le disque dur de votre 
ordinateur.
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Le ventilateur est une pièce consommable qui 
nécessitera un remplacement périodique.
Lorsque vous utilisez l’appareil à température 
ambiante, le cycle de remplacement est d’environ 
5 ans.
Mais, ce cycle de remplacement ne représente 
qu’une indication et ne garantit pas la durée de vie 
de ce consommable. Pour plus de détails sur le 
remplacement de ces pièces, veuillez contacter 
votre revendeur.

Si l’appareil est soudainement déplacé d’un 
endroit froid à un endroit chaud, ou si la 
température ambiante augmente brusquement, de 
l’humidité peut se former sur la surface externe de 
l’appareil et/ou à l’intérieur de l’appareil. Ce 
phénomène est connu sous le nom de 
condensation. Si de la condensation se produit, 
mettez l’appareil hors tension et patientez le 
temps que la condensation disparaisse avant 
d’utiliser l’appareil. L’utilisation de l’appareil 
avec de la condensation pourrait endommager 
l’appareil.

L’écran LCD intégré à cet appareil est fabriqué 
avec une technologie de haute précision, ce qui 
permet d’obtenir un taux d’au moins 99,99% de 
pixels qui fonctionnent. Ainsi, un infime 
pourcentage de pixels peut être « bloqué », c’est à 
dire toujours éteint (noir), toujours éclairé (rouge, 
vert ou bleu), ou clignotant. En outre, après une 
longue période d’utilisation, en raison des 
caractéristiques physiques de l’afficheur à 
cristaux liquides, de tels pixels « bloqués » 
peuvent apparaître spontanément. Ces problèmes 
ne sont pas graves. Notez que ces problèmes 
n’ont aucun effet sur les données enregistrées.

La borne de batterie de cet appareil (le connecteur 
pour les packs batterie et les adaptateurs CA) est 
une pièce consommable.
L’appareil risque de ne pas être alimenté 
correctement si les broches de la borne de batterie 
sont cintrées ou déformées par les chocs ou les 
vibrations, ou si elles sont touchées par la 
corrosion en raison d’une utilisation prolongée en 
extérieur.

Des inspections périodiques sont recommandées 
pour que l’appareil continue à fonctionner 
correctement et pour prolonger la durée de son 
utilisation.
Contactez un vendeur ou un technicien Sony pour 
plus d’informations sur les inspections.

A propos de la batterie rechargeable intégrée
Le caméscope possède une batterie rechargeable 
intégrée afin de stocker la date, l’heure et d’autres 
réglages, même lorsque le caméscope est éteint. 
La batterie rechargeable sera entièrement 
déchargée après environ 3 mois si l’adaptateur 
CA n’est pas branché ou si le caméscope est 
utilisé sans que le pack batterie ne soit fixé. 
Utilisez votre caméscope après avoir chargé la 
batterie.
Cependant, même si la batterie rechargeable 
intégrée n’est pas chargée, le fonctionnement du 
caméscope n’est pas affecté, tant que vous 
n’enregistrez pas la date et l’heure.

Annexe

Précautions d’utilisation
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Les réglages par défaut sont affichés en gras (par exemple, 2048×1080P (Level A)).

Remarques

• La résolution du format d’enregistrement est déterniné par le réglage de Base Setting >Imager Scan Mode dans le menu 
System (page 96).

• Aucune image de lecture n’est émise si la résolution de sortie vidéo est plus élevée que celle de l’image.

Formats de sortie du connecteur SDI OUT

Lorsque Country >NTSC/PAL Area dans le menu System est réglé sur NTSC Area

Lors de l’utilisation d’une configuration basique (XAVC-I / XAVC-L / MPEG HD)

Formats de sortie et limites

 Formats vidéo et signaux de sortie

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
4096×2160 59.94P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

4096×2160 29.97P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

4096×2160 24.00P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF – 1920×1080 24PsF

– 1920×1080P Pas de sortie

4096×2160 23.98P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Pas de sortie

3840×2160 59.94P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

3840×2160 29.97P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 29.97PsF
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3840×2160 23.98P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Pas de sortie

1920×1080 59.94P 2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

– 720×480i Pas de sortie

– 720×480P Pas de sortie

1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i 

– 720×480i Pas de sortie

– 720×480P Pas de sortie

1920×1080 29.97P 2048×1080PsF – 2048×1080 29.97PsF

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

– 720×480i Pas de sortie

1920×1080 23.98P 2048×1080PsF – 2048×1080 23.98PsF

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Pas de sortie

1920×1080i (2-
3PD)

1920×1080i (2-
3PD)

1920×1080 59.94i (2-3PD)

– 720×480i (2-
3PD)

Pas de sortie

1280×720 59.94P 1280×720P 1280×720P 1280×720 59.94P

– 720×480i Pas de sortie

– 720×480P Pas de sortie

1280×720 29.97P 1280×720P 1280×720P 1280×720 59.94P (2-2RP)

– 720×480i Pas de sortie

1280×720 23.98P 1280×720P (2-
3PD)

1280×720P (2-
3PD)

1280×720 59.94P (2-3PD)

– 720×480i (2-
3PD)

Pas de sortie

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
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Lors de l’utilisation d’une unité d’extension (RAW)

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI

RAW Output Format
4096×2160 59.94P

Video Format (valeur fixe)
1920×1080 59.94P

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
4096×2160 59.94P

Video Format (valeur fixe)
1280×720 59.94P

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
2048×1080 59.94P

Video Format (valeur fixe)
1920×1080 59.94P 

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
2048×1080 59.94P

Video Format (valeur fixe)
1280×720 59.94P 

2048×1080P 
(Level A)

– 2048×1080 59.94P Level-A

2048×1080P 
(Level B)

– 2048×1080 59.94P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P Level-A

1920×1080P 
(Level B)

– 1920×1080 59.94P Level-B

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
4096×2160 29.97P

Video Format (valeur fixe)
1920×1080 29.97P

2048×1080PsF – 2048×1080 29.97PsF

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

RAW Output Format
2048×1080 29.97P

Video Format (valeur fixe)
1920×1080 29.97P 

2048×1080PsF – 2048×1080 29.97PsF

1920×1080PsF 1920×1080i 1920×1080 29.97PsF
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Lors de l’utilisation d’une unité d’extension (ProRes 422)

*1 Impossible d’émettre un signal compatible avec le CBK-WA100.

Lorsque Country >NTSC/PAL Area dans le menu System est réglé sur PAL Area

Lors de l’utilisation d’une configuration basique (XAVC-I / XAVC-L / MPEG HD)

RAW Output Format
4096×2160 23.98P

Video Format (valeur fixe)
1920×1080 23.98P

2048×1080PsF – 2048×1080 23.98PsF

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Pas de sortie

RAW Output Format
2048×1080 23.98P

Video Format (valeur fixe)
1920×1080 23.98P

2048×1080PsF – 2048×1080 23.98PsF

1920×1080PsF – 1920×1080 23.98PsF

– 1920×1080P Pas de sortie

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i

1920×1080 29.97P 1920×1080PsF 1920×1080i SDI OUT 1
1920×1080 29.97P

SDI OUT 2
1920×1080 29.97PsF

1920×1080 23.98P 1920×1080P 1920×1080P 1920×1080 23.98P*1

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
4096×2160 50P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

4096×2160 25P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 25PsF

3840×2160 50P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
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Lors de l’utilisation d’une unité d’extension (RAW)

3840×2160 25P – 4096×2160P Pas de sortie

– 3840×2160P Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 25PsF

1920×1080 50P 2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

– 720×576i Pas de sortie

– 720×576P Pas de sortie

1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

– 720×576i Pas de sortie

– 720×576P Pas de sortie

1920×1080 25P 2048×1080PsF – 2048×1080 25PsF

1920×1080PsF 1920×1080i 1920×1080 25PsF

– 720×576i Pas de sortie

1280×720 50P 1280×720P 1280×720P 1280×720 50P

– 720×576i Pas de sortie

– 720×576P Pas de sortie

1280×720 25P 1280×720P 1280×720P 1280×720 50P (2-2RP)

– 720×576i Pas de sortie

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI

RAW Output Format
4096×2160 50P

Video Format (valeur fixe)
1920×1080 50P

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
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Lors de l’utilisation d’une unité d’extension (ProRes 422)

RAW Output Format
4096×2160 50P

Video Format (valeur fixe)
1280×720 50P 

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1280×720P 1280×720P 1280×720 50P

RAW Output Format
2048×1080 50P

Video Format (valeur fixe)
1920×1080 50P

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1920×1080i 1920×1080i 1920×1080 50i

RAW Output Format
2048×1080 50P

Video Format (valeur fixe)
1280×720 50P 

2048×1080P 
(Level A)

– 2048×1080 50P Level-A

2048×1080P 
(Level B)

– 2048×1080 50P Level-B

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P Level-A

1920×1080P 
(Level B)

– 1920×1080 50P Level-B

1280×720P 1280×720P 1280×720 50P

RAW Output Format
4096×2160 25P

Video Format (valeur fixe)
1920×1080 25P 

2048×1080PsF – 2048×1080 25PsF

1920×1080PsF 1920×1080i 1920×1080 25PsF

RAW Output Format
2048×1080 25P

Video Format (valeur fixe)
1920×1080 25P 

2048×1080PsF – 2048×1080 25PsF

1920×1080PsF 1920×1080i 1920×1080 25PsF

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

1920×1080 25P 1920×1080PsF 1920×1080PsF SDI OUT 1
1920×1080 25P

SDI OUT 2
1920×1080 25PsF

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie SDI

SDI HDMI
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Formats de sortie du connecteur HDMI OUT

Lorsque Country >NTSC/PAL Area dans le menu System est réglé sur NTSC Area

Lors de l’utilisation d’une configuration basique (XAVC-I / XAVC-L / MPEG HD)

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
4096×2160 59.94P – 4096×2160P 4096×2160 59.94P

– 3840×2160P 3840×2160 59.94P

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 59.94i

4096×2160 29.97P – 4096×2160P 4096×2160 29.97P

– 3840×2160P 3840×2160 29.97P

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

4096×2160 24.00P – 4096×2160P 4096×2160 24P

– 3840×2160P 3840×2160 24P

1920×1080PsF – Pas de sortie

– 1920×1080P 1920×1080 24P (Pure)

4096×2160 23.98P – 4096×2160P 4096×2160 23.98P

– 3840×2160P 3840×2160 23.98P

1920×1080PsF – Pas de sortie

– 1920×1080P 1920×1080 23.98P (Pure)

3840×2160 59.94P – 4096×2160P 4096×2160 59.94P

– 3840×2160P 3840×2160 59.94P

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 59.94i

3840×2160 29.97P – 4096×2160P 4096×2160 29.97P

– 3840×2160P 3840×2160 29.97P

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

3840×2160 23.98P – 4096×2160P 4096×2160 23.98P

– 3840×2160P 3840×2160 23.98P

1920×1080PsF – Pas de sortie

– 1920×1080P 1920×1080 23.98P (Pure)
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1920×1080 59.94P 2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 59.94i

– 720×480i 720×480 59.94i

– 720×480P 720×480 59.94P

1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i

– 720×480i 720×480 59.94i

– 720×480P 720×480 59.94P

1920×1080 29.97P 2048×1080PsF – Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

– 720×480i 720×480 59.94i (PsF)

1920×1080 23.98P 2048×1080PsF – Pas de sortie

1920×1080PsF – Pas de sortie

– 1920×1080P 1920×1080 23.98P (Pure)

1920×1080i 
(2-3PD)

1920×1080i 
(2-3PD)

1920×1080 59.94i (2-3PD)

– 720×480i 
(2-3PD)

720×480 59.94i (2-3PD)

1280×720 59.94P 1280×720P 1280×720P 1280×720 59.94P

– 720×480i 720×480 59.94i

– 720×480P 720×480 59.94P

1280×720 29.97P 1280×720P 1280×720P 1280×720 59.94P (2-2RP)

– 720×480i 720×480 59.94i (PsF)

1280×720 23.98P 1280×720P 
(2-3PD)

1280×720P 
(2-3PD)

1280×720 59.94P (2-3PD)

– 720×480i 
(2-3PD)

720×480 59.94i

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
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Lors de l’utilisation d’une unité d’extension (RAW)

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI

RAW Output Format
4096×2160 59.94P

Video Format (valeur fixe)
1920×1080 59.94P

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
4096×2160 59.94P

Video Format (valeur fixe)
1280×720 59.94P

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
2048×1080 59.94P

Video Format (valeur fixe)
1920×1080 59.94P 

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 59.94i

RAW Output Format
2048×1080 59.94P

Video Format (valeur fixe)
1280×720 59.94P 

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 59.94P

1920×1080P 
(Level B)

– Pas de sortie

1280×720P 1280×720P 1280×720 59.94P

RAW Output Format
4096×2160 29.97P

Video Format (valeur fixe)
1920×1080 29.97P 

2048×1080PsF – Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 29.97PsF

RAW Output Format
2048×1080 29.97P

Video Format (valeur fixe)
1920×1080 29.97P

2048×1080PsF – Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 29.97PsF
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Lors de l’utilisation d’une unité d’extension (ProRes 422)

Lorsque Country >NTSC/PAL Area dans le menu System est réglé sur PAL Area

Lors de l’utilisation d’une configuration basique (XAVC-I / XAVC-L / MPEG HD)

RAW Output Format
4096×2160 23.98P

Video Format (valeur fixe)
1920×1080 23.98P

2048×1080PsF – Pas de sortie

1920×1080PsF – Pas de sortie

– 1920×1080P 1920×1080 23.98P (Pure)

RAW Output Format
2048×1080 23.98P

Video Format (valeur fixe)
1920×1080 23.98P

2048×1080PsF – Pas de sortie

1920×1080PsF – Pas de sortie

– 1920×1080P 1920×1080 23.98P (Pure)

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
1920×1080 59.94i 1920×1080i 1920×1080i 1920×1080 59.94i

1920×1080 29.97P 1920×1080PsF 1920×1080i 1920×1080 29.97PsF

1920×1080 23.98P 1920×1080P 1920×1080P 1920×1080 23.98P (Pure)

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
4096×2160 50P – 4096×2160P 4096×2160 50P

– 3840×2160P 3840×2160 50P

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 50i

4096×2160 25P – 4096×2160P 4096×2160 25P

– 3840×2160P 3840×2160 25P

1920×1080PsF 1920×1080i 1920×1080 25PsF

3840×2160 50P – 4096×2160P 4096×2160 50P

– 3840×2160P 3840×2160 50P

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 50i

3840×2160 25P – 4096×2160P 4096×2160 25P

– 3840×2160P 3840×2160 25P

1920×1080PsF 1920×1080i 1920×1080 25PsF

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
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Lors de l’utilisation d’une unité d’extension (RAW)

1920×1080 50P 2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 50i

– 720×576i 720×576 50i

– 720×576P 720×576 50P

1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

– 720×576i 720×576 50i

– 720×576P 720×576 50P

1920×1080 25P 2048×1080PsF – Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 50i (PsF)

– 720×576i 720×576 50i (PsF)

1280×720 50P 1280×720P 1280×720P 1280×720 50P

– 720×576i 720×576 50i

– 720×576P 720×576 50P

1280×720 25P 1280×720P 1280×720P 1280×720 50P (2-2RP)

– 720×576i 720×576 50i (PsF)

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI

RAW Output Format
4096×2160 50P

Video Format (valeur fixe)
1920×1080 50P

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 50i

RAW Output Format
4096×2160 50P

Video Format (valeur fixe)
1280×720 50P 

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1280×720P 1280×720P 1280×720 50P

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
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Lors de l’utilisation d’une unité d’extension (ProRes 422)

Réglages de sortie HDMI pour dispositifs HDMI

RAW Output Format
2048×1080 50P

Video Format (valeur fixe)
1920×1080 50P

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1920×1080i 1920×1080i 1920×1080 50i

RAW Output Format
2048×1080 50P

Video Format (valeur fixe)
1280×720 50P 

2048×1080P 
(Level A)

– Pas de sortie

2048×1080P 
(Level B)

– Pas de sortie

1920×1080P 
(Level A)

1920×1080P 1920×1080 50P

1920×1080P 
(Level B)

– Pas de sortie

1280×720P 1280×720P 1280×720 50P

RAW Output Format
4096×2160 25P

Video Format (valeur fixe)
1920×1080 25P 

2048×1080PsF – Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 25PsF

RAW Output Format
2048×1080 25P

Video Format (valeur fixe)
1920×1080 25P 

2048×1080PsF – Pas de sortie

1920×1080PsF 1920×1080i 1920×1080 25PsF

Réglages du format d’enregistrement
(Rec Format >Video Format dans le 
menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI
1920×1080 50i 1920×1080i 1920×1080i 1920×1080 50i

1920×1080 25P 1920×1080PsF 1920×1080i 1920×1080 50i (PsF)

Réglages du format d’enregistrement
(Rec Format >RAW Output Format et 
Video Format dans le menu System)

Réglages de sortie SDI/HDMI
(Output Format >SDI et 
HDMI dans le menu Video)

Signal de sortie HDMI

SDI HDMI

Output Setting >HDMI Target 
Device dans le menu Video

Output Display >SDI/HDMI 
dans le menu Video

Sortie HDMI

OSD On/Off MLUT On/Off

Recorder (par défaut) SDI=On, HDMI=On (par défaut)
* Grisé, ne peut pas être sélectionné.

– Suit le SDI1

SDI=On, HDMI=Off Off

SDI=Off, HDMI=Off Off

Monitor SDI=On, HDMI=On (par défaut) On Suit le SDI2

SDI=On, HDMI=Off
* Grisé, ne peut pas être sélectionné.

–

SDI=Off, HDMI=Off Off
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Remarques

• Si le réglage Output Display actuel ne peut plus être sélectionné après avoir changé HDMI Target Device, le réglage 
Output Display se modifie de la façon suivante.
– Revient de manière forcée à sa valeur par défaut.
– Si la valeur par défaut ne peut pas être sélectionnée, passe de manière forcée à « SDI=On, HDMI=On ».

• HDMI Target Device ne peut pas être réglé sur Recorder si Codec est réglé sur ProRes.

Etats lorsque le moniteur LUT ne peut pas être configuré indépendamment
Dans les cas suivants, Monitor LUT >SDI2, HDMI et Viewfinder dans le menu Video ne peuvent pas être 
réglés séparément. Ils sont synchronisés sur le réglage SDI1 & Internal Rec.

- Lorsque Output Format >HDMI dans le menu Video est sur 4096×2160 ou 3840×2160
- Lorsque S&Q Motion >Setting dans le menu Recording est sur On
- Lorsque Lens >Distortion Comp. dans le menu System est sur Auto
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Si le caméscope détecte un avertissement, une précaution ou une opération qui nécessite une confirmation, 
un message s’affiche dans le viseur, les indicateurs d’enregistrement commencent à clignoter et un 
avertissement sonore est émis.
Le son d’avertissement est émis depuis le haut-parleur intégré et les écouteurs connectés au connecteur 
pour casque.

Le caméscope arrêtera l’opération si l’un des écrans suivants s’affiche.

Suivez les instructions fournies si l’écran suivant s’affiche.

Avertissements de fonctionnement

Messages d’erreur

Message du viseur Avertisse-
ment 
sonore

Indicateur 
d’enregistre-
ment

Cause et solution

E + code d’erreur Continu Clignotement 
rapide

Indique une anomalie dans le caméscope. L’enregistrement 
s’arrête, même lorsque zREC est affiché dans le viseur.
Mettez le caméscope hors tension, et vérifiez si vous détectez 
un problème au niveau des dispositifs, des câbles ou du 
support raccordés. Si l’erreur persiste après avoir remis le 
caméscope sous tension, contactez votre technicien Sony.
(Si le caméscope ne peut pas être mis hors tension en réglant 
le commutateur POWER sur OFF, retirez la batterie ou 
débranchez l’alimentation DC IN.)

Messages d’avertissement

Message du viseur Avertisse-
ment 
sonore

Indicateur 
d’enregistre-
ment

Cause et solution

Media Near Full Intermittent Clignotement La capacité restante de la carte mémoire XQD est faible.
Remplacez-la dès que possible.

Media Full Continu Clignotement 
rapide

Les plans n’ont pas pu être enregistrés, copiés ou divisés car la 
capacité restante de la carte XQD n’est pas suffisante.
Remplacez-la immédiatement.

Battery Near End Intermittent Clignotement La capacité restante du pack batterie est faible.
Rechargez-le dès que possible.

Battery End Continu Clignotement 
rapide

Le pack batterie est vide. L’enregistrement est désactivé.
Arrêtez les opérations et remplacez le pack batterie.

Temperature High Intermittent Clignotement La température interne est élevée.
Mettez le caméscope hors tension et laissez-le refroidir avant 
de le faire fonctionner à nouveau.

Voltage Low Intermittent Clignotement La tension DC IN est faible (niveau 1). Vérifiez la source 
d’alimentation.

Insufficient Voltage Continu Clignotement 
rapide

La tension DC IN est trop faible (niveau 2). L’enregistrement 
est désactivé.
Raccordez une source d’alimentation différente.
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Les messages de précaution et d’opération suivants peuvent apparaître au centre de l’écran. Suivez les 
instructions fournies pour résoudre le problème.

1) « Media (B) » s’affiche pour la carte située dans le logement B.

Messages de précaution concernant l’opération

Message du viseur Cause et solution
Battery Error
Please Change Battery

Une erreur a été détectée au niveau du pack batterie.
Remplacez-le par un pack batterie normal.

Backup Battery End
Please Change

La capacité restante de la batterie de secours est insuffisante.
Rechargez la batterie de secours.

Unknown Media(A)1)

Please Change

Une carte mémoire qui a été divisée en plusieurs parties ou une carte 
mémoire contenant plus de plans que ceux pris en charge par le 
caméscope a été insérée.
La carte ne peut pas être utilisée dans le caméscope et doit être 
remplacée.

Cannot Use Media(A)1)

Unsupported File System

Une carte utilisant un système de fichiers différent ou une carte non 
formatée a été insérée.
La carte ne peut pas être utilisée dans le caméscope et doit être 
remplacée ou formatée à l’aide du caméscope.

Media Error

Media(A)1) Needs to be Restored

Une erreur s’est produite avec la carte mémoire et la carte doit être 
restaurée.
Restaurez la carte mémoire.

Media Error

Cannot Record to Media(A)1)

La carte mémoire peut être endommagée et ne peut plus être utilisée 
pour l’enregistrement.
La lecture est possible, il est donc recommandé d’effectuer une copie et 
de remplacer la carte mémoire.

Media Error

Cannot Use Media(A)1)

La carte mémoire peut être endommagée et ne peut plus être utilisée 
pour l’enregistrement ou la lecture.
La carte ne peut pas être utilisée dans le caméscope et doit être 
remplacée.

Media(A)1) Error
Recording Halted
Playback Halted

L’enregistrement et la lecture se sont arrêtés parce qu’une erreur s’est 
produite pendant l’utilisation de la carte mémoire.
Si le problème persiste, remplacez la carte mémoire.

Media Reached Rewriting Limit

Change Media (A)1) 

La carte mémoire a atteint la fin de sa durée de vie.
Effectuez une copie de sauvegarde et remplacez la carte immédiatement. 
Si vous continuez à utiliser la carte, la carte risque de ne plus pouvoir 
enregistrer ou lire.

Pour plus de détails, reportez-vous au mode d’emploi de la carte 
mémoire.

Fan Stopped Le ventilateur intégré s’est arrêté.
Evitez l’utilisation à des températures élevées, débranchez l’alimentation 
et prenez contact avec votre technicien Sony.

Invalid setting value was reset:
Media/Clip Naming/Camera Position
Please save All File again

Le réglage de format Clip Naming a été réinitialisé car un fichier ALL 
invalide a été chargé.
Configurez les réglages de format désiré, puis tentez à nouveau 
d’enregistrer le fichier ALL.
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Oui : L’élément est enregistré.
Non : L’élément n’est pas enregistré.

Eléments enregistrés dans les fichiers

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
Camera ISO/Gain/EI Mode Oui Oui

ISO/Gain<H> Oui Oui

ISO/Gain<M> Oui Oui

ISO/Gain<L> Oui Oui

Exposure Index<H> Oui Oui

Exposure Index<M> Oui Oui

Exposure Index<L> Oui Oui

Shockless Gain Oui Oui

Auto Exposure Level Oui Oui

Mode Oui Oui

Speed Oui Oui

AGC Oui Oui

AGC Limit Oui Oui

Auto Shutter Oui Oui

A.SHT Limit Oui Oui

Clip High light Oui Oui

Detect Window Oui Oui

Detect Window Indication Oui Oui

Focus Focus Area Oui Non

Focus Area (Push AF) Oui Non

AF Assist Oui Non

Shutter Mode Oui Oui

Shutter Speed Oui Oui

Shutter Angle Oui Oui

ECS Frequency Oui Oui

Color Bars Setting Non Non

Type Oui Non

Noise Suppression Setting Oui Oui

Level Oui Oui

Flicker Reduce Mode Oui Non

Frequency Oui Non

SteadyShot Setting Oui Non

Handle Zoom Zoom Speed Type Oui Non

Zoom Speed Oui Non

Auto Black Balance Auto Black Balance – –

AF Micro Adjustment Setting Non Non

Amount Non Non

Clear All – –

Video Light Set Video Light Set Oui Non
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Paint White Preset White Oui Oui

Color Temp <A> Oui Oui

Color Temp Balance <A> Oui Oui

R Gain <A> Oui Oui

B Gain <A> Oui Oui

Color Temp <B> Oui Oui

Color Temp Balance <B> Oui Oui

R Gain <B> Oui Oui

B Gain <B> Oui Oui

Filter White Memory Oui Non

Shockless White Oui Oui

White Switch<B> Oui Non

ATW Speed Oui Oui

Offset White Offset White <A> Oui Oui

Warm Cool <A> Oui Oui

Warm Cool Balance <A> Oui Oui

Offset White <B> Oui Oui

Warm Cool <B> Oui Oui

Warm Cool Balance <B> Oui Oui

Offset White<ATW> Oui Oui

Warm Cool<ATW> Oui Oui

Warm Cool Balance<ATW> Oui Oui

Black Setting Oui Oui

Master Black Oui Oui

R Black Oui Oui

B Black Oui Oui

Gamma Setting Oui Oui

Step Gamma Oui Oui

Master Gamma Oui Oui

R Gamma Oui Oui

G Gamma Oui Oui

B Gamma Oui Oui

Gamma Category Oui Oui

Gamma Select Oui Oui

Black Gamma Setting Oui Oui

Range – –

Master Black Gamma Oui Oui

Knee Setting Oui Oui

Auto Knee Oui Oui

Point Oui Oui

Slope Oui Oui

Knee Saturation Oui Oui

Knee Saturation Level Oui Oui

White Clip Setting Oui Oui

Level Oui Oui

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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Detail Setting Oui Oui

Level Oui Oui

H/V Ratio Oui Oui

Crispening Oui Oui

Level Depend Oui Oui

Level Depend Level Oui Oui

Frequency Oui Oui

Knee Aperture Oui Oui

Knee Aperture Level Oui Oui

Limit Oui Oui

White Limit Oui Oui

Black Limit Oui Oui

V Black Limit Oui Oui

V Detail Creation Oui Oui

Skin Detail Setting Oui Oui

Area Detection – –

Area Indication Non Non

Level Oui Oui

Saturation Oui Oui

Hue Oui Oui

Width Oui Oui

Aperture Setting Oui Oui

Level Oui Oui

Matrix Setting Oui Oui

Adaptive Matrix Oui Oui

Preset Matrix Oui Oui

Preset Select Oui Oui

User Matrix Oui Oui

Level Oui Oui

Phase Oui Oui

User Matrix R-G Oui Oui

User Matrix R-B Oui Oui

User Matrix G-R Oui Oui

User Matrix G-B Oui Oui

User Matrix B-R Oui Oui

User Matrix B-G Oui Oui

Multi Matrix Setting Oui Oui

Area Indication Non Non

Color Detection – –

Axis Non Non

Hue Oui Oui

Saturation Oui Oui

Maintenance Test Saw Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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Audio Audio Input CH1 Input Select Oui Non

CH2 Input Select Oui Non

CH3 Input Select Oui Non

CH4 Input Select Oui Non

INPUT1 MIC Reference Oui Non

INPUT2 MIC Reference Oui Non

CH1 Wind Filter Oui Non

CH2 Wind Filter Oui Non

CH3 Wind Filter Oui Non

CH4 Wind Filter Oui Non

CH3 Level Control Oui Non

CH4 Level Control Oui Non

CH3 Input Level Oui Non

CH4 Input Level Oui Non

Audio Input Level Oui Non

Limiter Mode Oui Non

CH1&2 AGC Mode Oui Non

CH3&4 AGC Mode Oui Non

AGC Spec Oui Non

1kHz Tone on Color Bars Oui Non

CH1 Level Oui Non

CH2 Level Oui Non

CH3 Level Oui Non

CH4 Level Oui Non

Audio Output Monitor CH Oui Non

Monitor Volume Oui Non

Headphone Out Oui Non

Alarm Volume Oui Non

Output Limiter Oui Non

HDMI Output CH Oui Non

Video Output On/Off SDI Oui Non

HDMI Oui Non

Output Format SDI Oui Non

HDMI Oui Non

REF Non Non

Output Setting HDMI Target Device Oui Non

4K/2K to HD Conv. Oui Non

Monitor LUT Category Oui Non

LUT Select Oui Non

Look Profile Select Oui Non

User 3D LUT Select Oui Non

SDI1 & Internal Rec Oui Non

SDI2 Oui Non

HDMI Oui Non

Viewfinder Oui Non

Output Display SDI2 Oui Non

HDMI Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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VF VF Setting Brightness Oui Non

Color Mode Oui Non

Peaking Setting Oui Non

Peaking Type Oui Non

Frequency Oui Non

Normal Peaking Level Oui Non

Color Oui Non

Color Peaking Level Oui Non

Zebra Setting Oui Non

Zebra Select Oui Non

Zebra1 Level Oui Non

Zebra1 Aperture Level Oui Non

Zebra2 Level Oui Non

Marker Setting Oui Non

Color Oui Non

Center Marker Oui Non

Safety Zone Oui Non

Safety Area Oui Non

Aspect Marker Oui Non

Aspect Mask Oui Non

Aspect Safety Zone Oui Non

Aspect Safety Area Oui Non

Aspect Select Oui Non

User Box Oui Non

User Box Width Oui Non

User Box Height Oui Non

User Box H Position Oui Non

User Box V Position Oui Non

100% Marker Oui Non

Guide Frame Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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Display On/Off Setting Oui Non

Shutter Setting Oui Non

ND Filter Position Oui Non

Gain Setting Oui Non

Rec/Play Status Oui Non

HXR-IFR5 Rec Control Oui Non

Color Temp. Oui Non

Frame Rate / Interval Oui Non

Battery Remain Oui Non

Timecode Oui Non

Audio Manual Oui Non

Audio Level Meter Oui Non

Media Status Oui Non

Focus Position Oui Non

Iris Position Oui Non

Zoom Position Oui Non

SteadyShot Oui Non

Focus Mode Oui Non

Focus Area Indicator Oui Non

Focus Area Ind. (Push AF) Oui Non

Focus Indicator Oui Non

Auto Shutter Oui Non

AGC Oui Non

Auto Iris Oui Non

AE Mode Oui Non

Auto Exposure Level Oui Non

White Balance Mode Oui Non

SDI/HDMI Rec Control Oui Non

Rec Format Oui Non

Gamma Oui Non

Timecode Lock Oui Non

Wi-Fi Condition Oui Non

Clip Name Oui Non

Focus Assist Indicator Oui Non

Focus Area Marker Oui Non

Video Level Warning Oui Non

Clip Number Oui Non

GPS Oui Non

Level Gauge Oui Non

Lens Info Oui Non

Notice Message Oui Non

Video Signal Monitor Setting Oui Non

Source Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File



131

TC/UB Timecode Mode Oui Non

Run Oui Non

Setting Non Non

Reset – –

TC Format Oui Non

TC Display Display Select Oui Non

Users Bit Mode Oui Non

Setting Non Non

HDMI TC Out Setting Oui Non

Recording S&Q Motion Setting Oui Non

High Frame Rate Mode Oui Non

Frame Rate Oui Non

Interval Rec Setting Non Non

Interval Time Oui Non

Number of Frames Oui Non

Pre-Lighting Oui Non

Picture Cache Rec Setting Oui Non

Cache Rec Time Oui Non

Simul Rec Setting Oui Non

Rec Button Set Oui Non

SDI/HDMI Rec Control Setting Oui Non

Thumbnail Display Clip Properties – –

Set Index Picture – –

Thumbnail View Essence Mark Thumbnail – –

Clip Thumbnail – –

Set Shot Mark Add Shot Mark1 – –

Delete Shot Mark1 – –

Add Shot Mark2 – –

Delete Shot Mark2 – –

Set Clip Flag Add OK – –

Add NG – –

Add KEEP – –

Delete Clip Flag – –

Lock/Unlock Clip Select Clip – –

Lock All Clips – –

Unlock All Clips – –

Delete Clip Select Clip – –

All Clips – –

Filter Clips OK – –

NG – –

KEEP – –

None – –

Customize View Thumbnail Caption Oui Oui

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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Media Update Media Media(A) – –

Media(B) – –

Format Media Media(A) – –

Media(B) – –

SD Card – –

Clip Auto Naming Oui Non

Camera ID Oui Non

Reel Number Oui Non

Camera Position Oui Non

Title Prefix Oui Non

Number Set Non Non

File All File Load SD Card – –

Save SD Card – –

File ID Oui Non

Scene File Recall Internal Memory – –

Store Internal Memory – –

Load SD Card – –

Save SD Card – –

File ID Non Oui

Scene White Data Oui Non

User Menu Item Load SD Card – –

Save SD Card – –

File ID Non Non

User Gamma Current Settings – –

Load SD Card – –

Reset – –

Monitor LUT Current Settings – –

Load SD Card – –

Reset – –

Monitor 3D LUT Current Settings – –

Load SD Card – –

Reset – –

Lens File White Offset R Non Non

White Offset B Non Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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System Base Setting Shooting Mode Oui Non

Color Space Oui Non

Imager Scan Mode Oui Non

Codec Select Oui Non

Rec Format Video Format Oui Non

RAW Output Format Oui Non

Genlock Reference – –

Assignable Button <1> Oui Non

<2> Oui Non

<3> Oui Non

<4> Oui Non

<5> Oui Non

<6> Oui Non

Assignable Dial Assignable Dial Oui Non

IRIS Dial Oui Non

Assignable Dial Direction Oui Non

IRIS Dial Direction Oui Non

Rec Lamp Rec Lamp Oui Non

Fan Control Setting Oui Non

HOLD Switch Setting with Rec Button Oui Non

with Hand Grip Remote Oui Non

Lens Zoom Ring Direction Oui Non

Distortion Comp. Oui Non

Language Select Oui Non

Clock Set Time Zone Oui Non

Date Mode Oui Non

12H/24H Oui Non

Date Non Non

Time Non Non

Country NTSC/PAL Area Oui Non

Hours Meter Hours(System) – –

Hours(Reset) – –

Reset – –

Basic Authentication User Name Non Non

Password Non Non

Wi-Fi Wi-Fi Oui Non

SSID & Password – –

Wi-Fi Direct Connection – –

Client – –

IP Address – –

Subnet Mask – –

MAC Address – –

Regenerate Password – –

GPS GPS Oui Non

IR Remote Setting Oui Non

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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Camera Battery Alarm Low BATT Oui Non

BATT Empty Oui Non

Camera DC IN Alarm DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

Ext. Unit Battery Alarm Near End:Info Battery Oui Non

End:Info Battery Oui Non

Near End:Sony Battery Oui Non

End:Sony Battery Oui Non

Near End:Other Battery Oui Non

End:Other Battery Oui Non

Detected Battery Non Non

Ext. Unit DC IN Alarm DC Low Voltage1 Oui Non

DC Low Voltage2 Oui Non

All Reset Reset – –

APR APR – –

Camera Config HD/2K Modulation Oui Non

Version Number – –

Version Up – –

Ext. Unit Version Number – –

Ext. Unit Version Up – –

LEVEL 1 LEVEL 2 LEVEL 3 All File Scene File
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Voir les éléments relatifs dans « Réglage de l’audio sur Record » (page 44) et « Liste du menu de 
configuration » (page 64).

* Réglez sur MAN lorsque l’audio est entré par l’adaptateur XLR.

Diagrammes bloc

Audio Input (CH1&CH2)

<
C

H
1 Input S

elect>
Input1

Internal M
IC

S
hoe1

<
C

H
1 W

ind F
ilter>

O
n

O
ff

C
H

1 LE
V

E
L C

O
N

T
R

O
L*

A
U

TO
M

A
N

<
C

H
1 Level>

A
udio Input Level

S
ide

Level +
 S

ide
T

hrough

C
H

1 IN
P

U
T

LE
V

E
L

0~
10

<
C

H
1 Input S

elect>
Input1
Input2

Internal M
IC

S
hoe2

<
C

H
2 W

ind F
ilter>

O
n

O
ff

C
H

2 LE
V

E
L C

O
N

T
R

O
L*

A
U

TO
M

A
N

<
C

H
2 Level>

A
udio Input Level

S
ide

Level +
 S

ide
T

hrough

C
H

2 IN
P

U
T

LE
V

E
L

0~
10

<A
udio Input Level>

0~
99

<Lim
iter M

ode>
O

ff, −6dB
−9dB

, −12dB
−15dB

, −17dB

<C
H

1&
2 A

G
C

 M
ode>

M
ono

S
tereo

IN
P

U
T

1

S
hoe1

S
hoe2

IN
P

U
T

2

Internal
M

IC

C
H

1

C
H

2



136

* Réglez sur Manual lorsque l’audio est entré par l’adaptateur XLR.

Audio Input (CH3&CH4)
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Audio Output
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CE PRODUIT EST SOUS LICENCE AVC 
PATENT PORTFOLIO POUR 
L’UTILISATION PERSONNELLE DU 
CONSOMMATEUR OU TOUT AUTRE 
UTILISATION N’IMPLIQUANT PAS DE 
REMUNERATION
 
(i) ENCODAGE VIDEO EN CONFORMITE 

AVEC LE STANDARD AVC (« AVC 
VIDEO » ET/OU

(ii) DECODAGE VIDEO AVC ENCODE PAR 
UN CONSOMMATEUR ENGAGE DANS 
UNE ACTIVITE PERSONNELLE ET/OU 
OBTENU D’UN FOURNISSEUR VIDEO 
AYANT LA LICENCE DE DISTRIBUTION 
AVC VIDEO.

 
AUCUNE LICENCE N’EST ATTRIBUEE OU 
NE DOIT ETRE DESTINEE POUR TOUT 
AUTRE USAGE. DES INFORMATIONS 
SUPPLEMENTAIRES PEUVENT ETRE 
OBTENUES DE MPEG LA, L.L.C. VOIR 
HTTP://WWW.MPEGLA.COM

Ce produit utilise le logiciel auquel s’applique la 
licence GPL/LGPL. Ceci vous informe que vous 
disposez d’un droit d’accès, de modification et de 
redistribution du code source de ces logiciels dans 
les conditions de la GPL/LGPL.
Le code source est disponible sur Internet. 
Reportez-vous à l’adresse URL suivante et suivez 
les instructions de téléchargement.
http://www.sony.net/Products/Linux/common/
search.html

Nous préférerions que vous ne nous contactiez 
pas au sujet du contenu du code source.

Pour connaître le contenu de ces licences, voir 
« License1.pdf » dans le dossier « License » du 
CD-ROM fourni.

Adobe Reader doit être installé sur votre 
ordinateur pour visualiser des fichiers PDF.
Si Adobe Reader n’est pas installé sur votre 
ordinateur, vous pouvez le télécharger en vous 
rendant à l’adresse URL suivante.
http://get.adobe.com/reader/

IMPORTANT: 
BEFORE USING THE SOFTWARE 
CONTAINED IN THE SOLID STATE 
MEMORY CAMCORDER, PLEASE READ 
THIS END USER LICENSE AGREEMENT 
(“EULA”) CAREFULLY. BY USING THE 
SOFTWARE YOU ARE ACCEPTING THE 
TERMS OF THIS EULA. IF YOU DO NOT 
ACCEPT THE TERMS OF THIS EULA, YOU 
MAY NOT USE THE SOFTWARE.

This EULA is a legal agreement between you and 
Sony Corporation (“SONY”). This EULA 
governs your rights and obligations regarding the 
software of SONY and/or its third party licensors 
(including SONY’s affiliates) and their respective 
affiliates (collectively, the “THIRD-PARTY 
SUPPLIERS”) contained in the wireless adapter, 
together with any updates/ upgrades provided by 
SONY, any printed, on-line or other
electronic documentation for such software, and 
any data files created by operation of such 
software (collectively, the “SOFTWARE”).

Notwithstanding the foregoing, any software in 
the SOFTWARE having a separate end user 
license agreement (including, but not limited to, 
GNU General Public license and Lesser/Library 
General Public License) shall be covered by such 
applicable separate end user license agreement in 
lieu of the terms of this EULA to the extent 
required by such separate end user license 
agreement (“EXCLUDED SOFTWARE”).

SOFTWARE LICENSE
The SOFTWARE is licensed, not sold. The 
SOFTWARE is protected by copyright and other 
intellectual property laws and international 
treaties.

Licences

Licence MPEG-4 AVC Patent 
Portfolio

Obtention d’un logiciel sous 
licence GPL/LGPL

AUTORISATION DE LICENCE DE 
L’UTILISATEUR FINAL
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COPYRIGHT
All right and title in and to the SOFTWARE 
(including, but not limited to, any images, 
photographs, animation, video, audio, music, text 
and “applets” incorporated into the SOFTWARE) 
is owned by SONY or one or more of the THIRD-
PARTY SUPPLIERS.

GRANT OF LICENSE
SONY grants you a limited license to use the 
SOFTWARE solely in connection with the 
wireless adapter and only for your individual use. 
SONY and the THIRD-PARTY SUPPLIERS 
expressly reserve all rights, title and interest 
(including, but not limited to, all intellectual 
property rights) in and to the SOFTWARE that 
this EULA does not specifically grant to you.

REQUIREMENTS AND LIMITATIONS
You may not copy, publish, adapt, redistribute, 
attempt to derive source code, modify, reverse 
engineer, decompile, or disassemble any of the 
SOFTWARE, whether in whole or in part, or 
create any derivative works from or of the 
SOFTWARE unless such derivative works are 
intentionally facilitated by the SOFTWARE. You 
may not modify or tamper with any digital rights 
management functionality of the SOFTWARE. 
You may not bypass, modify, defeat or 
circumvent any of the functions or protections of 
the SOFTWARE or any mechanisms operatively 
linked to the SOFTWARE. You may not separate 
any individual component of the SOFTWARE 
for use on more than one wireless adapter unless 
expressly authorized to do so by SONY. You may 
not remove, alter, cover or deface any trademarks 
or notices on the SOFTWARE. You may not 
share, distribute, rent, lease, sublicense, assign, 
transfer or sell the SOFTWARE. The software, 
network services or other products other than 
SOFTWARE upon which the SOFTWARE’S 
performance depends might be interrupted or 
discontinued at the discretion of the suppliers 
(software suppliers, service suppliers, or SONY). 
SONY and such suppliers do not warrant that the 
SOFTWARE, network services, contents or other 
products will continue to be available, or will 
operate without interruption or modification. 

EXCLUDED SOFTWARE AND OPEN 
SOURCE COMPONENTS
Notwithstanding the foregoing limited license 
grant, you acknowledge that the SOFTWARE 
may include EXCLUDED SOFTWARE. Certain 

EXCLUDED SOFTWARE may be covered by 
open source software licenses (“Open Source 
Components”), which means any software 
licenses approved as open source licenses by the 
Open Source Initiative or any substantially 
similar licenses, including but not limited to any 
license that, as a condition of distribution of the 
software licensed under such license, requires 
that the distributor make the software available in 
source code format. If and to the extent disclosure 
is required, please visit www.sony.com/linux or 
other SONY-designated web site for a list of 
applicable OPEN SOURCE COMPONENTS 
included in the SOFTWARE from time to time, 
and the applicable terms and conditions 
governing its use. Such terms and conditions may 
be changed by the applicable third party at any 
time without liability to you. To the extent 
required by the licenses covering EXCLUDED 
SOFTWARE, the terms of such licenses will 
apply in lieu of the terms of this EULA. To the 
extent the terms of the licenses applicable to 
EXCLUDED SOFTWARE prohibit any of the 
restrictions in this EULA with respect to such 
EXCLUDED SOFTWARE, such restrictions will 
not apply to such EXCLUDED SOFTWARE. To 
the extent the terms of the licenses applicable to 
Open Source Components require SONY to make 
an offer to provide source code in connection with 
the SOFTWARE, such offer is hereby made. 

USE OF SOFTWARE WITH 
COPYRIGHTED MATERIALS
The SOFTWARE may be capable of being used 
by you to view, store, process and/or use content 
created by you and/or third parties. Such content 
may be protected by copyright, other intellectual 
property laws, and/or agreements. You agree to 
use the SOFTWARE only in compliance with all 
such laws and agreements that apply to such 
content. You acknowledge and agree that SONY 
may take appropriate measures to protect the 
copyright of content stored, processed or used by 
the SOFTWARE. Such measures include, but are 
not limited to, counting the frequency of your 
backup and restoration through certain 
SOFTWARE features, refusal to accept your 
request to enable restoration of data, and 
termination of this EULA in the event of your 
illegitimate use of the SOFTWARE. 



140

CONTENT SERVICE 
PLEASE ALSO NOTE THAT THE 
SOFTWARE MAY BE DESIGNED TO BE 
USED WITH CONTENT AVAILABLE 
THROUGH ONE OR MORE CONTENT 
SERVICES (“CONTENT SERVICE”). USE OF 
THE SERVICE AND THAT CONTENT IS 
SUBJECT TO THE TERMS OF SERVICE OF 
THAT CONTENT SERVICE. IF YOU 
DECLINE TO ACCEPT THOSE TERMS, 
YOUR USE OF THE SOFTWARE WILL BE 
LIMITED. You acknowledge and agree that 
certain content and services available through the 
SOFTWARE may be provided by third parties 
over which SONY has no control. USE OF THE 
CONTENT SERVICE REQUIRES AN 
INTERNET CONNECTION. THE CONTENT 
SERVICE MAY BE DISCONTINUED AT ANY 
TIME.

INTERNET CONNECTIVITY AND THIRD 
PARTY SERVICES
You acknowledge and agree that access to certain 
SOFTWARE features may require an Internet 
connection for which you are solely responsible. 
Further, you are solely responsible for payment of 
any third party fees associated with your Internet 
connection, including but not limited to Internet 
service provider or airtime charges. Operation of 
the SOFTWARE may be limited or restricted 
depending on the capabilities, bandwidth or 
technical limitations of your Internet connection 
and service. The provision, quality and security of 
such Internet connectivity are the sole 
responsibility of the third party providing such 
service. 

EXPORT AND OTHER REGULATIONS
You agree to comply with all applicable export 
and re-export restrictions and regulations of the 
area or country in which you reside, and not to 
transfer, or authorize the transfer, of the 
SOFTWARE to a prohibited country or otherwise 
in violation of any such restrictions or 
regulations.

HIGH RISK ACTIVITIES
The SOFTWARE is not fault-tolerant and is not 
designed, manufactured or intended for use or 
resale as on-line control equipment in hazardous 
environments requiring fail-safe performance, 
such as in the operation of nuclear facilities, 
aircraft navigation or communication systems, air 
traffic control, direct life support machines, or 

weapons systems, in which the failure of the 
SOFTWARE could lead to death, personal injury, 
or severe physical or environmental damage 
(“HIGH RISK ACTIVITIES”). SONY, each of 
the THIRD-PARTY SUPPLIERS, and each of 
their respective affiliates specifically disclaim 
any express or implied warranty, duty or 
condition of fitness for HIGH RISK 
ACTIVITIES.

EXCLUSION OF WARRANTY ON 
SOFTWARE
You acknowledge and agree that use of the 
SOFTWARE is at your sole risk and that you are 
responsible for use of the SOFTWARE. The 
SOFTWARE is provided “AS IS,” without 
warranty, duty or condition of any kind.

SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
EXPRESSLY DISCLAIM ALL 
WARRANTIES, DUTIES OR CONDITIONS, 
EXPRESS OR IMPLIED, INCLUDING, BUT 
NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY, 
NONINFRINGEMENT AND FITNESS FOR A 
PARTICULAR PURPOSE. SONY DOES NOT 
WARRANT OR MAKE ANY CONDITIONS 
OR REPRESENTATIONS (A) THAT THE 
FUNCTIONS CONTAINED IN ANY OF THE 
SOFTWARE WILL MEET YOUR 
REQUIREMENTS OR THAT THEY WILL BE 
UPDATED, (B) THAT THE OPERATION OF 
ANY OF THE SOFTWARE WILL BE 
CORRECT OR ERROR-FREE OR THAT ANY 
DEFECTS WILL BE CORRECTED, (C) THAT 
THE SOFTWARE WILL NOT DAMAGE ANY 
OTHER SOFTWARE, HARDWARE OR 
DATA, (D) THAT ANY SOFTWARE, 
NETWORK SERVICES (INCLUDING THE 
INTERNET) OR PRODUCTS (OTHER THAN 
THE SOFTWARE) UPON WHICH THE 
SOFTWARE’S PERFORMANCE DEPENDS 
WILL CONTINUE TO BE AVAILABLE, 
UNINTERRUPTED OR UNMODIFIED, AND 
(E) REGARDING THE USE OR THE 
RESULTS OF THE USE OF THE SOFTWARE 
IN TERMS OF ITS CORRECTNESS, 
ACCURACY, RELIABILITY, OR 
OTHERWISE. 
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NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY SONY OR AN 
AUTHORIZED REPRESENTATIVE OF SONY 
SHALL CREATE A WARRANTY, DUTY OR 
CONDITION OR IN ANY WAY INCREASE 
THE SCOPE OF THIS WARRANTY. SHOULD 
THE SOFTWARE PROVE DEFECTIVE YOU 
ASSUME THE ENTIRE COST OF ALL 
NECESSARY SERVICING, REPAIR OR 
CORRECTION. SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED 
WARRANTIES, SO THESE EXCLUSIONS 
MAY NOT APPLY TO YOU.

LIMITATION OF LIABILITY
SONY AND EACH OF THE THIRD-PARTY 
SUPPLIERS (for purposes of this Section, SONY 
and each of the THIRD-PARTY SUPPLIERS 
shall be collectively referred to as “SONY”) 
SHALL NOT BE LIABLE FOR ANY 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES FOR BREACH OF ANY
EXPRESS OR IMPLIED WARRANTY, 
BREACH OF CONTRACT, NEGLIGENCE, 
STRICT LIABILITY OR UNDER ANY OTHER 
LEGAL THEORY RELATED TO THE
SOFTWARE, INCLUDING, BUT NOT 
LIMITED TO, ANY DAMAGES ARISING 
OUT OF LOSS OF PROFITS, LOSS OF 
REVENUE, LOSS OF DATA, LOSS OF USE 
OF THE SOFTWARE OR ANY ASSOCIATED 
HARDWARE, DOWN TIME AND USER’ S 
TIME, EVEN IF ANY OF THEM HAVE BEEN 
ADVISED OF THE POSSIBILITY OF SUCH
DAMAGES. IN ANY CASE, EACH AND ALL 
OF THEIR AGGREGATE LIABILITY UNDER 
ANY PROVISION OF THIS EULA SHALL BE 
LIMITED TO THE AMOUNT ACTUALLY 
PAID FOR THE PRODUCT. SOME 
JURISDICTIONS DO NOT ALLOW THE 
EXCLUSION OR LIMITATION OF 
INCIDENTAL OR CONSEQUENTIAL 
DAMAGES, SO THE ABOVE EXCLUSION 
OR LIMITATION MAY NOT APPLY TO 
YOU.

CONSENT TO USE OF NON-PERSONAL 
INFORMATION, LOCATION DATA, DATA 
SECURITY
You acknowledge and agree that SONY and its 
affiliates, partners and agents may read, collect, 
transfer, process and store certain information 
collected from the SOFTWARE, including but 

not limited to information about (i) the 
SOFTWARE and (ii) the software applications, 
contents and peripheral devices that interact with 
your wireless adapter and the SOFTWARE 
(“Information”). Information includes, but is not 
limited to: (1) unique identifiers relating to your 
wireless adapter and its components; (2) 
performance of the wireless adapter, the 
SOFTWARE and their components; (3) 
configurations of your wireless adapter, the 
SOFTWARE and the software applications, 
contents and peripheral devices that interact with 
the wireless adapter and the SOFTWARE; (4) use 
and frequency of use of the functions of (x) the 
SOFTWARE, and (y) the software applications, 
contents and peripheral devices that interact with 
the SOFTWARE; and (5) location data, as 
indicated below. SONY and its affiliates, partners 
and agents may use and disclose Information 
subject to applicable laws in order to improve its 
products and services or to provide products or 
services to you. Such uses include, but are not 
limited to: (a) administering the functionalities of 
the SOFTWARE; (b) to improve, service, update 
or upgrade the SOFTWARE; (c) improving, 
developing and enhancing the current and future 
products and services of SONY and other parties; 
(d) to provide you with information about the 
products and services offered by SONY and other 
parties; (e) complying with applicable laws or 
regulations; and (f) to the extent offered, 
providing you with location-based services of 
SONY and other parties, as indicated below. In 
addition, SONY retains the right to use 
Information to protect itself and third parties from 
illegal, criminal or harmful conduct.

Certain services available through the 
SOFTWARE may rely upon location 
information, including, but not limited to, the 
geographic location of the wireless adapter. You 
acknowledge that for the purpose of providing 
such services, SONY, the THIRDPARTY 
SUPPLIERS or their partners may collect, 
archive, process and use such location data, and 
that such services are governed by the privacy 
policies of SONY or such third party. By 
reviewed the privacy policies applicable to such 
services and consent to such activities. 

SONY, its affiliates, partners and agents will not 
intentionally use Information to personally 
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identify the owner or user of the SOFTWARE 
without your knowledge or consent. Any use of 
Information will be in accordance with the 
privacy policies of SONY or such third party. 

Please contact applicable contact address of each 
area or country for SONY’ s current privacy 
policy. Please contact applicable third parties for 
privacy policies relating to personally identifiable 
and other information you provide when you use 
or access third party software or services. 

Information may be processed, stored or 
transferred to SONY, its affiliates or agents which 
are located in countries outside of your country of 
residence. Data protection and information 
privacy laws in certain countries may not offer the 
same level of protection as your country of 
residence and you may have fewer legal rights in 
relation to Information processed and stored in, or 
transferred to, such countries. SONY will use 
reasonable efforts to take appropriate technical 
and organizational steps to prevent unauthorized 
access to or disclosure of Information, but does 
not warrant it will eliminate all risk of misuse of 
such Information.

AUTOMATIC UPDATE FEATURE
From time to time, SONY or the THIRD-PARTY 
SUPPLIERS may automatically update or 
otherwise modify the SOFTWARE, including, 
but not limited to, for purposes of enhancement of 
security functions, error correction and 
improvement of functions, at such time as you 
interact with SONY’ s or third parties’ servers, or 
otherwise. Such updates or modifications may 
delete or change the nature of features or other 
aspects of the SOFTWARE, including, but not 
limited to, functions you may rely upon. You 
acknowledge and agree that such activities may 
occur at SONY’ s sole discretion and that SONY 
may condition continued use of the SOFTWARE 
upon your complete installation or acceptance of 
such update or modifications. Any updates/
modifications shall be deemed to be, and shall 
constitute part of, the SOFTWARE for purposes 
of this EULA. By acceptance of this EULA, you 
consent to such update/modification.

ENTIRE AGREEMENT, WAIVER, 
SEVERABILITY
This EULA and SONY’ s privacy policy, each as 
amended and modified from time to time, 

together constitute the entire agreement between 
you and SONY with respect to the SOFTWARE. 
The failure of SONY to exercise or enforce any 
right or provision of this EULA shall not 
constitute a waiver of such right or provision. If 
any part of this EULA is held invalid, illegal, or 
unenforceable, that provision shall be enforced to 
the maximum extent permissible so as to maintain 
the intent of this EULA, and the other parts will 
remain in full force and effect.

GOVERNING LAW AND JURISDICTION
The United Nations Convention on Contracts for 
the International Sale of Goods shall not apply to 
this EULA. This EULA shall be governed by the 
laws of Japan, without regards to conflict of laws
provisions. Any dispute arising out of this EULA 
shall be subject to the exclusive venue of the 
Tokyo District Court in Japan, and the parties 
hereby consent to the venue and jurisdiction of 
such courts.

EQUITABLE REMEDIES
Notwithstanding anything contained in this 
EULA to the contrary, you acknowledge and 
agree that any violation of or noncompliance with 
this EULA by you will cause irreparable harm to 
SONY, for which monetary damages would be 
inadequate, and you consent to SONY obtaining 
any injunctive or equitable relief that SONY 
deems necessary or appropriate in such 
circumstances. SONY may also take any legal 
and technical remedies to prevent violation of 
and/or to enforce this EULA, including, but not 
limited to, immediate termination of your use of 
the SOFTWARE, if SONY believes in its sole 
discretion that you are violating or intend to 
violate this EULA. These remedies are in addition 
to any other remedies SONY may have at law, in 
equity or under contract.

TERMINATION
Without prejudice to any of its other rights, 
SONY may terminate this EULA if you fail to 
comply with any of its terms. In case of such 
termination, you must: (i) cease all use, and 
destroy any copies, of the SOFTWARE; (ii) 
comply with the requirements in the section 
below entitled “Your Account Responsibilities”.

AMENDMENT
SONY RESERVES THE RIGHT TO AMEND 
ANY OF THE TERMS OF THIS EULA AT ITS 
SOLE DISCRETION BY POSTING NOTICE 
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ON A SONY DESIGNATED WEB SITE, BY 
EMAIL NOTIFICATION TO AN EMAIL 
ADDRESS PROVIDED BY YOU, BY 
PROVIDING NOTICE AS PART OF THE 
PROCESS IN WHICH YOU OBTAIN 
UPGRADES/ UPDATES OR BY ANY OTHER 
LEGALLY RECOGNIZABLE FORM OF 
NOTICE. If you do not agree to the amendment, 
you should promptly contact SONY for 
instructions. Your continued use of the 
SOFTWARE after the effective date of any such 
notice shall be deemed your agreement to be 
bound by such amendment.

THIRD-PARTY BENEFICIARIES
Each THIRD-PARTY SUPPLIER is an express 
intended thirdparty beneficiary of, and shall have 
the right to enforce, each provision of this EULA 
with respect to the SOFTWARE of such party. 

Should you have any questions concerning this 
EULA, you may contact SONY by writing to 
SONY at applicable contact address of each area 
or country.

Copyright © 2012 Sony Corporation.

Sur la base des contrats de licence entre Sony et 
les détenteurs de copyright des logiciels, ce 
produit utilise des logiciels libres.
Pour répondre aux exigences des détenteurs de 
copyright des logiciels, Sony est dans l’obligation 
de vous informer sur le contenu de ces licences.
Pour connaître le contenu de ces licences, voir 
« License1.pdf » dans le dossier « License » du 
CD-ROM fourni.

Poids Environ 2,0 kg (4 lb 6,5 oz) (boîtier 
uniquement)

Dimensions
(Unité : mm (pouce), boîtier 
uniquement)1) 

1) Les valeurs indiquées pour les dimensions sont 
approximatives.

Alimentation
12 V CC (11 V à 17,0 V)

Consommation électrique
Environ 19 W (boîtier, objectif 
SELP28135G, enregistrement XAVC-I 
QFHD 59.94P, viseur allumé)

Température d’utilisation
0 °C à 40 °C (32 °F à 104 °F)

Température de stockage
−20 °C à +60 °C (−4 °F à +140 °F)

Durée d’utilisation continue
Environ 60 minutes (lors de l’utilisation 
du BP-U30)

Licences de logiciels libres

Caractéristiques 
techniques

Généralités

247 (9 3/4)
24

5,
5 

(9
 3

/ 4
)

15
9 

(6
 3

/ 8
)
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Format d’enregistrement (vidéo)
XAVC Intra 
AVC/H.264 High 4:2:2 Intra Profile
QFHD : VBR, 600 Mbit/s max.
4K : VBR, 600 Mbit/s max.
HD : CBG, 222 Mbit/s
XAVC Long 
AVC/H.264 High Profile
QFHD : VBR, 150 Mbit/s max., 4:2:0, 
Long
HD : VBR, 50 Mbit/s max., 4:2:2, Long
MPEG HD 422 
MPEG-2 Long GOP
Mode HD422 : CBR, 50 Mbit/s, 
MPEG-2 422P@HL
ProRes 422 HQ 1)

Apple ProRes 422 HQ
4:2:2, 10 bits, VBR, 220 Mbit/s max.
ProRes 422 1)

Apple ProRes 422
4:2:2, 10 bits, VBR, 147 Mbit/s max.

Format d’enregistrement (audio)
LPCM 24 bits, 48 kHz, 4-canaux

Fréquence d’enregistrement élevée
XAVC Intra 
4096 × 2160/59.94P, 50P, 29.97P, 24P, 
23.98P, 25P
3840 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
1920 × 1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P
XAVC Long 
3840 × 2160/59.94P, 50P, 29.97P, 
23.98P, 25P
1920 × 1080/59.94P, 50P, 59.94i, 50i, 
29.97P, 23.98P, 25P
MPEG HD 422 
1920 × 1080/59.94i, 50i, 29.97P, 
23.98P, 25P
1280 × 720/59.94P, 50P, 29.97P, 
23.98P, 25P
ProRes 422 HQ 1)

1920 × 1080/59.94i, 50i, 29.97P, 25P, 
23.98P
ProRes 422 1)

1920 × 1080/59.94i, 50i, 29.97P, 25P, 
23.98P

Durée d’enregistrement/lecture
XAVC Intra 4096 × 2160/3840 × 2160 
59.94P

Environ 22 minutes : à l’aide du 
QD-G128A
Environ 11 minutes : à l’aide du 
QD-G64A

50P
Environ 26 minutes : à l’aide du 
QD-G128A
Environ 13 minutes : à l’aide du 
QD-G64A

29.97P
Environ 44 minutes : à l’aide du 
QD-G128A
Environ 22 minutes : à l’aide du 
QD-G64A

23.98P/24P
Environ 55 minutes : à l’aide du 
QD-G128A
Environ 27 minutes : à l’aide du 
QD-G64A

25P
Environ 52 minutes : à l’aide du 
QD-G128A
Environ 26 minutes : à l’aide du 
QD-G64A

XAVC Intra 1920 × 1080 
59.94P

Environ 59 minutes : à l’aide du 
QD-G128A
Environ 30 minutes : à l’aide du 
QD-G64A

50P
Environ 71 minutes : à l’aide du 
QD-G128A
Environ 35 minutes : à l’aide du 
QD-G64A

59.94i
Environ 118 minutes : à l’aide du 
QD-G128A
Environ 59 minutes : à l’aide du 
QD-G64A

50i
Environ 141 minutes : à l’aide du 
QD-G128A
Environ 70 minutes : à l’aide du 
QD-G64A
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29.97P
Environ 118 minutes : à l’aide du 
QD-G128A
Environ 59 minutes : à l’aide du 
QD-G64A

23.98P
Environ 147 minutes : à l’aide du 
QD-G128A
Environ 74 minutes : à l’aide du 
QD-G64A

25P
Environ 141 minutes : à l’aide du 
QD-G128A
Environ 70 minutes : à l’aide du 
QD-G64A

XAVC Long 3840 × 2160 
59.94P/50P

Environ 87 minutes : à l’aide du 
QD-G128A
Environ 44 minutes : à l’aide du 
QD-G64A

29.97P/23.98P/25P
Environ 131 minutes : à l’aide du 
QD-G128A
Environ 66 minutes : à l’aide du 
QD-G64A

XAVC Long 1920 × 1080 
Mode 50M

Environ 262 minutes : à l’aide du 
QD-G128A
Environ 131 minutes : à l’aide du 
QD-G64A

Mode 35M
Environ 374 minutes : à l’aide du 
QD-G128A
Environ 187 minutes : à l’aide du 
QD-G64A

Mode 25M
Environ 524 minutes : à l’aide du 
QD-G128A
Environ 262 minutes : à l’aide du 
QD-G64A

MPEG HD 422 
Environ 262 minutes : à l’aide du 
QD-G128A
Environ 131 minutes : à l’aide du 
QD-G64A

ProRes 422 HQ 1)

59.94i/29.97P
Environ 60 minutes: à l’aide du 
QD-G128A
Environ 30 minutes: à l’aide du 
QD-G64A

50i/25P
Environ 72 minutes: à l’aide du 
QD-G128A
Environ 36 minutes: à l’aide du 
QD-G64A

23.98P
Environ 74 minutes: à l’aide du 
QD-G128A
Environ 37 minutes: à l’aide du 
QD-G64A

ProRes 422 1)

59.94i/29.97P
Environ 90 minutes: à l’aide du 
QD-G128A
Environ 45 minutes: à l’aide du 
QD-G64A

50i/25P
Environ 108 minutes: à l’aide du 
QD-G128A
Environ 54 minutes: à l’aide du 
QD-G64A

23.98P
Environ 112 minutes: à l’aide du 
QD-G128A
Environ 56 minutes: à l’aide du 
QD-G64A

1) Avec XDCA-FS7 (optionnelle) connecté

Remarque

La durée d’enregistrement/lecture peut varier en fonction 
des conditions d’utilisation et des caractéristiques de 
mémoire.

Imageur (type)
Capteur d’image CMOS Super 
équivalent 35

Nombre de pixels
11,6 mégapixels (total), 
8,8 mégapixels@17:9/
8,3 mégapixels@16:9 (réel)

Section de caméra
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Filtres ND
1 : Clear
2 : 1/4ND
3 : 1/16ND
4 : 1/64ND

Sensibilité
Gamma vidéo : T14 @ 24p
(2000 lux, réflexion 89,9%, 3200K)

Sensibilité ISO
Gamma S-Log3 ISO2000 (source 
lumineuse D55)

Illumination minimum
0,7 lux (18 dB, 23.98P, Shutter: OFF, 
ND Clear, F1.4)

Monture d’objectif
Monture E

Latitude 14 diaphragmes
S/B vidéo

57 dB (Gamma vidéo/Suppression du 
bruit : désactivés)

Vitesse d’obturateur
1/3 à 1/9000 sec (23.98P)

Angle d’obturateur
5,6° à 300°

Ralenti et accéléré
XAVC QFHD : 1 à 60P, 
XAVC HD : 1 à 180P

Equilibre des blancs
Mode prédéfini  (2100K à 10000K), 
mode mémoire A, B (1500K à 50000K)

Gain −3, 0, 3, 6, 9, 12, 18 dB
Courbe gamma

STD1, STD2, STD3, STD4, STD5, 
STD6, HG1, HG2, HG3, HG4, HG7, 
HG8, S-Log2, S-Log3, USER1, USER2, 
USER3, USER4, USER5

Fréquence d’échantillonnage
48 kHz

Quantification
24 bits

Réponse de fréquence
Mode MIC entrée XLR :

50 Hz à 20 kHz (±3 dB ou moins)
Mode LINE entrée XLR :

20 Hz à 20 kHz (±3 dB ou moins)

Plage dynamique
90 dB (typique)

Distorsion
0,08% ou moins (niveau d’entrée 
−40 dBu)

Haut parleur intégré
Monaural

Microphone interne
Monaural

Entrées
INPUT 1/2 :

Type XLR, 3 broches, femelle
Commutable LINE / MIC / MIC+48V
MIC : référence −40, −50, −60 dBu

Sorties
SDI OUT 1/2 :

Type BNC, 0,8 Vp-p, asymétrique 
(sortie 3G HD/1,5G HD)
Conforme à la norme SMPTE ST424 
Level-A/B, SMPTE ST425 Level-A/B, 
SMPTE ST292-1 
Audio 4 canaux

Casque (mini-prise stéréo) :
−16 dBu (sortie du niveau de référence, 
volume maximal du moniteur, charge de 
16 Ω)

HDMI : type A, 19 broches

Autre
DC IN : conforme à la norme EIAJ, 11 V à 

17 V CC
Connecteur d’unité d’extension :

Dédié (144 broches)
Griffe à interfaces multiples :

Dédiée (21 broches)
REMOTE :

Type mini-sub à 3 pôles de 2,5 Φ 
USB : Conforme à la norme 2.0, type mini AB 

pour stockage de masse (1)
Type A pour connexion LAN sans fil (1)

VF : dédiée (40 broches)

Section audio

Section entrée/sortie
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Moniteur LCD
Taille d’écran

8,8 cm (3,5 pouces) de diagonale
Rapport d’aspect

16:9
Nombre de pixels

960 (H) × 540 (V)

Logements de carte XQD pour l’enregistrement 
vidéo (2)
Logement de carte UTILITY SD (1)

Viseur (y compris oculaire, œilleton, tige, 
attache)
Télécommande de poignée
Module LAN sans fil USB (IFU-WLM3)
Télécommande infrarouge (RMT-845)
Adaptateur CA/Chargeur
Pack batterie (BP-U30)

Tension maximale : 16,4 V CC
Tension nominale : 14,4 V CC
Capacité : 28 Wh

Cordon d’alimentation (1)
Câble mini USB (1)
Crochet de montage optionnel (1)
Capuchon de la monture d’objectif (1)
Capuchon protecteur du connecteur de la poignée 
(deux vis M2 fournies) (1)
Capuchon du module LAN sans fil USB (2)
Cache de rechange du connecteur LAN sans fil 
(1)
Cache de rechange du connecteur de l’unité 
d’extension (1)
Kit de griffe pour accessoire (griffe pour 
accessoire (1), plaque de griffe (1), vis (4))
Avant d’utiliser cet appareil (1)
Mode d’emploi (CD-ROM) (1)

La conception et les spécifications sont sujettes à 
modification sans préavis.

Section d’affichage

Section de logement de support

Accessoires fournis

Sony ne peut être tenue responsable de tout 
dommage, de quelque nature que ce soit, 
résultant d’une incapacité à mettre en place 
des mesures de sécurité adaptées pour les 
dispositifs de transmission, de fuites de 
données inévitables dues aux spécifications 
de transmission ou de tout autre problème de 
sécurité.

Remarques
• Effectuez toujours un essai d’enregistrement 

pour vérifier que l’enregistrement s’est fait 
correctement. 
Sony n’assumera pas de responsabilité 
pour les dommages de quelque sorte qu’ils 
soient, incluant mais ne se limitant pas à la 
compensation ou au remboursement, suite 
au manquement de cet appareil ou de son 
support d’enregistrement, de systèmes de 
mémoire extérieurs ou de tout autre 
support ou système de mémoire à 
enregistrer un contenu de tout type.

• Vérifiez toujours que l’appareil fonctionne 
correctement avant l’utilisation. 
Sony n’assumera pas de responsabilité 
pour les dommages de quelque sorte qu’ils 
soient, incluant mais ne se limitant pas à la 
compensation ou au remboursement, à 
cause de la perte de profits actuels ou 
futurs suite à la défaillance de cet appareil, 
que ce soit pendant la période de garantie 
ou après son expiration, ou pour toute 
autre raison quelle qu’elle soit.

• Sony n’assumera pas de responsabilité 
pour les réclamations, quelle qu’elles 
soient, effectuées par les utilisateurs de cet 
appareil ou par des tierces parties.

• Sony n’assumera pas de responsabilité 
pour la perte, la réparation ou la 
reproduction de toutes données 
enregistrées sur le système de mémoire 
intérieur, le support d’enregistrement, les 
systèmes de mémoire extérieurs ou tout 
autre support ou système de mémoire.

• Sony n’assumera pas de responsabilité 
pour la cessation ou l’interruption de tout 
service lié à cet appareil, résultant de 
quelque circonstance que ce soit.
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Lorsque l’appareil est utilisé avec une connexion 
PC, téléchargez tous les pilotes du dispositif, les 
plug-ins et les applications logicielles dont avez 
besoin à partir des sites internet suivants.

Site internet Sony produits professionnels :

Logiciels créatifs Sony, page de téléchargement 
du logiciel :
http://www.sonycreativesoftware.com/download/
software_for_sony_equipment

XDCAM est une marque commerciale de Sony 
Corporation.
• XAVC et  sont des marques déposées de 

Sony Corporation.
• XQD et  sont des marques 

commerciales de Sony Corporation.
• HDMI, le logo HDMI et High-Definition 

Multimedia Interface sont des marques 
commerciales ou des marques déposées de 
HDMI Licensing, LLC aux Etats-Unis et/ou 
dans d’autres pays.

Tous les autres noms d’entreprises ou de produits 
sont des marques commerciales ou des marques 
déposées de leurs détenteurs respectifs. Les 
éléments de marques commerciales ne sont pas 
indiqués par les symboles ® ou ™ dans ce 
document.

Téléchargements de logiciels

Etats-Unis http://pro.sony.com

Canada http://www.sonybiz.ca

Amérique latine http://sonypro-latin.com

Europe http://www.pro.sony.eu/pro

Moyen-Orient, Afrique http://sony-psmea.com

Russie http://sony.ru/pro/

Brésil http://sonypro.com.br

Australie http://pro.sony.com.au

Nouvelle Zélande http://pro.sony.co.nz

Japon http://www.sonybsc.com

Asie pacifique http://pro.sony-asia.com

Corée http://bp.sony.co.kr

Chine http://pro.sony.com.cn

Inde http://pro.sony.co.in

Marques commerciales
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